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Getting Started with UIM

You use the Oracle Communications Unified Inventory Management (UIM) feature for Oracle Communications Design Studio to create and maintain specifications and other content that define inventory entities and their behavior in UIM. Specifications can describe physical inventory items (such as routers or interface cards) or intangible items such as roles, business interactions, and addresses. You use specifications as blueprints for the various kinds of entities contained in your inventory.

When getting started with UIM, see the following topics:

	
About Creating Specifications and Other Inventory Content


	
Design Studio Users and Tasks












About Creating Specifications and Other Inventory Content

There is no set pattern to the way you use Design Studio to create specifications and other inventory-related content for UIM. The following list provides a high-level overview of the tasks you perform to create new content for UIM along with links to the help topics about those tasks:

	
Create a project to contain the specifications and rule sets that you develop.

Each project is mapped to directories in the file system and is a collection of files and folders. See the "Working with Design Studio Projects" for information about creating and opening projects.


	
Define entity specifications.

Specifications are the blueprints used to create inventory entities in UIM. There are many different types of entities, such as logical devices, equipment, telephone numbers, roles, places, and so on. See "Creating New Specifications" for general information about entity specifications. See the sections about the various specification types for detailed information about them.

When you define a specification, you enter its properties, establish relationships of various kinds with other specifications, specify its layout, and more. See "Defining Specification Properties", "Defining Specification Relationships", and "About Specification Layouts" for more information.


	
Define characteristics and add them to specifications.

Characteristics define items of data that you want to collect, such as serial numbers, settings, dates, and so on. The same characteristic can be used in multiple specifications. See "Creating Characteristics" and "Adding Existing Characteristics to Specifications" for more information.


	
Defining configurations.

Some types of entity specifications can be associated with configurations. Configurations define the resources that can be allocated to an entity and provide a record of the evolution of facts about the entity over time. See "Creating Configuration Specifications" for more information.


	
Define rule sets and related entities.

You use rule sets to customize UIM behavior. Rule sets are associated with extension points, which determine when the rule is applied. See UIM Developer's Guide and "Working with Rulesets and Extension Points" for more information.


	
Prepare for deployment into UIM.

Design Studio automatically builds cartridges from UIM projects. Before deployment, you should clean the project and resolve any errors. See "Reviewing the Error Log" and "Problems View" for more information.













Design Studio Users and Tasks

There are three primary groups of users for the Inventory features of Design Studio:

	
Modelers


	
Cartridge Developers


	
Deployment Managers












Modelers

Modelers are responsible for developing and extending complex models of services, networks, and other parts of your inventory. This involves the following tasks:


	Task	Reference
	Creating Entity Specifications	Creating New Specifications
For information about particular kinds of specifications, see the individual sections about them.


	Creating Characteristics	Creating Characteristics

	Creating Configurations	Creating Configuration Specifications















Cartridge Developers

Cartridge developers can perform the tasks mentioned previously, and also write the rule sets, extension points, and other entities required to customize UIM behavior. See UIM Developer's Guide for more information about development tasks and procedures.

In addition to modeling, this involves the following tasks:


	Task	Reference
	Creating entity identification specifications	Working with Entity Identification Specifications

	Creating sequence specifications	Working with Sequence Specifications

	Creating extension points	Working with Extension Points
Working with Enabled Extension Points



	Creating rule sets	Working with Rulesets

	Creating rule set extension points	Working with Ruleset Extension Points

	Extending technology packs	About Technology Packs and Cartridges
Extending Technology Packs and Cartridges

















Deployment Managers

Deployment managers are responsible for build management and are usually advanced users of the version control system. Activities performed by deployment managers may include:


	Task	Reference
	Importing cartridges	About Imported Inventory Cartridge Projects

	Cleaning projects	Running Clean Builds
	Resolving build issues	Reviewing the Error Log and Problems View
	Reviewing error logs	Reviewing the Error Log















Creating Inventory Cartridge Projects

Design Studio cartridge projects are collections of folders and files that represent the content you are working on. They are used for builds, version management, sharing, and resource organization. Cartridge projects map to directories in the file system. When you create a cartridge project, you specify a location for it in the file system. Design Studio uses the files and folders in a project to build a cartridge that you can import into UIM. Each Inventory project corresponds to a cartridge. See "Working with Design Studio Cartridge Projects" for more information.


Related Topics

Project Editor











Working with Specifications

Many entities in Oracle Communications Unified Inventory Management (UIM) are defined by specifications, which you create in Oracle Communications Design Studio. There are different types of specifications for different types of entities. For example, UIM includes specifications for telephone numbers, networks, physical devices, and inventory groups.

Specifications provide a way to classify entities and augment them with additional properties, called characteristics. For example, you can create a Service specification to define a DSL service and associate characteristics to the specification for the properties that you want to capture on DSL services at run time.

In addition, you can associate rulesets and extension points to specifications to extend or customize the run-time behavior of entities created from the specifications. See "Working with Rulesets and Extension Points" for more information.

You can relate specifications to other specifications to affect behavior in UIM. For example, you can relate Inventory Group specifications to Telephone Number specifications to limit the types of inventory groups in which a telephone number can be included.




	
Note:

The procedures for working with specifications assume that you are working in the Studio Design perspective.







When working with specifications, see the following topics:

	
About the Specification Editor


	
About Specification Relationships


	
About Configuration Specification Usage


	
Creating New Specifications


	
Configuring Specifications


	
Specification Editor


	
Inventory Entity Editor












About the Specification Editor

The Specification editor can contain many different tabs. Some of these tabs are specific to a small subset of specifications, and others are relevant to most specifications. The following tabs appear in most specification editors:

	
Characteristics: Defines characteristics associated with the specification. See "Adding Existing Characteristics to Specifications" for more information.


	
Specification Properties: Defines basic information about a specification. See "Defining Specification Properties" for more information.


	
Related Specifications: Defines relationships between a specification and other specifications. See "Defining Specification Relationships" for more information.


	
Configuration Spec Usage: Defines the configuration specifications and configuration items in which a specification is listed as an option. This tab enables you to add specification options to configuration items without having to modify the configuration specification. See "Defining Configuration Specification Usage" for more information.


	
Rules: Defines rulesets and extension points that extend or customize the behavior of entities created from the specification. See "Associating Specification-Based Extension Points to Rulesets" for more information.


	
Layouts: Defines how the properties of entities created from the specification appear in various pages of the UIM user interface. See "About Specification Layouts" for more information


	
Media: Defines any media files associated with the specification. See "Adding Media to a Specification" for more information.


	
Extends: Defines the entity type that is defined by the specification. See "Reviewing Specification Extensions" for more information.




Most Specification editor tabs include the Display Name field, where you can enter the name that appears in Design Studio editors and in UIM. Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


Related Topics

Specification Editor










About Specification Relationships

You can relate a specification to other specifications to affect run-time behavior in UIM. For example, UIM uses a Physical Port specification relationship to an Equipment specification to automatically create ports on equipment. See UIM Information Model Reference for more information about specification relationships recognized and used in UIM.

Specification relationships can also be used in customized logic using rulesets and extension points. See "Working with Rulesets and Extension Points" for more information.

You can create child and parent relationships between any specifications in the current workspace, including specifications in other projects. For example, you can create a relationship between a specification you have created in a new project and another specification in a sealed technology pack. See "Extending Technology Packs and Cartridges by Adding Content" for more information.

Creating a relationship with a specification in another project creates a dependency between the cartridges built from the two projects. The required cartridge must be deployed into UIM before the cartridge that requires it.


Related Topics

Defining Specification Relationships

Specification Editor Related Specifications Tab










About Configuration Specification Usage

You can define the configuration items in which a specification is listed as an option. These specification options define the type of entities that may be referenced or assigned to other entities on a configuration. For example, you can define that telephone numbers created from a certain specification can be assigned to entities that use a certain configuration specification.

You can add specification options to configuration items without having to modify the configuration specification. This is a useful way to extend the technology pack. See "Extending Technology Packs and Cartridges by Adding Content" for more information about extending technology packs.

If you are not extending a technology pack or other external cartridge, you should define configuration items and specification options from the configuration specification. See "Adding Configuration Items".

You can specify any configuration specification that is in the current workspace. If you specify a configuration specification that is in another project, you create a dependency between the cartridges. The cartridge containing the configuration specification must be deployed into UIM before the cartridge that contains the specification that refers to the configuration.


Related Topics

Defining Configuration Specification Usage

Specification Editor Configuration Spec Usage Tab










Creating New Specifications

The procedure for creating specifications is the same for all specification types. When creating new specifications, you must specify a project. See "Creating New Cartridge Projects" for more information.

To create a new specification:

	
From the Studio menu, select New, then select Inventory, then select a conceptual division, and then select a specification type.

The Specification Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
In the Name field, enter a name for the new specification.

The name must be unique among specification types in the same namespace. This is the name that will appear in UIM.


	
(Optional) Select a location for the new specification.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the new specification and displays its information in a Specification editor.





Related Topics

Configuring Specifications

Specification Editor










Configuring Specifications

After you create a specification, you can define how it relates to other specifications, use rules to control its behavior in UIM, and add characteristics to capture details that are not included in the entity type defined by the specification.

When configuring specifications, see the following topics:

	
Defining Specification Properties


	
Defining Specification Relationships


	
Defining Configuration Specification Usage


	
About Specification Layouts


	
Adding Media to a Specification


	
Reviewing Specification Extensions


	
Copying Specifications












Defining Specification Properties

You can define basic information about a specification, such as a display name, a description, and the dates during which the specification is valid.

To define specification properties:

	
In a Specification editor, click the Specification Properties tab.


	
(Optional) In the Description field, enter a description for the specification.


	
(Optional) In the Start Date and End Date fields, enter the specification's validity dates.

If you leave the Start Date field blank, the application sets it to the date on which the cartridge was built in Design Studio. Leaving the End Date field blank means that the specification is valid indefinitely.


	
(Optional) If instances of this specification can be assigned to more than one instance of a consumer entity at the same time, select the Can be assigned to multiple entities check box.

This check box appears only if the entity type associated with the specification can be assigned to entity types that are referred to as consumer entity. Consumer entity types include Service, Geographic Site, Logical Device, Network, Pipe, and Pipe Termination Point.


	
(Optional) If instances of this specification can assign entities whose specifications allow them to be assigned to multiple instances of consumer entities at the same time, select the Can assign entities that allow multiple assignments check box.

This check box appears only if the entity type associated with the specification is a consumer entity. Consumer entity types include Service, Geographic Site, Logical Device, Network, Pipe, and Pipe Termination Point.


	
(Optional) To enter an ID for this entity instance, select Enter Id Manually.

If this check box is not selected, the ID for this entity instance is auto-generated.


	
(Optional) Associate to the specification an Entity ID specification.

Do one of the following:

	
Click Entity ID Specification to associate with the specification a new Entity ID specification.


	
Click Select to associate with the specification an existing Entity ID specification.




See "Working with Entity Identification Specifications" for more information.


	
From the File menu, select Save.





Related Topics

Specification Editor Specification Properties Tab










Defining Specification Relationships

You can define relationships between specifications in the current workspace, including specifications in other projects.

To define specification relationships:

	
In a Specification editor, click the Related Specifications tab.


	
Click Select.

The Selection Dialog dialog box appears.


	
Do one of the following:

	
Select an existing specification and click OK.


	
Click New to create and relate a new specification. See "Creating New Specifications" for more information.




The specification appears in the Related Specifications tab, which lists the specification name, the cartridge in which it is located, and the type of relationship (CHILD by default).


	
(Optional) If the relationship is child-to-parent, change the relationship type to PARENT.

The normal relationship is defined as a child. You must specify a parent relationship only when the related entity is in a separate cartridge that exists independently. See "Changing Specification Relationship Properties" for more information.


	
From the File menu, select Save.





Related Topics

Specification Editor Related Specifications Tab









Changing Specification Relationship Properties

After you have defined a relationship between specifications, you can change the relationship's properties.

To change relationship properties:

	
Open the Specification editor of a specification whose relationship properties you want to change.


	
Click the Related Specifications tab.


	
Select a specification from the list and click Modify.

The Relationship Properties dialog box appears.


	
Enter or change relationship properties.

See "Specification Editor Related Specifications Tab" for more information about the properties that you can change.


	
Click OK.

Design Studio sets the properties and closes the dialog box.





Related Topics

Defining Specification Relationships











Defining Configuration Specification Usage

You can define the configuration items in which a specification is listed as an option. This process enables you to add specification options to configuration items without having to modify the configuration specification. This is a useful way to extend the technology pack. See "Extending Technology Packs and Cartridges by Adding Content" for more information about extending technology packs.




	
Note:

If you are not extending a technology pack or other external cartridge, define configuration items and specification options from the configuration specification. See "Adding Configuration Items".







To define configuration specification usage:

	
Open the Specification editor of the specification for which you want to define configuration specification usage.


	
Click the Configuration Spec Usage tab.


	
Click Select.

The Configuration Types Selection dialog box appears.


	
Select the type of configuration.


	
Click Next.

The Select a Configuration Specification dialog box appears, listing all configuration specifications of the selected type in all projects in the workspace.


	
Select a configuration specification, then click OK.

The Configuration Item Selection dialog box appears, displaying the hierarchy of configuration items in the selected configuration specification.


	
Do one of the following:

	
Select a configuration item, then click OK.


	
Click New to create and use a new specification. See "Creating New Specifications" for more information.




The configuration item is added to the Configuration Spec Usage tab. The name of the configuration specification, its type, and the cartridge in which it is located are displayed, along with the path of the selected configuration item.


	
From the File menu, select Save.





Related Topics

About Configuration Specification Usage

Specification Editor Configuration Spec Usage Tab










About Specification Layouts

Specification layouts define how the default data elements, derived data, and characteristics (of entities defined by the specification) appear in the UIM user interface. You can define this configuration for each page and panel associated with an entity. In UIM, a page is an area that serves a function for the entity, and a panel is a section on a page where default data elements and characteristics of the entity appear.

You can define which default data elements and characteristics of an entity appear on a page and panel. You can also configure the row on which a default data element or characteristic appears and the order of elements and characteristics within the row.

Additionally, you can configure user interface settings for a characteristic on an entity. These settings define how the characteristic appears and behaves on a page or panel.

When defining layouts, see the following topics:

	
Defining Specification Layouts


	
Defining Characteristic User Interface Settings












Defining Specification Layouts

You define layouts for specifications to determine the data elements that appear as fields in UIM. You can define layouts for the characteristics that you define for the specification, and for all modeled and derived data elements of the entity.

To define layouts:

	
In a Specification editor, click the Layouts tab.


	
In the Page/Panels field, select a page type for the specification.

You can define different attributes for a characteristic when it appears on different types of pages. For example, you can define an edit mask for a characteristic when it appears on an edit page and a display mask for the same characteristic when it appears on a summary page.




	
Note:

The options available in the Page/Panels field are defined in the ora_uim_mds project. You must import and open this project and the ora_uim_model project in your workspace before modeling UIM entities in Design Studio.








	
Select the elements that you want to appear as fields in the run-time user interface.

To select elements, you can:

	
Select elements in the Available column, then click the arrow to move them to the Selected column.


	
Shift-select multiple elements to move them as a group.





	
Remove elements that you do not want to appear in the user interface.

Select an element the Selected column then click the arrow to move it to the Available column.


	
Change the order in which the elements appear.

Select an element in the Selected column and then click an arrow to reposition the element.


	
For Edit Panel layouts, change the distribution of the elements in the layout.

Do any of the following:

	
Right-click in the Selected Elements area at the desired location and select Insert New Row to create a new row.


	
Right-click in the Selected Elements area on an existing row and select Delete New Row to remove an existing new row marker.





	
(Optional) To return the layout to the default version, click Reset.


	
From the File menu, select Save.





Related Topics

Specification Editor Layouts Tab

Defining Characteristic User Interface Settings










Defining Characteristic User Interface Settings

You define user interface settings for each characteristic to determine how the characteristic appears and behaves on each page and panel in UIM.

To define characteristic user interface settings:

	
In a Specification editor, click the Layouts tab.


	
In the Selected column, select a characteristic.

The configurable options for the characteristic appear in the UI Settings area.




	
Note:

You can configure user interface settings only for characteristics.








	
Define the user interface options for each characteristic.

See "Settings Tab" for information about the options.


	
From the File menu, select Save.





Related Topics

Specification Editor Layouts Tab

Defining Specification Layouts











Adding Media to a Specification

Media files can be associated to a specification and are used in UIM to display an image of an entity instance created from the specification. Media files are used in UIM to display an entity as an icon in a tree view, as a node in a network visualization, as a node in a service topology visualization, and as a card in an equipment visualization.

To add a media file to a specification:

	
In a Specification editor, click the Media tab.


	
Click Add.

The Open dialog box appears.


	
Select a file, then click Open.

The path to the selected media file appears in the Media tab.


	
Click the Media Type field, then select a type.




	
Note:

Only one media type can be selected per row. To use the same image for more than one purpose, you must add it to a new row and select an additional media type.








	
From the File menu, select Save.





Related Topics

Specification Editor Media Tab










Reviewing Specification Extensions

To review a specification extension:

	
In a Specification editor, click the Extends tab.


	
Review the value in the Extends field.

Design Studio automatically populates the value in the Extends field when you create new specifications. You can remove the value, but you cannot make a different selection.


	
(Optional) To open the business entity that is extended by the specification, click Extends.


	
(Optional) To remove the association, click Clear.





Related Topics

Specification Editor Extends Tab










Copying Specifications

You can copy specifications from one project to another. For example, you can extend a technology pack by copying a specification into your own project and make any necessary modifications.

To copy specifications:

	
From the Studio menu, select Show Design Perspective.


	
Click the Cartridge tab.


	
In the Solution view, locate the target specification.

The project must exist in the same workspace. See "Importing Projects" for information.


	
Right-click the target specification and select Copy.


	
Navigate to the source project.


	
Right-click the source project and select Paste.

The Set Name of Copy dialog box appears.


	
In the Name field, enter a unique name for the specification.

Specification names must be unique in the workspace.


	
Click OK.

The specification is added to the source project.














Specification Editor

Use the Specification editor to configure properties for a specification. The specification tabs referenced below are used by most specification types and are the same or similar for each type. For information about tabs that are specific to a specification type, see the Help for that specification type.

When working with specification tabs, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Specification Editor Characteristics Tab

Use the Characteristics tab to create, select, edit, and remove characteristics. See "Creating Characteristics" and "Adding Existing Characteristics to Specifications" for more information about adding characteristics to Specification editors.




	
Note:

The default data elements that appear in the Characteristics tab data tree are inherited from the extended entity, defined in the ora_uim_model project. These default data elements are read-only.







When working with the Specification editor Characteristics tab, see the following topics:

	
About the Characteristics Tab Context Menu


	
Details Tab


	
Information Tab


	
Usage Tab


	
Characteristics Tab Data Values Subtab












About the Characteristics Tab Context Menu

The Characteristics tab context menu contains actions specific to data elements tagged as characteristics. To access these actions, right-click in the left column of the tab. The context menu options that are available depend on the selection in the editor. For example, the list of context menu options that appear when you right-click in the white space is different than the list that appears when you right-click a characteristic.


	Command	Use
	Delete	Select to delete the characteristic from the specification.
	Refactoring	Select to access a menu of options for improving names and locations of the characteristics. See "Managing Data Element Names and Locations" for more information.
	Refresh	Refreshes the view.
	Add Characteristic	Select to create a new data element (that is automatically tagged as a characteristic) to add to the specification. See "Creating Characteristics" for more information.
	Select Characteristic	Select to add an existing data element (tagged as a characteristic) to the specification. See "Tags Tab" for more information about tagging data elements as characteristics.














Characteristics Tab Data Values Subtab

Use the Data Values subtab to define at the specification level values for a drop down list that do not change (static values).




	
Note:

See "Data Schema Editor Characteristics Tab" for information about defining parameters for drop down lists at the schema level.








	Field	Use
	Included table	Click the text inside the Code and Description columns to change the code name and description for the drop down value.
The value you enter in the Code field is stored in the database. The value you enter in the Description field is displayed in the run-time user interface.

Values that are inherited from a base type are read-only.

Click inside the Default column and select Yes to make the selected value the default value in the run-time environment.


	Add	Click to add a new value to the Included table.
	Remove	Click to remove a value from the Included table.
	Excluded table	Displays inherited values that you want to exclude from the list of values in the run-time environment. Move values between the Included and Excluded tables using the arrows to display a subset of the inherited values as valid values for the characteristic in the UIM.
	Language	Displays the language in which the selected value appears in UIM.















Specification Editor Specification Properties Tab

Use the Specification Properties tab to enter identifying information about a specification.


	Field	Use
	Display Name	Enter the name that appears in Design Studio editors and in UIM.
Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


	Start Date	Enter the first date on which this specification is valid.
	End Date	Enter the last date on which this specification is valid.
	System Provided	Indicates whether a specification is provided by Oracle. System-provided specifications support out-of-the-box functionality for defining Managed Project Extension, Channelized Connectivity Extension, and Property Location Extension entities.
They enable you to define entity-level characteristics for Managed Project Extension, Channelized Connectivity Extension, and Property Location Extension entities. Additionally, system-provided specifications can be selected as a specification option on an item in a configuration specification.

Note: You must import the ora_uim_basespecifications cartridge (which includes the specifications for extension entities) before you define characteristics for the extension entities. For information about the ora_uim_basespecifications cartridge, see UIM Cartridge and Technology Pack Guide.


	Can be assigned to multiple entities	Select if the entity created using this specification can be assigned to more than one instance of a consumer entity at the same time.
	Can assign entities that allow multiple assignments	Select if an entity created using this specification can assign entities whose specifications allow them to be assigned to multiple instances of consumer entities at the same time.
	Enter Id Manually	Select if you do not want data instances using this specification to have an automatically-generated ID. This check box is displayed only for the entities that are enabled for auto-generation of ID.
The Entity Identification Specification field is not available when you select this option.


	Entity Identification Specification	Defines the format for an identifier generated for an instance of the entity created from the specification. This option appears only for the specification that is enabled for auto-generation of ID.
Click the Entity Identification Specification to create a new Entity Identification specification.


	Select	Click to select an existing Entity Identification specification.
	Clear	Click to deselect an Entity Identification specification.
	Description	Enter a description of the specification.







Related Topics

Defining Specification Properties










Specification Editor Related Specifications Tab

Use the Related Specifications tab to relate a specification to another specification or change relationship properties.


	Field	Use
	Display Name	Enter the name that appears in Design Studio editors and in UIM.
Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


	Specification	Displays the name of the specification.
	Cartridge	Displays the name of the cartridge project into which the specification is built.
	Type	Displays the type of the specification, such as Service specification or Place specification.
	Relationship	Indicates that the related entity is designated as either a parent or a child of the entity being edited. The normal relationship is defined as a child. You must specify a parent relationship only when the related entity is in a separate cartridge that exists independently.
	Minimum Quantity and
Maximum Quantity

	Displays the minimum number of instances that may be provided by the relationship and the maximum number of instances that may be provided by the relationship. Select the specification row and click Modify to change the values for these fields.
	Select	Click to select an existing specification to which you can relate the selected specification.
	Modify	Click to modify any of the following relationship properties:
	
Name: The name of the relationship.


	
Status: Indicates whether the relationship between the specifications is active or inactive.


	
Relationship: Indicates that the related entity is a parent or a child of the entity being edited. The default relationship is CHILD. Select PARENT if the relationship owner is the child and the relationship target is the parent.


	
Minimum Quantity: The minimum number of instances that may be provided by the relationship.


	
Maximum Quantity: The maximum number of instances that may be provided by the relationship.


	
Description: A description of the relationship.




See "Changing Specification Relationship Properties" for more information.


	Remove	Click to remove the related specification.







Related Topics

Defining Specification Relationships










Specification Editor Configuration Spec Usage Tab

Use the Configuration Spec Usage tab to define the configuration specifications and configuration items in which a specification is listed as an option.

You can use this tab to add specification options to configuration items without having to modify the configuration specification. This is useful for extending technology packs. See "Extending Technology Packs and Cartridges by Adding Content" for more information about extending technology packs.




	
Note:

If you are not extending a technology pack or an external cartridge, define configuration items and specification options from the configuration specification.








	Field	Use
	Configuration Spec	Displays the name of the configuration specification.
	Cartridge	Displays the name of the cartridge project into which the configuration specification is built.
	Type	Displays the type of the configuration specification, such as Service Configuration specification or Place Configuration specification.
	Item Path	Displays the path to the configuration specification item where the edited specification may be used as a specification option.
	Select	Click to select an existing configuration specification.
	Remove	Click to remove the configuration specification.







Related Topics

About Configuration Specification Usage

Defining Configuration Specification Usage










Specification Editor Rules Tab

Use the Rules tab to extend or customize any UIM specification by adding ruleset extension points. The ruleset extension point brings together a ruleset, which defines the customized behavior, and the extension point, which defines when the rule will be executed.

For information about extending specifications, see UIM Developer's Guide.


	Field	Use
	Ruleset Extension Point	Displays the ruleset extension points that are added to a UIM specification.
	Cartridge	Displays the name of the cartridge project into which the ruleset extension point is built.
	Select	Click to select a ruleset extension point that you want to add to a UIM specification.
	Remove	Click to remove a ruleset extension point that is already added to a UIM specification.
	Add	Click to add a new ruleset extension point to a UIM specification.







Related Topics

Associating Specification-Based Extension Points to Rulesets










Specification Editor Layouts Tab

Use the Layouts tab to define which elements appear in UIM for the entities created from the specification.

See "Settings Tab" for information about the fields that appear in the UI Settings area.


	Field	Use
	Display Name	Enter the name that appears in Design Studio editors and in UIM.
Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


	Page/Panels	Select the UIM run-time application page layout type.
You can define different attributes for characteristics when they appear on different types of pages. For example, you can define an edit mask for a characteristic when it appears on an edit page, and a display mask for the same characteristic when it appears on a summary page.

The options available in this field are defined in the ora_uim_mds project. You must import and open this project and the ora_uim_model project in your workspace before modeling UIM entities in Design Studio.


	Available column	Displays the elements that are available to be displayed as fields in the run-time user interface, but which are not currently selected. Use the arrow keys to move the elements between the Available column and the Selected column.
	Selected column	Displays the elements that will appear as fields in the run-time UI, and includes the characteristics (defined on the Characteristics tab) and all derived data. The fields are displayed in the order in which they appear in the product. Use the up and down arrow keys to reposition the elements in this column.
Select a characteristic to view the user interface (UI) settings. See "Settings Tab" for more information about the fields in the UI Settings area.

See UIM Help for information about how to use these fields in the UIM run-time environment.


	Reset	Click to revert the layout back to the most recently saved version.







Related Topics

About Specification Layouts










Specification Editor Media Tab

Use the Media tab to add a media file, such as a JPG or GIF file, to a specification. When adding media files, you can specify the media type to determine the orientation of the image and how the image is used in the application.

For example, a media file of type front is used to display an entity as a node in a network visualization, as a node in a service topology visualization, and as an equipment (if the equipment is of the type "CARD") in an equipment visualization. A media type of right would indicated that the image be used when the right side of the object is displayed. A media of type icon is used when displaying the equipment in a tree view.




	
Note:

UIM uses the media types front and icon only.








	Field	Use
	Media Type	Click to select how the media is to be used in the application. Select:
	
front to represent the front view of the object.


	
back to represent the back view of the object


	
top to represent the top view of the object.


	
bottom to represent the bottom view of the object.


	
right to represent the right side of the object.


	
left to represent the left side of the object.


	
tiny to use a small version of the object in tree views.


	
icon to use an icon to represent the object.


	
background to represent the background of a visualization display.





	Media File	Displays the path of the media file, such as JPG or GIF, which you have added to the specification.
	Remove	Click to remove a media file.
	Add	Click to add a new media file.







Related Topics

Adding Media to a Specification










Specification Editor Extends Tab

Use the Extends tab to inherit the data elements of the corresponding business model entity.


	Field	Use
	Extends	Click the link to open the selected entity in a Specification editor.
Click Clear to delete the selection and remove the association.

Click Select to select a business model entity. The specification inherits all characteristics and default data elements of the business model entity. Inherited data elements are read-only.


	Realizes	Appears only for specifications that realize conceptual model entities.
Click the link to open the associated conceptual model entity.

Click Clear to delete the selection and remove the association.

Click Select to associate the specification with a conceptual model entity from a list of available entities.









Related Topics

Reviewing Specification Extensions











Inventory Entity Editor

You use the Inventory Entity editor to review the inventory entities included in the ora_uim_model project. The editor displays the default data elements defined for the entity and (when applicable) the base entity from which the entity inherits data elements. This editor is read-only and is for informational purposes only.











Working with Characteristics

Characteristics are data elements that enable you to add properties to entities that are created from specifications. A characteristic can be associated to multiple entity specifications. When an entity instance is created from a specification, that instance includes the characteristics defined at the specification level.

When working with characteristics, see the following topics:

	
About Control Types


	
About Masks


	
Creating Characteristics


	
Populating Drop-Down Lists


	
Adding Existing Characteristics to Specifications


	
Overriding Default Values of Characteristics in Entity Specifications


	
Data Schema Editor Characteristics Tab












About Masks

Masks control the way characteristics (defined with a control type of Numeric or Text) are formatted and displayed in Oracle Communications Unified Inventory Management (UIM).

	
The edit mask controls how text is formatted in editable fields, such as those that appear during creation or update.


	
The display mask controls how text is formatted in read-only fields.




You use Java regular expressions to define the edit and display masks. For example, to format the text as an IPv4 address, you could use the following regular expression for both masks:

\\d{3}.\\d{3}.\\d{3}.\\d{3}




	
Note:

When a user enters text in a field, only the text is stored in the UIM database. If you do not specify a display mask, the unformatted text is displayed in pages.







You can use the following Java regular expressions:


	Characters, Predefined Character Classes, or Greedy Quantifier	Description
	x	The character x
	\\
	The backslash character
	\d	A digit: [0-9]
	\D	A non-digit: [^0-9]
	\s	A whitespace character: [ \t]
	\w	A word character: [a-zA-Z_0-9]
	X?	X, once or not at all
	X*	X, zero or more times
	X+	X, one or more times






For additional information, see Java regular expression documentation:


http://java.sun.com/javase/6/docs/api/java/util/regex/Pattern.html



Related Topics

About Control Types










Creating Characteristics

A characteristic is a data element that you intend to associate with a Design Studio for Inventory specification. You create characteristics by creating new data elements and tagging those elements as characteristics.

Oracle Communications Design Studio enables you to leverage the data elements from various entities and available for use in the workspace. When modeling data, you can create common data schemas (for example, schemas in Model projects) to enable product-agnostic data type modeling. Also, you can create product-specific data schemas (for example, data schemas in your Inventory projects). See "Modeling Data" for more information.

When creating characteristics, see the following topics:

	
Creating Characteristics in the Dictionary View


	
Creating Characteristics from the Specification Editor


	
Tagging Data Elements as Characteristics


	
Create and Add Characteristic Data Element Dialog Box












Creating Characteristics in the Dictionary View

In the Dictionary view, you can create data elements that are automatically tagged as a characteristic.

To create a characteristic in the Dictionary view:

	
From the Studio menu, select Show Design Perspective.


	
Click the Dictionary tab.


	
Right-click in the Dictionary view and select Add Characteristic.

The Create and Add Characteristic dialog box appears.


	
Define the information about the new characteristic.

See "Create and Add Characteristic Data Element Dialog Box" for information about the fields in this dialog box.


	
Click Finish.

The new characteristic appears in the Dictionary view.





Related Topics

Creating Characteristics

Modeling Data










Creating Characteristics from the Specification Editor

You can create new data elements that are automatically tagged as characteristics when working in any Specification editor.

To create a characteristic from a Specification editor:

	
Create a new specification or open an existing specification in the Specification editor.

See "Creating New Specifications" for more information.


	
Click the Characteristics tab.


	
In the data tree area, right-click and select Add Characteristic.

The Create and Add Characteristic dialog box appears.


	
Define the information about the new characteristic.

See "Create and Add Characteristic Data Element Dialog Box" for information the fields in this dialog box.


	
Click Finish.

The new characteristic appears in the Characteristics tab data tree.


	
From the File menu, select Save.





Related Topics

Creating Characteristics

Specification Editor Characteristics Tab

Modeling Data










Tagging Data Elements as Characteristics

You can identify a data element as a characteristic using Design Studio tags. When modeling specifications, you can filter entities to display only those data elements tagged as characteristics.

To tag data elements as characteristics:

	
From the Solution view, double-click a Data Schema entity.

The Data Schema entity appears in the Data Schema editor.


	
In the Dictionary area, select the data element that you want to tag as a characteristic.

The data element subtabs appear in the Elements area.


	
Click the Tags subtab.


	
Click Add.

The Tag Selection dialog box appears.


	
Select Characteristic and click OK.


	
(Optional) Select a tag and click Remove to delete the association.


	
From the File menu, select Save.





Related Topics

Creating Characteristics

Modeling Data










Create and Add Characteristic Data Element Dialog Box

You use the Create and Add Characteristic Data Element dialog box to create new data elements that are automatically tagged as characteristics.


	Field	Use
	Entity	Displays the schema entity in which the new characteristic is saved.
When you create a new Inventory project, Design Studio automatically adds a new schema entity to the project. The name of the schema entity is the same as the name of the project.


	Type	Displays (for some data elements) a base type from which the data element can inherit default data elements. This field is not applicable to data elements tagged as characteristics.
	Primitive Type	Displays the data type for the characteristic. If this characteristic inherits from a base type, this field displays the type of the base element.
Design Studio supports the following primitive data types:

	
String


	
Int


	
Long


	
Decimal


	
Hexbinary


	
Date


	
Date and Time


	
Boolean


	
Float


	
Double


	
Time





	Name	Enter the name for the characteristic.
	Display Name	Edit the characteristic display name.
	Multiplicity	Enables you to define (for some data elements) the minimum number and maximum number of times the data element can appear in the run-time application.
These fields are not applicable to data elements tagged as characteristics.


	Abstract	Enables you to specify (for some data elements) whether the data element is intended to be inherited and not referenced.
This field is not applicable to data elements tagged as characteristics.


	Length	Specify the Minimum and Maximum length of String data types. This field is read-only for characteristics that inherit from a base type.
You must define the minimum and maximum lengths with a nonnegative integer between 0 and 999999999. Select Unbounded to define the maximum length as 999999999.


	Default	(Optional) Assign a default value for the characteristic. The default value must be of the same type as the characteristic. For example, if the characteristic is a String, the default value must be a String.
The length of the default value must be equal to or less than the value defined for the maximum length of the characteristic.

















Populating Drop-Down Lists

You can populate the contents of a drop-down list characteristic in three ways:

	
Static Values: Enables you to populate the drop-down list with a group of values that do not change. See "Populating a Drop-Down list with Static Values" for more information.


	
Entity Link: Enables you to populate the drop-down list with the names of all entities created from the selected specification. See "Populating Drop-Down Lists with Entity Links Using Existing Specifications" and "Populating Drop-Down Lists with Entity Links Using New Specifications" for more information.


	
Query: Enables you to populate the drop-down list with the results of a query that you define. See "Populating Drop-Down Lists with Query Results" for more information.







	
Note:

See "Overriding Values for Drop Down List Characteristics" for information about defining values for drop down lists at the Specification editor level.















Populating a Drop-Down list with Static Values

You can populate a drop-down list with values that do not change.

To populate a drop-down list with static values:

	
Open the Data Schema editor.


	
In the Dictionary area, select a data element.

The data element subtabs appear in the Element area.


	
Click the Settings tab.


	
In the Control Type field, ensure that the DropDown value is selected.

See "About Control Types" for more information.


	
Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic. See "Tagging Data Elements as Characteristics" for more information.


	
In the Data Values area, select Enumerations.


	
Click the Enumerations tab.


	
Click Add.

Design Studio creates a new row in the Included table and uses placeholder text for the Code and Description values.


	
Click the placeholder text in the Code or Description columns.

The placeholder text becomes editable.


	
Edit the placeholder text.

The contents of these fields are stored in the database, but only the Description field is displayed to the user in UIM. For example, you may want Red as the label displayed to the user, but 1 as the value stored in the database.

You can enter text in the Code field without entering text in the Description field. In this case, the Code text is displayed.


	
(Optional) To make the enumeration the default value in the run-time environment, click inside the Default column and select Yes.


	
(Optional) To remove a value from the table, select any value and click Remove.


	
From the File menu, select Save.













Populating Drop-Down Lists with Entity Links Using Existing Specifications

Entity links enable you to populate the drop-down list with the names of all entities created from the selected specification. For example, if you specify a Logical Device specification named Customer Edge Router, the drop-down list includes the names of all Logical Device instances created from the Customer Edge Router specification.

To populate a drop-down list with the names of entity instances created from an existing specification:

	
Open the Data Schema editor.


	
In the Dictionary area, select a data element.

The data element subtabs appear in the Element area.


	
Click the Settings tab.


	
In the Control Type field, ensure that DropDown is selected.

See "About Control Types" for more information.


	
Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic. See "Tagging Data Elements as Characteristics" for more information.


	
In the Drop Down Options field, select Entity Link.


	
In the Entity Link area, click Select.

The Entity Selection dialog box appears, containing a list of available specifications.


	
Select a specification in the list.

To shorten the list of specifications, enter characters in the Select an item to open field. The list displays specifications whose names begin with the characters you enter. You can use the wildcard characters shown in the dialog box.


	
Click OK.

The specification you selected is displayed in the Entity Link area.


	
(Optional) Click the Entity link.

The editor for the selected specification opens.


	
(Optional) To remove a selected specification from the Entity Link area, click Clear.


	
From the File menu, select Save.













Populating Drop-Down Lists with Entity Links Using New Specifications

Entity links enable you to populate the drop-down list with the names of all entities created from the selected specification. For example, if you specify a Logical Device specification named Customer Edge Router, the drop-down list includes the names of all Logical Device instances created from the Customer Edge Router specification.

To populate a drop-down list with the names of entity instances created from a new specification:

	
Open the Data Schema editor.


	
In the Dictionary area, select a data element.

The data element subtabs appear in the Element area.


	
Click the Settings tab.


	
In the Control Type field, ensure that DropDown is selected.

See "About Control Types" for more information.


	
Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic. See "Tagging Data Elements as Characteristics" for more information.


	
In the Drop Down Options field, select Entity Link.


	
In the Entity Link area, click Entity.

The New Studio Entity dialog box appears.


	
Select an entity type, then click Next.

The Entity Specification Wizard appears. See "Creating New Specifications" for more information.


	
Configure the properties of the new specification.

See "Specification Editor" for more information.


	
When you finish configuring the new specification, return to the Data Schema editor.

The new specification is displayed in the Entity Link area.


	
From the File menu, select Save.













Populating Drop-Down Lists with Query Results

You can populate drop-down lists with the results of a query that you define. You use Java Persistence Query Language (JPQL) commands to write the query to search for values that are stored in instance data.

To populate a drop-down list from the results of a query:

	
Open the Data Schema editor.


	
In the Dictionary area, select a data element.

The data element subtabs appear in the Element area.


	
Click the Settings tab.


	
In the Control Type field, ensure that DropDown is selected.


	
Click the Characteristics tab.


	
In the Drop Down Options field, select Query.


	
(Optional) Do one of the following:

	
Click Select.

The Element Selection dialog box appears. You can select a characteristic to use in a filtered data query. When you use a filtered data query, you must include in the query string a "?" to indicate where in the query the characteristic parameter is to be used.


	
Click Parameter.

The Create Data Schema Element dialog box appears. You can create a new characteristic for use in the filtered data query.





	
In the Body field, enter a JPQL query.

For example, you can create a City Name characteristic as a drop-down list populated with all GeographicPlace instances created from the City specification.

The query for this data is as follows:


Select name from GeographicPlace where specification.name.contains(”City”)


	
From the File menu, select Save.














Adding Existing Characteristics to Specifications

You can add existing characteristics to specifications.




	
Note:

You can also create new characteristics in Specification editors. See "Creating Characteristics from the Specification Editor" for more information.







To add existing characteristics to a specification:

	
Create a new specification or open an existing specification in the Specification editor.

See "Creating New Specifications" for more information.


	
Click the Characteristics tab.


	
In the data tree area, right-click and select Select Characteristic.

The Select Characteristic dialog box appears.

See "Select Characteristic Dialog Box" for more information.


	
Select a characteristic and click OK.

The characteristic appears in the Characteristics tab data tree.


	
From the File menu, select Save.





Related Topics

Specification Editor Characteristics Tab









Select Characteristic Dialog Box

Use the Select Characteristic dialog box to search for and select existing characteristics.


	Field	Use
	Element and Entity Name	Search for specific characteristics or for specific entities.
	
The search is not case sensitive.


	
Use a space between terms to search on multiple terms.


	
Add OR between terms to search for either one or the other. For example, entering 32 OR aa returns names with either 32 or aa.


	
Variations of a word are returned. For example, a search query for ID returns productID, customerID and orderID.


	
Use a negative sign (-) before a second search term to omit specific variations of words (ensure there is a space before the negative sign). For example, a search query for ID -product returns customerID and orderID, but not productID.




















Overriding Default Values of Characteristics in Entity Specifications

You can override the default values of characteristics when you add them to entity specifications and entity configuration specifications. Additionally, you can override the values defined for drop down lists. This capability enables you to adjust values to meet specific circumstances without having to create new characteristic specifications.

When overriding characteristic default values, see the following topics:

	
About Characteristic Attribute Overrides


	
Overriding Characteristic Default Values


	
Overriding Values for Drop Down List Characteristics












About Characteristic Attribute Overrides

Characteristics that you add to specifications can have attributes defined at the data schema level. You can override the values defined at the data schema level by editing the characteristic attributes for a specific specification. In this case, the override applies only in the entity or entity configuration specification where you made the change. For example, if you change the values for a drop-down list in a particular Logical Device specification, those changes apply only to that specification. If you use the drop-down list in another specification, it retains its originally defined values.

You must ensure that override values meet all restrictions defined in the characteristic specification. For example:

	
The value must be within the valid values that you defined on the characteristic. For example, for numeric text type characteristic, if the valid value range is from 3 to 5, you get an error message if you enter 6.


	
The value must conform to an edit mask or display mask if one is defined for the characteristic.


	
The value must conform to the length defined for the characteristic.





Related Topics

Overriding Characteristic Default Values

Overriding Values for Drop Down List Characteristics










Overriding Characteristic Default Values

To override default values of characteristics:

	
Create a new specification or open an existing specification in the Specification editor.

See "Creating New Specifications" for more information.


	
Click the Layouts tab.


	
In the Page/Panels field, select a page type for the specification.

You can define different attributes for a characteristic when it appears on different types of pages. For example, you can define an edit mask for the characteristic when it appears on an edit page and a display mask for the same characteristic when it appears on a summary page.




	
Note:

The options available in the Page/Panels field are defined in the ora_uim_mds project. You must import and open this project and the ora_uim_model project in your workspace before modeling UIM entities in Design Studio.








	
In the Panels/Element area, select a characteristic in the Select column.

The characteristic attribute fields appear in the UI Settings area. The fields that appear are determined by the value in the Control Type field.


	
Specify override values for the characteristic.

The values that you define here override the values defined for the characteristic at the data schema level. See "Settings Tab" for information about the fields that appear in the UI Settings area.


	
From the File menu, select Save.





Related Topics

About Characteristic Attribute Overrides

Overriding Values for Drop Down List Characteristics










Overriding Values for Drop Down List Characteristics

To override default values of characteristics defined as drop down lists:

	
Create a new specification or open an existing specification in the Specification editor.

See "Creating New Specifications" for more information.


	
Click the Characteristics tab.


	
In the data tree area, select a characteristic with a control type defined as DropDown.

The characteristic attribute subtabs appear.

See "Settings Tab" for information about defining the control type.


	
Click the Data Values subtab.


	
Do any of the following:

	
Click Add to add additional values to the drop down list.


	
Select a value listed in the table and click the arrow to move the value to the Excluded table.

You cannot delete values defined at the data schema level. However, you can prevent these values from appearing in the list for specific specifications by moving them to the Excluded table.

Select a value and click Remove to delete a value from the drop down list. You cannot delete values defined at the data schema level.


	
Click inside the Default column and select Yes to make the selected value the default value in the run-time environment.





	
From the File menu, select Save.





Related Topics

About Characteristic Attribute Overrides

Overriding Characteristic Default Values

Enumerations Tab











Data Schema Editor Characteristics Tab

Use the Data Schema editor Characteristics tab to define valid dates for calendar-type characteristics and to define enumerations (also known as drop down list values) for drop down-type characteristics.




	
Note:

You can define valid values for characteristics at two different levels: at the schema level (general) and at the specification level (specific). Design Studio evaluates the values defined for characteristics from the general level to the specific level. For example, the characteristic properties defined at the data element level (defined for data elements in the Data Schema editor) are overridden if you define properties for the same characteristic at the specification level (properties defined in the Specification editor).
See "Specification Editor Layouts Tab" for more information about defining characteristic attributes at the specification level.










	Field	Use
	Start Date	Select the date after which the calendar-type field is valid.
	End Date	Select the date after which the calendar-type field is invalid.
	Drop Down Options	Select one of the following:
	
Select Enumerations to populate the drop down list with a set of statically-defined values. See "Creating Data Element Enumerations" and "Enumerations Tab" for more information.


	
Select Entity Link to populate the drop down list with the names of all entities created from the selected specification. Use the options in the Entity Link area to complete the configuration.


	
Select Query to populate a drop-down list with the results of the query that you define. Use the options in the Query area to complete the configuration.





	Entity Link	If you selected Entity Link in the Drop Down Options field, you can populate the drop down list with the names of all entities created from the selected specification.
Do one of the following:

	
Click the Entity link to create and use a new specification.


	
Click Select to use an existing specification.


	
Click Clear to remove the selection.





	Query	If you selected Query in the Drop Down Options field, you can populate a drop-down list with the results of the query that you define.
Do one of the following:

	
Click Parameter to create and use a new query.


	
Click Select to select an existing characteristic for the query parameter.


	
Click Clear to remove the selection.




















Working with Configurations

Oracle Communications Unified Inventory Management (UIM) Service, Place, Network, Pipe, Logical Device, and Logical Device Account specifications can have configurations associated with them. A configuration describes details about how an entity is realized, and how it is supported by the resources that enable it.

When working with configurations, see the following topics:

	
About Configurations


	
About Configuration Items


	
Creating Configuration Specifications


	
Adding Configuration Items


	
Configuration Specification Editor












About Configurations

A configuration is a hierarchically organized collection of facts (configuration items) in the form of characteristics, resource allocations, and entity references. Configurations can be versioned such that a collective set of facts can be organized, managed and referenced as a unit (version) with its own life cycle. Service, Place, Network, Pipe, Logical Device, and Logical Device Account specifications can have configurations associated with them.




	
Note:

The term Place Configuration specification applies to places that are of type Geographic Site.







In general, configurations should contain the bulk of the information about the specification. They should contain the characteristics that are likely to change over time, while the service itself should contain attributes that are unlikely to change: name, description, and so on.

Configurations are separate entities that are defined by specifications. Configurations include the following features that are not available in other entities:

	
Configuration items: Define the content of the configuration. Configuration items can include child items, which are arranged hierarchically. Each configuration item can have its own properties, characteristics, layout, and specification options. See "Adding Configuration Items" for more information.


	
Specification options: Define the entities that can be allocated or referenced to a configuration item.





Related Topics

Adding Existing Configurations to a Service Specification

Adding Existing Configurations to a Network Specification

Adding a Configuration to a Pipe Specification

Adding Existing Configurations to a Logical Device Specification

Adding Existing Configurations to a Logical Device Account Specification










About Configuration Items

Configuration items enable you to create a hierarchy of items within a configuration. Configuration items can contain other configuration items, so you can nest information to capture how resources are organized.

In Oracle Communications Design Studio, configuration items appear in a hierarchical format in the Configuration area of the entity Configuration Specification editor.


Configuration items enable you to assign or reference resources to the configuration and to configure those resources appropriately (entities referenced to the configuration are not consumed by the configuration). You can add any of the following to configuration items:

	
Minimum and maximum quantities: These determine how many instances of the item can be included in the configuration. The minimum quantity also dictates the items that are automatically created when you create a configuration version or add a new configuration item, with child configuration items, to a configuration version.


	
Characteristics: You use characteristics to capture specific attributes about the configuration item. You can override the default values defined in a characteristic specification. See "Overriding Default Values of Characteristics in Entity Specifications" for more information.


	
Specification options: You use specification options to determine which entities can be referenced by or allocated to a service, place, pipe, network, logical device, logical device account, and so forth. When you create a specification option, you associate one or more specifications with it. See "Configuration Specification Editor Specification Options Subtab" for more information.





Related Topics

Adding Configuration Items










Creating Configuration Specifications

You can create a configuration specification independently or create a new configuration specification in the processing of adding it to a Service, Place, Network, Pipe, Logical Device, or Logical Device Account specification.




	
Note:

Place configurations apply only to places defined as sites.







To create a configuration specification:

	
Do one of the following:

	
If you are creating the configuration independently, from the Studio menu select New, then select Inventory, then select a conceptual division, then select one of the configuration specifications.


	
If you are creating a configuration while adding it to a specification, open the Specification editor, click the configurations tab (for example, in the Service Specification editor, click the Service Configurations tab), then click Add.




The Entity Configuration Specification Wizard appears.


	
In the Project field, select the name of the project to which the new configuration specification should be added.


	
In the Name field, enter a name for the new configuration specification.

The name you enter appears in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the new configuration specification and displays its information in an editor.





Related Topics

Adding Configuration Items

Adding Existing Configurations to a Service Specification

Adding Existing Configurations to a Network Specification

Adding a Configuration to a Pipe Specification

Adding Existing Configurations to a Logical Device Specification










Adding Configuration Items


Configuration items enable you to create a hierarchy of items within a configuration.

To add configuration items:

	
In the Studio Projects view, double-click any entity configuration specification to open it in an entity Configuration Specification editor.


	
Click the Details tab.


	
In the Details tab data tree area, do one of the following:

	
Right-click a configuration item that will be the parent of the new configuration item in the hierarchy.


	
Right-click in the white space to add a configuration item at the top level.





	
Select Configuration Items, then select Add Item.

The Create Configuration Item dialog box appears.


	
Enter a name for the configuration item, then click OK.

The new configuration item appears in the Details tab data tree area.


	
Select the new configuration item.


	
On the Details tab Details subtab, select minimum and maximum quantities in the Multiplicity fields.

Set the Minimum field to a non-zero value to indicate that the configuration item is required in the configuration and that the specified number of items will be created automatically in UIM when an instance of the configuration is created.

See "Details Tab" for more information about the fields on this subtab.


	
Add characteristics to the configuration item.

See "Adding Characteristics to Configuration Items" for more information.


	
Add specification options to the configuration item.

See "Adding Specification Options to Configuration Items" for more information.


	
From the File menu, select Save.












Adding Characteristics to Configuration Items

Characteristics enable you to add attributes to the configuration item.




	
Note:

When necessary, you can override the default values defined for a characteristic at the data schema level. The override applies only to the characteristic as it is used in a specific configuration specification. See "Overriding Default Values of Characteristics in Entity Specifications".







When adding characteristics to configuration items, you can add existing characteristics or you can create new characteristics to add to the configuration item. See the following topics for more information:

	
Adding Existing Characteristics to Configuration Items


	
Adding a New Characteristic to Configuration Items












Adding Existing Characteristics to Configuration Items

To add existing characteristics to configuration items:

	
In the Solution view, double-click any entity configuration specification.

The entity Configuration Specification editor opens.


	
Click the Details tab.


	
In the Details tab data tree area, right-click a configuration item and select Select Characteristic.

The Select Characteristic dialog box appears. See "Select Characteristic Dialog Box" for more information.


	
Select a characteristic from the list and click OK.

The characteristic is added to the configuration item in the Details tab data tree.


	
From the File menu, select Save.





Related Topics

Adding New Specification Options to Configuration Items

Configuration Specification Editor










Adding a New Characteristic to Configuration Items

You can create new characteristics to add to a configuration item.

To add a new characteristic to configuration items:

	
In the Solution view, double-click any entity configuration specification.

The entity Configuration Specification editor opens.


	
Click the Details tab.


	
In the Details tab data tree area, right-click a configuration item and select Add Characteristic.

The Create and Add Characteristic dialog box appears. See "Create and Add Characteristic Data Element Dialog Box" for more information.


	
Click Finish.

The characteristic is added to the configuration item in the Details tab data tree.


	
In the Details tab data tree, select the characteristic.


	
In the Details tab subtabs, define the attribute information for the characteristic.

See "Design Studio Common Editor Tabs" for more information about the fields on these subtabs.


	
From the File menu, select Save.





Related Topics

Adding Existing Characteristics to Configuration Items

Configuration Specification Editor











Adding Specification Options to Configuration Items

Specification options enable UIM users to associate entities to configuration items. There are two kinds of specification options:

	
Assignments (or allocations) mean that a resource (such as a logical device or pipe) is consumed by the configuration.


	
References indicated the interest in or significance of an entity to the configuration. The entity is not consumed, but referenced.




In Design Studio, when you add specifications as reference or assignment options to a configuration item, entities based on the specification will be available for assignment or reference in UIM. The entities that are available to assign or reference depend on the specification type. For example, you can use a service configuration to allocate telephone numbers, but you cannot use a network configuration to allocate telephone numbers.

You can add existing specifications as specification options to configuration items or create new specifications in process of adding them. See the following topics for more information:

	
Adding Existing Specifications to Configuration Items


	
Adding New Specification Options to Configuration Items












Adding Existing Specifications to Configuration Items

To add existing specifications to configuration items:

	
In the Solution view, double-click any entity configuration specification.

The entity configuration specification editor opens.


	
Click the Details tab.


	
In the Details tab data tree area, select a configuration item.


	
Click the Specification Options tab.


	
In the Item Option Type field, select an option type.

You can select Assignment or Reference. The default value is None. See "Configuration Specification Editor Specification Options Subtab" for more information.


	
Click Add.

The Specification Option dialog box appears.


	
Click Select.

The Selection Dialog dialog box appears.


	
Select a specification, then click OK.

The specification name appears in the Specification field of the Specification Option dialog box.


	
Click OK.

The entity specification appears in the Specification Options tab.


	
From the File menu, select Save.





Related Topics

Adding New Specification Options to Configuration Items

Configuration Specification Editor

Specification Editor Configuration Spec Usage Tab










Adding New Specification Options to Configuration Items

You can create new specification options to add to the configuration item.

To add a new specification option to configuration items:

	
In the Solution view, double-click any entity configuration specification.

The entity Configuration Specification editor opens.


	
In the Configuration area, select a configuration item.


	
Click the Specification Options tab.


	
In the Item Option Type field, select an option type.

You can select Assignment or Reference. The default value is None. See "Configuration Specification Editor Specification Options Subtab" for more information.


	
Click Add.

The Specification Option dialog box appears.


	
Click New.

The New Studio Entity dialog box appears. See Selecting "Selecting Entity Types" for more information.


	
Select an entity type, then click Next.

The Entity Specification Wizard appears.


	
Create the new specification.

See "Creating New Specifications" for more information.


	
In the Specification Option dialog box, click OK.


	
From the File menu, select Save.





Related Topics

Adding Existing Specifications to Configuration Items

Configuration Specification Editor











Adding Rules to Configurations

You can define rule set extension points for the entire configuration. When adding rules to configurations, you can add existing rules or you can create new rules to add to the configuration. See the following topics for more information:

	
Adding Existing Rules to Configurations


	
Adding New Rules to Configurations












Adding Existing Rules to Configurations

You can add existing rules to a configuration.

To add rules to a configuration:

	
In the Solution view, double-click any entity configuration specification.

The entity Configuration Specification editor opens.


	
Click the Rules tab.


	
Click Select.

The Selection Dialog dialog box appears, containing a list of available rule set extension points.


	
Select a rule in the list.


	
Click OK.

The rule that you selected is displayed in the Ruleset Extension Point area.





Related Topics

Adding New Rules to Configurations

Configuration Specification Editor










Adding New Rules to Configurations

You can create new rules to add to a configuration.

To add a new rule to a configuration:

	
In the Solution view, double-click any entity configuration specification.

The entity Configuration Specification editor opens.


	
Click the Rules tab.


	
Click Add.

The Ruleset Extension Point Wizard appears.


	
In the Project field, select the name of the project to which the new rule should be added.


	
In the Name field, enter a name for the new rule.

The name you enter appears in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

The rule that you added is displayed in the Ruleset Extension Point column.





Related Topics

Adding New Rules to Configurations

Configuration Specification Editor











Associating Tags with Configuration Items

Tags are keywords that you can use to categorize data elements and instances of entities. Tags help you filter and search for data elements that are associated with specific Oracle Communications applications. See "Working with Tags" for more information.

You can create your own tags and associate your tags to configuration items that you add to Service, Place, Logical Device, Logical Device Account, and Network entity Configuration specifications. Associating tags with configuration items that you add to Configuration specifications enables UIM users to search for tags using the Tags Search page. At run time, the tag is visible (on the Configuration Summary page) for all instances of entities that were created from the Configuration specification. These tags are also visible in the getConfiguration and getConfigurationDifferences Web service operations, which are included in the Service Fulfillment Web service. The getConfiguration Web service operation response contains the tag information from the request.




	
Note:

You cannot associate tags with configuration items that you add to Pipe Configuration specifications.







To associate a tag with configuration items:

	
Create a new tag in a Model project.

When creating the new tag, complete the optional step to define the Build Directives attribute with the system-delivered Generate Inventory Runtime Tag tag. See "Creating Tags" for more information.


	
Create a dependency between the Model project and the Design Studio for Inventory project in which you intent to save the Configuration specification.

See "Managing Project Dependencies" for more information.


	
Open the Configuration Specification editor for the entity with which you want to associate the tag.


	
On the Details tab, select a configuration item.


	
Click the Tags tab.


	
Click Add.

A list of tags appears. The list includes all user-defined tags with a Build Directives attribute defined as Generate Inventory Runtime Tag.


	
Select a tag from the list and click OK.

The tag appears on the Tags tab and is now associated with the configuration item.


	
Deploy the Design Studio for Inventory Cartridge project to the run-time environment.

UIM users can search for tags using the Tags Search page. At run time, the tag is visible (on the Configuration Summary page) for all instances of entities that were created from the Configuration specification. See UIM Help for more information.














Configuration Specification Editor

You use a Configuration Specification editor to model a hierarchically organized collection of configuration items, which can contain characteristics and resource allocations.

When working with a Configuration Specification editor, see the following topics:

	
About the Configuration Specification Editor Context Menu


	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab







	
Note:

Some types of configuration specifications also contain a Specs tab. See the Help topics specific to those editors for more information.















Configuration Specification Editor Details Tab

Use the Details tab to create, select, and remove characteristics and configuration items.

When working with the Details tab, see the following topics:

	
About the Configuration Specification Editor Context Menu


	
Details Tab


	
Information Tab


	
Usage Tab


	
Configuration Specification Editor Data Values Subtab


	
Configuration Specification Editor Layouts Subtab


	
Configuration Specification Editor Tags Subtab


	
Configuration Specification Editor Specification Options Subtab












About the Configuration Specification Editor Context Menu

The Details tab context menu contains actions specific to characteristics. To access these actions, you right-click in the left column of the tab. The context menu options that are available depend on the selection in the editor. For example, the list of context menu options that appear when you right-click in the white space is different than the list that appears when you right-click a characteristic.


	Command	Use
	Add Characteristic	Select to create a new characteristic to add to the configuration specification. See "Creating Characteristics" for more information.
	Select Characteristic	Select to add an existing characteristic to the configuration specification.
	Configuration Items	Select to add a new configuration item to the configuration specification.
	Delete	Select to delete a characteristic or a configuration item from the configuration specification.
	Move Up	Repositions a characteristic in the view by moving it up in the list.
	Move Down	Repositions a characteristic in the view by moving it down in the list.
	Refactoring	Select to access a menu of options for improving names and locations of the characteristics. See "Managing Data Element Names and Locations" for more information.
	Refresh	Refreshes the view.














Configuration Specification Editor Data Values Subtab

Use the Data Values subtab to define sets of valid enumeration values for elements. Enumerations (also referred to as look-up or drop-down values) represent actual values that characteristics can take as valid values.


	Field	Use
	Included table	Click the placeholder text inside the Code and Description columns to change the code name and description for the enumeration.
The value you enter in the Code field is stored in the database. The value you enter in the Description field is displayed to the user.

Enumerations that are inherited from a base type are read-only. Additionally, enumerations can be inherited from an ancestor if the base type does not specifically define its own value space but derives the enumerations from an ancestor.

Click inside the Default column and select Yes to make the selected value the default value in the run-time environment.


	Add	Click Add to add an enumeration for the characteristic you selected in the Included table.
	Excluded table	Displays inherited enumerations that you want to exclude from the list of values in the run-time environment. Move enumerations between the Included and Excluded tables using the arrow buttons. Use this capability to display a subset of the inherited enumerations as valid values for the element in the run-time application.
	Language	For some data elements, you can specify the language in which to display the selected enumeration value.
This field is not applicable to data elements tagged as characteristics.









Related Topics

Configuration Specification Editor Details Tab










Configuration Specification Editor Layouts Subtab

Use the Layouts subtab to define how the characteristics appear for a configuration item in an instance of a configuration specification.

See "Settings Tab" for information about the fields that appear in the UI Settings area.


	Field	Use
	Page/Panels	Select the page type in the UIM run-time environment.
You can define different attributes for a characteristic when it appears on different types of pages. For example, you can define an edit mask for the characteristic when it appears on an edit page, and a display mask for the same characteristic when it appears on a summary page.

Note: The options available in this field are defined in the ora_uim_mds project. You must import and open this project and the ora_uim_model project in your workspace before modeling UIM entities in Design Studio.


	Available column	Displays the elements that are available to be displayed as fields in the run-time user interface, but which are not currently selected. Use the arrow keys to move the elements between the Available column and the Selected column.
	Selected column	Displays the elements that will appear as fields in the run-time user interface, and include the characteristics (defined on the Characteristics tab) and all derived data. The fields are displayed in the order in which they appear in the product. Use the up and down arrow keys to reposition characteristics in this column.
Select an element to view the user interface (UI) settings. See "Settings Tab" for more information about the fields in the UI Settings area.

See UIM Help for information about how to use these fields in the UIM run-time environment.


	Reset	Click to revert the layout to the default version.







Related Topics

About Specification Layouts










Configuration Specification Editor Tags Subtab

Use the Tags subtab to associate a tag with a configuration item.


	Field	Use
	Name	Displays the list of tags associated with the selected configuration item.
	Description	Displays a description of the tag that will appear in the UIM run-time application.
	Build Directives	Indicates whether the user-defined tag is associated with the system-delivered Generate Inventory Runtime Tag tag.
	Remove	Click to remove the association of the selected tag.
	Add	Click to associate a user-defined tag with the configuration item.







Related Topics

Associating Tags with Configuration Items

Configuration Specification Editor Details Tab

Working with Tags










Configuration Specification Editor Specification Options Subtab

Use the Specification Options subtab to allocate resources by associating instances of specifications with the configuration.


	Field	Use
	Assignment	Select to add a specification option as an assignment.
	Reference	Select to add a specification option as a reference.
	None	Select to indicate that the configuration item cannot consume or reference resources. The configuration item, however, can include child configuration items that consume or reference resources.
	Specification	Displays the selected specification.
	Cartridge	Displays the name of the cartridge project into which the specification option is built.
	Add	Click to add a specification option for an existing specification or for a new one. See "Adding Existing Specifications to Configuration Items" and "Adding New Specification Options to Configuration Items" for more information.
	Modify	Click to modify a specification option for an existing specification.
	Remove	Click to remove a specification option for an existing specification.







Related Topics

Adding Specification Options to Configuration Items

Specification Editor Configuration Spec Usage Tab











Configuration Specification Editor Layouts Tab

Use the Layouts tab to define how the characteristics appear for the configuration specification.

See "Settings Tab" for information about the fields that appear in the UI Settings area.


	Field	Use
	Page/Panels	Select the page type in the UIM run-time environment.
You can define different attributes for a characteristic when it appears on different types of pages. For example, you can define an edit mask for a characteristic when it appears on an edit page, and a display mask for the same characteristic when it appears on a summary page.

Note: The options available in this field are defined in the ora_uim_mds project. You must import and open this project and the ora_uim_model project in your workspace before modeling UIM entities in Design Studio.


	Available column	Displays the elements that are available to be displayed as fields in the run-time user interface, but which are not currently selected. Use the arrow keys to move the elements between the Available column and the Selected column.
	Selected column	Displays the elements that will appear as fields in the run-time user interface, and includes the characteristics (defined on the Characteristics tab) and all derived data. The fields are displayed in the order in which they appear in the product. Use the up and down arrow keys to reposition characteristics in this column.
Select a characteristic to view the user interface (UI) settings. See "Settings Tab" for more information about the fields in the UI Settings area.

See UIM Help for information about how to use these fields in the UIM run-time environment.


	Reset	Click to revert the layout to the default version.







Related Topics

About Specification Layouts










Configuration Specification Editor Rules Tab

Use the Rules tab to extend or customize a UIM specification by adding extension points and rule sets.


	Field	Use
	Ruleset Extension Points	Displays the rule set extension points that are added to a UIM specification.
	Cartridge	Displays the name of the cartridge project into which the rule set extension point is built.
	Select	Click to select a rule set extension point that you want to add to a UIM specification.
	Remove	Click to remove a rule set extension point that is already added to a UIM specification.
	Add	Click to add a new rule set extension point to a UIM specification.







Related Topics

Adding Rules to Configurations

Working with Rulesets and Extension Points












Working with Product and Service Specifications

In Oracle Communications Unified Inventory Management (UIM), products and services are closely related. Products are marketed and sold to customers, whereas services are provided to support the product. Products and services represent the commercial and technical aspects of the inventory: products represent the commercial view, and the corresponding services represent the technical view.




	
Note:

Product specifications are included in Design Studio for Inventory only for backward compatibility with customized solutions that require mapping services to corresponding products.
See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.









When working with products and services, see the following topics:

	
Working with Product Specifications


	
Working with Service Specifications


	
Working with Service Configuration Specifications












Working with Product Specifications




	
Note:

Product specifications are included in Design Studio for Inventory only for backward compatibility with customized solutions that require mapping services to corresponding products.
See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.









Product specifications can represent any or all of the following items in your inventory:

	
A service to which a customer or subscriber subscribes, such as Broadband Internet access


	
A service that a service provider performs for a customer, such as equipment installation


	
A piece of hardware that a customer purchases or leases




You are not required to create products in UIM. You can create services without the service being associated to a product. You can create products as a way to map to other systems that can send product information to UIM.

Product specifications can also be related to other Product specifications to constrain what products can be hierarchically related in UIM. A Product specification can be related to one or more Service specifications which constrains which services can be related to a product in UIM.

When working with Product specifications, see the following:

	
Defining Product Specifications


	
Product Specification Editor


	
Configuring Backward Compatibility for Product Specifications












Defining Product Specifications




	
Note:

Product specifications are included in Design Studio for Inventory only for backward compatibility with customized solutions that require mapping services to corresponding products.
See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.









When you create Product specifications, you define which Service specifications are included in the product. For example, if you create a product called MPLS VPN, you can specify that only instances of the MPLS VPN Service specifications can be included in the product. You can also relate child product specifications to a product specification.

In Oracle Communications Design Studio, you define the list of valid Service specifications in the Product Specification editor. You can select from existing Service specifications or create new ones. If you do not specify particular Service specifications, then the product can include any service in the inventory.

To define Product specifications:

	
Create a new Product specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
Click the Related Specifications tab.


	
Click Select.

The Selection Dialog dialog box opens.


	
In the Selection Dialog dialog box, do one of the following:

	
Select a specification from the list and click OK to add an existing Service specification to the Product specification.


	
Click New to create and add a new Service specification to the Product specification. See "Creating New Specifications" for more information.




In both scenarios, the Service specification appears in the Related Specification tab.


	
(Optional) Double-click a Service specification in the table.

The appropriate specification editor opens. For example, after creating a new Service specification, you can double-click the new row in the table to configure the specification.


	
(Optional) Select a Service specification in the table and click Modify.

The Relationship Properties dialog appears, where you can view or change information about the relationship between the Service and Product specifications.

See "Specification Editor Related Specifications Tab" for more information about the fields on the Relationship Properties dialog box.


	
(Optional) Select a Service specification in the table and click Remove.

The relationship between the Service specification and Product specification is deleted.


	
From the File menu, select Save.





Related Topics

Product Specification Editor










Product Specification Editor




	
Note:

Product specifications are included in Design Studio for Inventory only for backward compatibility with customized solutions that require mapping services to corresponding products.
See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.









Use the Product Specification editor to define Product specifications. When working with Product specifications, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab













Configuring Backward Compatibility for Product Specifications

Product specifications are included in Design Studio for Inventory for backward compatibility with customized solutions that require mapping services to corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.

If you require Design Studio for Inventory Product specifications for backward compatibility, see the following topics:

	
Copying Existing Product Specifications into an Inventory Project


	
Creating New Product Specifications Entities Using the Java Perspective












Copying Existing Product Specifications into an Inventory Project

Product specifications are included in Design Studio for Inventory for backward compatibility with customized solutions that require mapping services to corresponding products.

If you require Design Studio for Inventory Product specifications for backward compatibility, and if you have existing Product specifications in your workspace that you want to continue to use, you can copy the existing Product specification to a new Inventory project.

To copy existing Product specifications to a new Inventory project:

	
In the Solution view, locate the existing Inventory Product specification in your workspace.


	
Right-click the Product specification and select Copy.


	
Right-click the target Inventory project and select Paste.


	
Click Save.













Creating New Product Specifications Entities Using the Java Perspective

Product specifications are included in Design Studio for Inventory for backward compatibility with customized solutions that require mapping services to corresponding products.

If you require Design Studio for Inventory Product specifications for backward compatibility, and to create new Product specifications in your workspace, you can create the .product Design Studio entity in the Java perspective.

To create new Product specifications using the Java perspective:

	
From the Java perspective, click the Package Explorer tab.

The Package Explorer view appears.


	
Navigate to the Inventory project where you want to create a new Product specification, and select the model folder.


	
Right-click the model folder, then select New, and then select File.

The New File dialog box appears.


	
In the File Name field, enter a name for the file and include the .product extension.

For example, name the file SampleProduct.product.

The new file appears in the model folder in the Package Explorer view.


	
Right-click the new file, select Open With, and then select Text Editor.

The file opens in the Design Studio default text editor.


	
Copy the following XML fragment into the file:


<?xml version="1.0" encoding="UTF-8"?>
<com:modelEntity 
      xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
      xmlns:com="http://www.mslv.com/studio/core/model/common" 
      xmlns:data="http://www.oracle.com/communications/studio/core/model/common/data" 
      xmlns:inv="http://www.mslv.com/studio/inventory/model/specification" 
      xmlns="http://www.mslv.com/studio/inventory/model/specification" 
      xsi:type="inv:ProductSpecificationType" 
      name="SampleProduct">
 
  <com:baseEntityRef>
    <com:entity>Product</com:entity>
    <com:entityType>inventoryEntity</com:entityType>
    <com:relationship>unknown</com:relationship>
  </com:baseEntityRef>
  
  <com:id>Wodf--+O--+fkI4A---+Fg</com:id>
 
  <data:dataElementNode virtual="true">
    <com:id>Wodf--+O--+fkI4A---+Fg</com:id>
    <com:elementType>oracle.communications.studio.model.data.StudioModelDataElement</com:elementType>
    <data:name>SampleProduct</data:name>
    <data:displayName lang="[default]">SampleProduct</data:displayName>
    <data:primitiveType>none</data:primitiveType>
  </data:dataElementNode>
 
  <data:dataElementDetails xsi:type="data:dataElementCommonDetail">
    <com:id>z+l27sgB--+0-mVX--+m1Q</com:id>
    <com:elementType>oracle.communications.studio.model.data.StudioModelDataElementCommonDetails</com:elementType>
    <data:dataElementId>Wodf--+O--+fkI4A---+Fg</data:dataElementId>
    <data:defaultValue></data:defaultValue>
    <data:deprecated>false</data:deprecated>
    <data:sensitive>false</data:sensitive>
    <data:minLength>0</data:minLength>
    <data:maxLength>40</data:maxLength>
    <data:minMultiplicity>0</data:minMultiplicity>
    <data:maxMultiplicity>-1</data:maxMultiplicity>
  </data:dataElementDetails>
</com:modelEntity>


	
Click Save.


	
Switch to the Studio Design perspective.


	
Click the Studio Projects tab.

The Studio Projects view appears.


	
Expand your Inventory project, then expand the Product Specifications folder.

The Product specification that represents the new .product entity appears in the folder.


	
Right-click the new Product specification, then select Copy.


	
Right-click the Inventory project and then select Paste.

The Set Name of Copy dialog box appears.


	
Rename the copy of the Product specification to the desired name.


	
Delete the original Product specification that you created in the Java perspective.


	
Click Save.















Working with Service Specifications

Services represent the technical aspects of the inventory. The information you define on a Service specification is information about the service that is unlikely to change, or that requires no versioning as it changes.

You can create services without the service being associated to a product. Service specifications can also be related to Service configurations which also restrains the configurations that can be created for a service. Service configurations that you relate to a service define information about the service that is likely to change, and information that requires versioning as it changes.

When working with Service specifications, see "Service Specification Editor" for reference information about the tabs you use to define a Service specification.


Related Topics

Creating New Specifications

Working with Service Configuration Specifications









Service Specification Editor

You use the Service Specification editor to define Service specifications. When working with the Service Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Service Specification Editor Service Configurations Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Service Specification Editor Service Configurations Tab

Use the Service Configurations tab to select, add, and remove a service configuration.


	Field	Use
	Service Configuration	Displays the name of the Service Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Service Configuration specification is built.
	Select	Click to select and add an existing service configuration to the Service specification.
	Open	Click to open the selected service configuration in the Service Configuration Specification editor.
	Remove	Click to remove the selected service configuration from the Service specification.
	Add	Click to create a new service configuration and add it to the Service specification. See "Adding Existing Configurations to a Service Specification" for more information.







Related Topics

Service Specification Editor












Working with Service Configuration Specifications

Service Configuration specifications capture the details about the resources used by the service. Because these details can change frequently, service configurations provide a versioning capability that enables the management of the changes to a service over time. As the facts about a service changes over time, new versions of the service configuration can be created.

When you define a Service Configuration specification in Design Studio, you determine the collection of resources that can be allocated to the service. You define these resources as configuration items. The configuration items can have characteristics that enable you to express details about the configuration. The configuration items can be arranged hierarchically. See "Working with Configurations" for more information.

When working with Service Configuration specifications, see the following topics:

	
Adding Existing Configurations to a Service Specification


	
Adding New Configurations to a Service Specification


	
Service Configuration Specification Editor












Adding Existing Configurations to a Service Specification

You can add existing service configurations to a Service specification. The service configuration and the Service specification do not have to be in the same project.

To add an existing service configuration to a Service specification:

	
Open an existing Service Specification entity in the Service Specification editor or create a new Service Specification entity.

See "Creating New Specifications" for more information.


	
Click the Service Configurations tab.


	
Click Select.

The Add Entities dialog box appears.


	
Select the service configuration and click OK.

The service configuration you selected appears in the table.


	
From the File menu, select Save.





Related Topics

Adding Configuration Items

Adding New Configurations to a Service Specification










Adding New Configurations to a Service Specification

You can create and add a new service configurations to a Service specification. The service configuration and the Service specification do not have to be in the same project. You add a service configuration in the Service Configurations tab in the Service Specification editor.

To add a new service configuration to a Service specification:

	
Open an existing Service Specification entity in the Service Specification editor or create a new Service Specification entity.

See "Creating New Specifications" for more information.


	
Click the Service Configurations tab.


	
Click Add.

The Service Configuration Specification Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
In the Name field, enter a name for the new specification.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

The service configuration you added appears in the table.


	
From the File menu, select Save.





Related Topics

Creating Configuration Specifications

Adding Configuration Items

Adding Existing Configurations to a Service Specification










Service Configuration Specification Editor

Use the Service Configuration Specification editor to define Service Configuration specifications.

When working with the Service Configuration Specification editor, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Service Configuration Specification Editor Service Specs Tab












Service Configuration Specification Editor Service Specs Tab

Use the Service Specs tab to select, add, and remove the Service specifications that use the Service Configuration specifications. This tab identifies the Service specifications that use the Service Configuration specification. You must use this tab to relate a Service specification to its Service Configuration specification only when the Service specification and Service Configuration specification need to be in separate cartridges, and the Service specification can exist without the Service Configuration specification. If both the Service specification and Service Configuration specification are in the same cartridge, make the association in the Service Specification editor.


	Field	Use
	Service Specification	Displays the name of the Service specification.
	Cartridge	Displays the name of the cartridge project into which the Service specification is built.
	Select	Click to select an existing Service specification.
	Open	Click to open the selected Service specification in the Service Specification editor.
	Remove	Click to remove a Service specification.
	Add	Click to add a new Service specification.







Related Topics

Service Configuration Specification Editor













Working with Place, Party, and Role Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Place, Party, and Role specifications to describe the geographic entities, the people and organizations, and the functions those entities serve in your inventory.

When working with Place, Party, and Role specifications, see the following topics:

	
Working with Place Specifications


	
Working with Place Configuration Specifications


	
Working with Party Specifications


	
Working with Role Specifications












Working with Place Specifications

You use Place specifications to define geographic entities that can be located on a map, such as a state, city, street, postal address, campus, or building. Place entities answer the business question of where other inventory entities (such as subscribers, services, equipment, service terminations, and so on) are located.

There are four different types of Place specification that describe different geographical entities:

	
Location defines places based on geographic references.


	
Address defines ways to locate places based on textual information.


	
Address Range defines a group of addresses as a range, such as an address defined with a low street number and high street number.


	
Site define places that do not have a single, precise location like a regional office or a cell site that may change physical locations over time.




When working with Place specifications, see the following topics:

	
About the Site Place Type


	
About the Address Place Type


	
About the Address Range Place Type


	
About the Location Place Type


	
Defining Place Types


	
Place Specification Editor












About the Site Place Type

A site is a loosely defined place such as a campus, cell site, or VPN site. Unlike a location, a site is not necessarily bound to specific geographic coordinates. Because sites are only loosely defined, they can evolve over time. For example, you might need to plan a VPN without knowing the specific locations of the VPN sites. You can create configurations to keep track of the changes.

If a site includes multiple specific locations, you can include them in a Place hierarchy for the site. For example, if you create a Site specification instance for a campus, you can create Location specification instances for its individual buildings and include them in the site's Place hierarchy.


Related Topics

Defining Place Types

Place Specification Editor










About the Address Place Type

An Address specification can be used to define a standard address format to meet your business requirements and national postal standards. For example, you could define an Address specification that includes the following information:

	
Street address


	
City name


	
State or province


	
Country


	
Postal code




These individual pieces of information are called address components. You define them as characteristics and add them to a Place specification with the entity type of Address.

Address components are classified into the following categories:

	
Geographically based: Values for these components can be defined as a geographic location based on Location-type Place specification.


	
Non-geographically based: Values for these components cannot be defined as geographic locations, so they are typically captured as text.




For geographically-based address components, you can add characteristics to an Address specification that provide lists of entities of the appropriate type. See "Populating Drop-Down Lists" for more information.


Related Topics

Defining Place Types

Place Specification Editor










About the Address Range Place Type

You use Address Range specifications to define collections of addresses such as those used in Master Street Address Guide (MSAG) implementations. You can include individual addresses in the Place hierarchy of an address range instance.


Related Topics

Defining Place Types

Place Specification Editor










About the Location Place Type

You use the Location type for places that can be specifically defined by geographic references. Locations can be very specific places, such as a residence, or more general places, such as a city or province. In UIM, you create these hierarchies in the Place Hierarchy section of the Place Summary page.

You can geocode a location to identify its placement on the face of the earth and to enable geographic visualizations of your network or business.

Using geographic coordinates also makes it possible to calculate distances between locations.


Related Topics

Defining Place Types

Place Specification Editor










Defining Place Types

You select from the four types of places when modeling Place specifications.

To select a place type:

	
Create a new Place specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
Click the Properties tab.


	
In the Entity Type field, select a place type.

See "Place Specification Properties Tab" for more information.


	
From the File menu, select Save.





Related Topics

Place Specification Editor

Working with Place Specifications










Place Specification Editor

You use the Place Specification editor to model Place specifications. When working with Place specifications, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Place Specification Properties Tab


	
Place Specification Editor Place Configurations Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Place Specification Properties Tab

Use the Properties tab to define the entity type for the Place specification. In the Entity Type field, select one of the following values:


	Field	Use
	Site	Select to define a place that does not have a single, precise location. See "About the Site Place Type" for more information.
	Address	Select to define a place using the standard address format to meet your business requirements and national postal standards. See "About the Address Place Type" for more information.
	Address Range	Select to define a place using groups of related addresses. See "About the Address Range Place Type" for more information.
	Location	Select to define a place based on geographic references. See "About the Location Place Type" for more information.







Related Topics

Defining Place Types

Place Specification Editor










Place Specification Editor Place Configurations Tab

Use the Place Configurations tab to relate Place specifications defined as Site (on the Place Specification editor Properties tab) to Place configurations.




	
Note:

You use this tab for geographic sites only. The buttons on this tab are disabled for all other types of Place specifications.








	Field	Use
	Place Configurations	Displays the name of the Place Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Place Configuration specification is built.
	Select	Click to select an existing Place Configuration specification.
	Open	Click to open the selected configuration in the Place Configuration Specification editor.
	Remove	Click to remove a Place Configuration specification.
	Add	Click to add a new Place Configuration specification.
















Working with Place Configuration Specifications

Place Configuration specifications capture the details about the resources used by the Place specification. Place configurations only apply to Place entities defined as sites.

You can add existing Place Configuration specifications to a Place specification or you can create new Place Configuration specifications in the process of adding it to a Place specification. The place configuration and the Place specification do not have to be in the same project.

When working with Place Configuration specifications, see "Place Configuration Specification Editor" for more information.









Place Configuration Specification Editor

Use the Place Configuration Specification editor to model Place Configuration specifications. When working with Place Configuration specifications, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Place Configuration Specification Editor Place Specs Tab












Place Configuration Specification Editor Place Specs Tab

Use the Place Specs tab to select, add, and remove the Place specifications that use the Place Configuration specifications. The Place Specs tab identifies the Place specifications that use the Place Configuration specification. You must use this tab to relate a Place specification to its Place Configuration specification only when the Place specification and Place Configuration specification need to be in separate cartridges, and the Place specification can exist without the Place Configuration specification. If both the Place specification and Place Configuration specification are in the same cartridge, make the association on the Place specification.


	Field	Use
	Place Specification	Displays the name of the Place specification.
	Cartridge	Displays the name of the cartridge project into which the Place specification is built.
	Select	Click to select an existing Place specification.
	Open	Click to open the selected specification in the Place Specification editor.
	Remove	Click to remove a Place specification.
	Add	Click to add a new Place specification.







Related Topics

Place Specification Editor












Working with Party Specifications

You create Party specifications to model the people or organizations that interact with your inventory. Party specifications answer the business question of who is involved in your inventory.

Parties often play roles in your inventory. You can assign roles that are defined by Role specifications. You can assign one or more roles to an instance of a Party specification.

When working with Party specifications, see "Party Specification Editor" for reference information about the tabs you use to define a Party specification.


Related Topics

Creating New Specifications









Party Specification Editor

Use the Party Specification editor to model Party specifications. When working with Party specifications, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Role Specifications

You create Role specifications to define the functions played by entities in an inventory. For example, an instance of a Party specification called Individual could have the role of subscriber or employee.

When working with Role specifications, see the following topics:

	
About Role Specifications


	
Configuring a Role Specification


	
Role Specification Editor












About Role Specifications

An entity can play multiple roles simultaneously and its roles can change over time. For example, an instance of a Party specification called Organization could be both a supplier and a customer, either at the same time or at different times.

When a role specification is created you must select one or more role-enabled entity types to which the role applies. When an instance of the selected entity type is created in UIM, the role may be optionally applied to the entity. For example the role of "MPLS" may be applied to a Logical Device and a Pipe, indicating that they both support MPLS technology.

An entity's role might be relevant to its involvements with other entities. See "Working with Involvement Specifications" for more information about involvements.

Not all entity types can be assigned roles. In UIM, role-enabled entities have Role areas on their Summary pages.

When you create a Role specification, you can optionally select a role type.

The following are the role types:

	
Technology: This role defines the technology that an entity operates under or supports.


	
Function: This role defines the function that an entity plays.


	
Topology: This role defines the role the topology plays in the network topology, such as hub or spoke.





Related Topics

Configuring a Role Specification

Role Specification Editor










Configuring a Role Specification

When configuring Role specifications, you specify role types and valid entity types.

To configure Role specifications:

	
Create a new Role specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Role Specification editor, click the Properties tab.


	
In the Role Type field, select TECHNOLOGY, FUNCTION, or TOPOLOGY.

See "About Role Specifications" for more information.


	
In the Available Entity Types list, select the entity type or types that you want to be able to have this role.


	
Click the right arrow button to move the entity types to the Selected Entity Types list.

If necessary, you can use the left arrow button to move entity types back to the Available Entity Types list.


	
From the File menu, select Save.





Related Topics

Role Specification Editor










Role Specification Editor

Use the Role Specification editor to define the functions played by entities in an inventory.

When working with the Role Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Role Specification Editor Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Role Specification Editor Properties Tab

Use the Properties tab to select a role type for the role specification that you create.


	Field	Use
	Role Type	Select a role type when you create a role specification. Select one of the following:
	
Technology: Defines the technology that an entity operates under or supports.


	
Function: Defines the function that an entity plays.


	
Topology: Defines the role the topology plays in the network topology, such as hub or spoke.





	Available Entity Types	Displays the entity types that are available for selection.
	Selected Entity Types	Displays the entity types that have been selected.







Related Topics

Configuring a Role Specification

Role Specification Editor













Working with Equipment and Logical Device Specifications

You can model equipment in Oracle Communications Design Studio using several different methods. You can inventory all of your physical hardware resources down to the port level for asset-tracking purposes and you can model your network elements as logical devices for activation purposes.

When working with Equipment and Logical Device specifications, see the following topics:

	
Working with Logical Device Specifications


	
Working with Logical Device Configuration Specifications


	
Working with Device Interface Specifications


	
Working with Logical Device Account Specifications


	
Working with Logical Device Account Configuration Specifications


	
Working with Physical Device Specifications


	
Working with Equipment Specifications


	
Working with Equipment Holder Specifications


	
Working with Physical Port Specifications


	
Working with Physical Connector Specifications












Working with Logical Device Specifications

A logical device represents a functional view of a set of resources. The logical device itself is not physical, but it can be supported by one or more physical resources that support it and act together logically to perform one or more functions.

In the telecommunications industry, logical devices are often called network elements, but the terms are not interchangeable. In Unified Inventory Management (UIM), a logical device can also be a non-intelligent device that does not qualify as a network element. Logical devices that are network elements are addressable and manageable and can be managed through an element management system (EMS). See UIM Concepts for information on relating Logical Device specifications to Device Interface specifications.

Logical devices can be supported by one hardware item like a desktop router or by many pieces of hardware such as:

	
Central office switches


	
Digital cross-connect systems (DCS)


	
Digital subscriber line access multiplexers (DSLAM)


	
Main distribution frames (MDF)




A logical device can support other logical devices to create a hierarchy. You create Logical Device specifications in the same manner as other types of specifications. See "Creating New Specifications" for more information.

When working with Logical Device specifications, see "Logical Device Specification Editor" for reference information about the tabs you use to define a Logical Device specification.









Logical Device Specification Editor

Use the Logical Device Specification editor to model logical devices. When working with the Logical Device Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Logical Device Specification Editor Properties Tab


	
Logical Device Specification Editor Logical Device Configurations Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Logical Device Specification Editor Properties Tab

Use the Properties tab to enter information about the logical device.


	Field	Use
	Vendor	Enter the vendor name of the logical device.
	Model Number	Enter the model number of the logical device.
	Part Number	Enter the part number of the logical device.







Related Topics

Logical Device Specification Editor










Logical Device Specification Editor Logical Device Configurations Tab

Use the Logical Device Configurations tab to enter information about the Logical Device Configuration specification.


	Field	Use
	Logical Device Configuration	Displays the name of the Logical Device Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Logical Device Configuration specification is built.
	Select	Click to select an existing Logical Device Configuration specification.
	Open	Click to open the selected configuration in the Logical Device Configuration Specification editor.
	Remove	Click to remove the Logical Device Configuration specification.
	Add	Click to add a new Logical Device Configuration specification.







Related Topics

Logical Device Specification Editor












Working with Logical Device Configuration Specifications

The Logical Device Configuration specification captures the details about the resources used by the logical device. A Logical Device Configuration specification can include configuration items. Configuration items can have characteristics and can also consume a resource.

You can associate only the following specifications to the Logical Device Configuration specification:

	
Custom network address


	
Custom object


	
Device interface




When working with Logical Device Configuration specifications, see the following topics:

	
Adding Existing Configurations to a Logical Device Specification


	
Adding New Configurations to a Logical Device Specification


	
Logical Device Configuration Specification Editor












Adding Existing Configurations to a Logical Device Specification

You can add existing configurations to a Logical Device specification. The Logical Device configuration and the Logical Device specification do not have to be in the same project.

To add an existing Logical Device Configuration to a Logical Device specification:

	
Open a Logical Device Specification entity in the Logical Device Specification editor.

See "Creating New Specifications" for more information.


	
Click the Logical Device Configurations tab.


	
Click Select.

The Add Entities dialog box appears.


	
Select the configuration and click OK.

The logical device configuration you selected appears in the Logical Device Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding New Configurations to a Logical Device Specification

Adding Configuration Items

Logical Device Configuration Specification Editor










Adding New Configurations to a Logical Device Specification

You can add new configurations to a Logical Device specification. The logical device configuration and the Logical Device specification do not have to be in the same project.

To add new logical device configurations to a Logical Device specification:

	
Open a Logical Device Specification entity in the Logical Device Specification editor.

See "Creating New Specifications" for more information.


	
Click the Logical Device Configurations tab.


	
Click Add.

The Logical Device Configuration Specification Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
In the Name field, enter a name for the new specification.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

The logical device configuration you added appears in the Logical Device Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding Existing Configurations to a Logical Device Specification

Adding Configuration Items

Logical Device Configuration Specification Editor










Logical Device Configuration Specification Editor

Use the Logical Device Configuration Specification editor to model Logical Device configurations.

When working with the Logical Device Configuration Specification editor, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Logical Device Configuration Specification Editor Logical Device Specs Tab












Logical Device Configuration Specification Editor Logical Device Specs Tab

Use the Logical Device Specs tab to select, add, and remove the Logical Device specifications that use the Logical Device Configuration specifications. This tab identifies the Logical Device specifications that use the selected Logical Device Configuration specification. You must use this tab to relate a Logical Device specification to its Logical Device Configuration specification only when the Logical Device specification and Logical Device Configuration specification need to be in separate cartridges and the Logical Device specification can exist without the Logical Device Configuration specification. If both the Logical Device specification and Logical Device Configuration specification are in the same cartridge, make the association on the Logical Device specification.


	Field	Use
	Logical Device Configuration	Displays the name of the Logical Device specification.
	Cartridge	Displays the name of the cartridge project into which the Logical Device specification is built.
	Select	Click to select an existing Logical Device specification.
	Open	Click to open the selected specification in the Logical Device Specification editor.
	Remove	Click to remove a Logical Device specification.
	Add	Click to add a new Logical Device specification.







Related Topics

Adding Existing Configurations to a Logical Device Specification

Adding Configuration Items

Logical Device Configuration Specification Editor












Working with Device Interface Specifications

Logical devices often provide device interfaces. A device interface represents an access point into the device. These device interfaces may be for connectivity, power, timing, or any other means of interaction with the device.


You use Logical Device and Device Interface specifications to define the various types of logical devices and interfaces in your inventory.

You create Device Interface specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

You relate Logical Device specifications to Device Interface specifications on the Related Specifications tab in the Logical Device Specification editor.

When working with Device Interface specifications, see the following topics:

	
About Rate Codes


	
Device Interface Specification Editor












About Rate Codes

A rate code is an industry-recognized form of identification for transmission signals, or the speed at with data flows from one point to another, through some type of logical or physical medium. For example, a DS1 rate code refers to a transmission rate of 1.544 megabits per second (Mb/s) for T-Carrier technology.

You can associate a device interface specification with a rate code; the rate code will be applied to all new device interfaces created from the specification. The rate code on a device interface determines the technology and transmission rate the interface can support to terminate connectivity.

There are two types of validations associated with rate codes. First, Design Studio creates a problem marker if you attempt to associate a device interface specification with an incompatible rate code when parent-child relationships between the device interface specifications are defined.

The bit rate defined for a rate code associated with a child-level device interface cannot exceed a bit rate of the rate code defined at the parent level. For example, you cannot define a parent entity with a DS1 rate code (1.544 Mb/s) and define the child entity with a DS3 rate code (44.736 Mb/s) because the rate code associated with the child device interface has a bit rate that is higher than the bit rate for the rate code associated with the parent.

Additionally, Design Studio ensures that the sum of the bit rates defined for all child entities does not exceed the bit rate of the parent. For example, you cannot define a parent entity with a DS3 rate code (44.736 Mb/s) and define more than 28 child entities with DS1 rate codes (1.544 Mb/s), as the product of 29 and 1.544 exceeds 44.736, the M/bs defined for DS3.

Second, if you change the rate code associated with a device interface specification in a previously deployed cartridge in which device interface instances have been created in UIM, UIM generates a deployment error upon subsequent deployments if:

	
You changed the rate code from an existing value to a different value. For example, you cannot change the rate code value from DS3 to DS1.


	
You deleted an existing value and left the Rate Code field blank. For example, you cannot delete the DS3 value and leave the Rate Code field blank.




The error message appears in the Environment perspective Console view.


Related Topics

Device Interface Specification Editor Properties Tab










Device Interface Specification Editor

Use the Device Interface Specification editor to model Device Interface specifications.

When working with the Device Interface Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Device Interface Specification Editor Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Device Interface Specification Editor Properties Tab

Use the Device Interface Specification editor Properties tab to associate a rate code to the device interface.




	
Note:

You must import the ora_uim_basetechnologies base cartridge and add the ora_uim_basetechnologies base cartridge as a dependency to your cartridge project to have access to the delivered set of rate codes.








	Field	Use
	Display Name	Enter the name that appears in Design Studio editors and in UIM.
Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


	Rate Code	Displays the rate code of the device interface. Click Select to access a set of available rate codes.
If this field is populated, you can click the Rate Code link to review the attributes of the rate code.


	Clear	Click to remove the selection in the Rate Code field.
	Select	Click to select a rate code to associate with the device interface specification. Rate codes are available only if you have imported the ora_uim_basetechnologies base cartridge and added the ora_uim_basetechnologies base cartridge as a dependency to the project in which the device interface specification is saved.







Related Topics

About Rate Codes












Working with Logical Device Account Specifications

Logical device accounts are a special type of network address that are hosted or managed by a logical device. For a service provider, a logical device account could be a management account, such as a login name, for configuring a logical device. You use Logical Device Account specifications to define these accounts in your inventory. The information captured in a Logical Device Account specification depends on the account that you are modeling. For example, you might need to add characteristics for subscriber information such as a login name, mailbox, or accounting record.

You create Logical Device Account specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Logical Device Account Specification Editor" for reference information about the tabs you use to define a Logical Device Account specification.









Logical Device Account Specification Editor

Use the Logical Device Account Specification editor to model special types of network address that are hosted or managed by a logical device.

When working with the Logical Device Account Specification, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Logical Device Account Configuration Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Specification Editor Logical Device Account Configuration Tab

Use the Logical Device Account Configurations tab to enter information about the Logical Device Account Configuration specification.


	Field	Use
	Logical Device Account Configuration	Displays the name of the Logical Device Account Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Logical Device Configuration specification is built.
	Select	Click to select an existing Logical Device Account Configuration specification.
	Open	Click to open the selected configuration in the Logical Device Account Configuration Specification editor.
	Remove	Click to remove the Logical Device Account Configuration specification.
	Add	Click to add a new Logical Device Account Configuration specification.







Related Topics

Logical Device Account Specification Editor












Working with Logical Device Account Configuration Specifications

The Logical Device Account Configuration specification captures the details about the resources used by the logical device account. A Logical Device Account Configuration specification can include configuration items. Configuration items can have characteristics and can also consume resources.

You can assign the following types of specifications as specification options to the Logical Device Account Configuration specification:

	
Custom network address


	
Custom object


	
Telephone number




You can include all reference-enabled specification types as references in logical device account configuration items.

When working with Logical Device Account Configuration specifications, see the following topics:

	
Adding Existing Configurations to a Logical Device Account Specification


	
Adding New Configurations to a Logical Device Account Specification


	
Logical Device Account Configuration Specification Editor












Adding Existing Configurations to a Logical Device Account Specification

You can add existing configurations to a Logical Device Account specification. The Logical Device Account configuration and the Logical Device Account specification do not have to be in the same project.

To add an existing Logical Device Account Configuration to a Logical Device Account specification:

	
Open a Logical Device Account Specification entity in the Logical Device Account Specification editor.

See "Creating New Specifications" for more information.


	
Click the Logical Device Account Configurations tab.


	
Click Select.

The Add Entities dialog box appears.


	
Select the configuration and click OK.

The logical device account configuration you selected appears in the Logical Device Account Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding New Configurations to a Logical Device Account Specification

Adding Configuration Items

Logical Device Account Configuration Specification Editor










Adding New Configurations to a Logical Device Account Specification

You can add new configurations to a Logical Device Account specification. The logical device account configuration and the Logical Device Account specification do not have to be in the same project.

To add new logical device account configurations to a Logical Device Account specification:

	
Open a Logical Device Account Specification entity in the Logical Device Specification editor.

See "Creating New Specifications" for more information.


	
Click the Logical Device Account Configurations tab.


	
Click Add.

The Logical Device Account Configuration Specification Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
In the Name field, enter a name for the new specification.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

The logical device account configuration you added appears in the Logical Device Account Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding Existing Configurations to a Logical Device Account Specification

Adding Configuration Items

Logical Device Account Configuration Specification Editor










Logical Device Account Configuration Specification Editor

Use the Logical Device Account Configuration Specification editor to model Logical Device Account configurations.

When working with the Logical Device Account Configuration Specification editor, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Logical Device Account Configuration Specification Editor Logical Device Account Specs Tab












Logical Device Account Configuration Specification Editor Logical Device Account Specs Tab

Use the Logical Device Account Specs tab to select, add, and remove the Logical Device Account specifications that use the Logical Device Account Configuration specifications. This tab identifies the Logical Device Account specifications that use the selected Logical Device Account Configuration specification. You must use this tab to relate a Logical Device Account specification to its Logical Device Account Configuration specification only when the Logical Device Account specification and Logical Device Account Configuration specification need to be in separate cartridges and the Logical Device Account specification can exist without the Logical Device Account Configuration specification. If both the Logical Device Account specification and Logical Device Account Configuration specification are in the same cartridge, make the association on the Logical Device Account specification.


	Field	Use
	Logical Device Account Configuration	Displays the name of the Logical Device Account specification.
	Cartridge	Displays the name of the cartridge project into which the Logical Device Account specification is built.
	Select	Click to select an existing Logical Device Account specification.
	Open	Click to open the selected specification in the Logical Device Account Specification editor.
	Remove	Click to remove a Logical Device Account specification.
	Add	Click to add a new Logical Device Account specification.







Related Topics

Adding Existing Configurations to a Logical Device Specification

Adding Configuration Items

Logical Device Configuration Specification Editor












Working with Physical Device Specifications

A physical device is a collection of hardware resources that have a common function in the network. Physical devices are the counterpart of logical devices. They are aggregations of hardware, which can include other physical devices, equipment, physical ports, and physical connectors. In UIM, you can map a physical device to its corresponding logical device. You can also map the ports and connectors in a physical device to the device interfaces in a logical device.

You create Physical Device specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

When working with physical devices, see the following topics:

	
About Physical Device Specification Ports and Connectors


	
Physical Device Specification Editor












About Physical Device Specification Ports and Connectors

In Design Studio, you can include Physical Port and Physical Connector specifications in the Related Specifications tab of a Physical Device specification. When you create the physical device in UIM, instances of the ports and connectors are created automatically. The minimum quantity that you set governs the number of ports and connectors that are automatically added. The maximum quantity limits the number of ports and connectors that can be added. The minimum and maximum values are typically the same for ports or connectors of a physical device. See "Defining Specification Relationships" for instructions about adding related specifications.




	
Note:

When you include a physical port or physical connector in a Physical Device specification, you should set the minimum and maximum quantities to the same value. Ports and connectors are fixed parts of a physical device.








Related Topics

Working with Logical Device Specifications

Working with Device Interface Specifications

Physical Device Specification Editor










Physical Device Specification Editor

Use the Physical Device Specification editor to model collections of hardware resources that have a common function in the network.

When working with the Physical Device Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Equipment Specifications

Equipment specifications represent physical items of hardware. Modules and cards that occupy equipment holders are examples of equipment. But Equipment specifications can also model more complex devices such as shelves or racks. You can also use Equipment specifications for self-contained, independent devices such as routers or desk-top modules. You define the composition of the Equipment specification in the following ways:

	
In the Visualization tab of the Equipment Specification editor.


	
By relating physical ports, connectors, or equipment holder specifications to the Equipment specification.




When working with Equipment specifications, see the following topics:

	
About Equipment Specification Ports, Connectors, and Equipment Holders


	
Defining Equipment Specification Properties


	
Configuring Equipment Specifications in the Visualization Tab


	
Defining Visualization Tab Item Elements


	
Equipment Specification Editor












About Equipment Specification Ports, Connectors, and Equipment Holders

You can configure an Equipment specification so that instances of the specification automatically include physical ports, physical connectors, and equipment holders. If you include Physical Port, Physical Connector, or Equipment Holder specifications in the Related Specifications tab of an Equipment specification, instances of the ports, connectors, or holders are created automatically when you create instances of the equipment.

See "Defining Specification Relationships" for instructions about adding related specifications.




	
Note:

When you include a physical port or physical connector in an Equipment specification, you should set the minimum and maximum quantities to the same value. Ports and connectors are fixed parts of equipment.
















Defining Equipment Specification Properties

When you define Equipment specifications, you can specify its properties, including its equipment category.

To define Equipment specification properties:

	
Create a new Equipment specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Equipment Specification editor, click the Properties tab.


	
(Optional) In Equipment Category, select CARD, SHELF, or RACK.

The Visualization tab is empty for Equipment specifications that have not been assigned to a category. For example, if you are configuring a chassis, you can define its arrangement of slots and cards.


	
(For the CARD category only) In Required Holders, select the number of holders required for instances of this specification.

This number defines the number of equipment holders (slots) the card occupies. For example, if you set the value to 2, the card requires two contiguous slots. This requirement is enforced in both Design Studio and UIM.


	
(Optional) In the Vendor, Model Number, and Part Number fields, enter appropriate information.


	
From the File menu, select Save.





Related Topics

Configuring Equipment Specifications in the Visualization Tab

About Equipment Specification Ports, Connectors, and Equipment Holders

Equipment Specification Editor










Configuring Equipment Specifications in the Visualization Tab

You use the Equipment Specification editor Visualization tab to configure an Equipment specification that has been assigned to the card, shelf, or rack category. If you configure a rack to have shelves and cards, the shelves and cards are created automatically when you create an instance of the rack specification.

When configuring an Equipment specification on the Visualization tab, see the following topics:

	
Configuring a Card


	
Configuring a Shelf


	
Configuring a Rack












Configuring a Card

A card is an equipment category to which you assign an Equipment specification. When you configure a card specification, you assign a template that determines the card's orientation. You can choose a vertical or a horizontal orientation.




	
Note:

You must configure a Card specification in the Visualization tab before it can be added to shelves.







To configure a card specification:

	
Create a new Equipment specification and assign it to the card category, or navigate to the editor of an existing card specification.

See "Creating New Specifications" for more information.


	
In the Equipment Specification editor, click the Visualization tab.

The Visualization tab displays the Default Cards subtab in the Palettes tab.


	
From the Default Cards area, drag a card template to the canvas.


	
Select a card in the canvas, then enter information about it in the information area below the Palettes area.

You may need to make the Visualization tab larger to see the information area. See "Defining Visualization Tab Item Elements" for more information.


	
From the File menu, select Save.





Related Topics

Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor










Configuring a Shelf

A shelf is an equipment category to which you assign an Equipment specification. You add cards or empty slots to the shelf. When you add a card, you specify the slot that it should use. If the card requires more than one slot, the shelf must have the appropriate number of contiguous slots available. For example, if the card requires two slots, the shelf must have at least two contiguous slots available.

You can include card carriers in a shelf. Card carriers are subdivisions of spaces in the shelf that enable you to add additional cards. Card carriers are not physical items, but rather a way to divide the shelf in the visualization to accommodate varying numbers of cards. When you add a card carrier, you specify the number of slots in the slotCount element. When you configure a shelf specification, you define the shelf arrangement by choosing a template or an existing shelf.

To configure a shelf:

	
Create a new Equipment specification and assign it to the shelf category, or navigate to the editor of an existing shelf specification.

See "Creating New Specifications" for more information.


	
In the Equipment Specification editor, click the Visualization tab.

The Visualization tab displays four subtabs in the Palettes tab.


	
Do one of the following:

	
From the Default Shelves area, drag a shelf template to the canvas.


	
To start from an existing shelf, click the Shelves tab and drag an already configured shelf to the canvas. The shelf includes any slots or cards defined in its Equipment specification.





	
(Optional) Drag the card carrier template from the Default Shelves area to the desired location in the shelf template.

The card carrier template is the template that is not surrounded by a heavy black line.


	
(Optional) Click the Empty Slots tab and drag an item to the desired location in the shelf template or card carrier within the shelf template.


	
(Optional) Add cards to the shelf configuration.

To add a card:

	
Click the Cards tab and drag an item to the desired location in the shelf template or card carrier within the shelf template.

The Select Slot Specification dialog box appears.


	
Select a slot specification and click OK.

The card appears in the visualization. If the card requires more than one slot, the card graphic is shown in one slot. The other required slots are shaded and marked as occupied.





	
Enter information about items in the shelf in the information area below the Palettes area.

You may need to make the Visualization tab larger to see the information area. See "Defining Visualization Tab Item Elements" for more information.


	
(Optional) Right-click a slot or card in the canvas area and select Remove Item to remove slots or cards.


	
From the File menu, select Save.





Related Topics

Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor










Configuring a Rack

A rack is an equipment category to which you assign an Equipment specification. A rack includes one or more shelves. You can include any of the shelves that have already been defined in the workspace.

To configure a rack:

	
Create a new Equipment specification and assign it to the Rack category, or navigate to the editor of an existing rack specification.

See "Creating New Specifications" for more information.


	
In the Equipment Specification editor, click the Visualization tab.

The Visualization tab displays the Shelves subtab in the Palettes tab.


	
From the Shelves tab, drag one of the available shelves to the canvas.


	
(Optional) Add additional shelves, as needed.


	
Enter information about items in the shelves in the information area below the Palettes area.

You may need to make the Visualization tab larger to see the information area. See "Defining Visualization Tab Item Elements" for more information.


	
From the File menu, select Save.





Related Topics

Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor











Defining Visualization Tab Item Elements

You can define information about shelves, empty slots, cards, and card carriers in the Equipment Specification editor Visualization tab. The information is in the form of name-value element pairs.

To enter elements for items in the Visualization tab:

	
Open an Equipment specification in the Equipment Specification editor.


	
Click the Visualization tab.


	
In the canvas, click a card, card carrier, or empty slot to select it.

To select a shelf, click its perimeter. The selected item is highlighted in the canvas and information about it appears in the information area.


	
Enter or select values for the relevant elements.

The elements you can specify depend on the item selected in the canvas. See the following topics for information about the slotNumber and nativeEMSName elements:

	
Numbering Slots Automatically


	
Numbering Slots Individually


	
Assigning Native EMS Names Automatically to Slots


	
Assigning Native EMS Names Individually to Slots





	
From the File menu, select Save.





Related Topics

Working with Equipment Specifications

Equipment Specification Editor









Numbering Slots Automatically

You can automatically number all occupied slots. When you automatically number slots, Design Studio assigns integers beginning with 1, overwriting existing slot numbers.

To number slots automatically:

	
Open an Equipment specification in the Equipment Specification editor.


	
Click the Visualization tab.


	
In the canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the information area.


	
In the canvas, click the Auto Numbering icon in the toolbar.

Design Studio numbers all the occupied slots, beginning with 1.


	
Click OK in the confirmation dialog box.


	
From the File menu, select Save.





Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor










Numbering Slots Individually

You can specify slot numbers individually and assign any alphanumeric value.

To number slots individually:

	
Open an Equipment specification in the Equipment Specification editor.


	
Click the Visualization tab.


	
In the canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the information area.


	
In the information area, enter a value for the selected slot in the slotNumber field.


	
From the File menu, select Save.





Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor










Assigning Native EMS Names Individually to Slots

You can assign alphanumeric names to slots by using the nativeEMSName data element. You can use this element as a network-facing slot name that is independent of the slot number.

To assign names individually:

	
Open an Equipment specification in the Equipment Specification editor.


	
Click the Visualization tab.


	
In the canvas are, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the information area.


	
In the information area, enter a value for the selected slot in the nativeEMSName field.


	
From the File menu, select Save.





Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor










Assigning Native EMS Names Automatically to Slots

You can assign alphanumeric names to slots by using the nativeEMSName element. You can use this element as a network-facing slot name that is independent of the slot number.

You can assign names automatically to all occupied slots, beginning with a value that you select. If the starting value ends with an alphabetic character, the names increment by appending an integer to the value, beginning with 0. If the value ends with an integer, the names increment starting at that number.

To assign names automatically:

	
Open an Equipment specification in the Equipment Specification editor.


	
Click the Visualization tab.


	
In the canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the information area.


	
In the canvas, click the Native EMS Naming button in the toolbar.

The Enter NativeEMSName dialog box appears.


	
Enter a starting value and click OK.


	
From the File menu, select Save.





Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor











Equipment Specification Editor

Use the Equipment Specification editor to model physical items of hardware.

When working with the Equipment Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Equipment Specification Editor Properties Tab


	
Equipment Specification Editor Visualization Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Equipment Specification Editor Properties Tab

Use the Properties tab to define an Equipment category and enter information about the equipment.


	Field	Use
	Equipment Category	Select a category for the equipment. You can select CARD, SHELF, or RACK.
	Required Holders	Select the number of holders required for instances of this specification. This field is applicable to the CARD category only.
	Vendor	Lets you enter the name of the vendor of the equipment.
	Model Number	Enter the model number of the equipment.
	Part Number	Enter the part number of the equipment.







Related Topics

Defining Equipment Specification Properties

Equipment Specification Editor










Equipment Specification Editor Visualization Tab

Use the Visualization tab to configure an Equipment specification that has been assigned to a Card, Shelf, or Rack category.


	Field	Use
	Palettes	Use the templates on this tab to define the basic structure of the equipment. The Palettes tab contains subtabs that depend on whether the Equipment specification is defined as a card, a rack, or a shelf.
	Hierarchy	View Equipment configuration in a tree view. The tree view reflects the configuration in the canvas, so it updates as you add new items to the visualization. When you select an item in the canvas, the corresponding item in the tree view is highlighted; when you select an item in the tree view, the corresponding item in the canvas is highlighted.
	Canvas	Configure the equipment by dragging items from the Palettes tab.
	Default Cards	Displays the default selection of card templates.
This subtab appears if the Equipment specification is defined as a card.


	Default Shelves	Displays the default selection of shelf templates.
This subtab appears if the Equipment specification is defined as a shelf.


	Shelves	Displays a list of the shelves (Equipment specifications in the Shelf category) that have been defined in the workspace.
This subtab appears if the Equipment specification is defined as a shelf.


	Cards	Displays a list of the cards (Equipment specifications in the Card category) that have been defined in the workspace.
This subtab appears if the Equipment specification is defined as a shelf.


	Empty Slots	Displays a list of the slots (Equipment Holder specifications) that have been defined in the workspace.
This subtab appears if the Equipment specification is defined as a shelf.


	Shelves	Displays a list of the shelves (Equipment specifications in the Shelf category) that have been defined in the workspace.
This subtab appears if the Equipment specification is defined as a rack.









Related Topics

Configuring Equipment Specifications in the Visualization Tab

Defining Visualization Tab Item Elements

Equipment Specification Editor












Working with Equipment Holder Specifications

An Equipment Holder specification defines a slot into which cards can be installed. Equipment holders are provided by equipment and can in turn contain other equipment. For example, a LAN card can be installed in a slot that is installed in a shelf. An equipment holder cannot exist on its own. It must always be provided by equipment.

You create Equipment Holder specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

You can configure an Equipment specification so that instances of the specification automatically include physical ports, physical connectors, and equipment holders. See "About Equipment Specification Ports, Connectors, and Equipment Holders" for more information.

You can configure Equipment Holder specifications so that slots based on those specifications can contain only cards based on particular specifications. If you establish a parent-to-child relationship between an Equipment Holder specification and one or more Card specifications, UIM limits which cards a slot can contain. See "Defining Specification Relationships" for information about establishing these relationships.

See "Equipment Holder Specification Editor" for reference information about the tabs you use to define an Equipment Holder specification.









Equipment Holder Specification Editor

Use the Equipment Holder Specification editor to model Equipment Holder specifications.

When working with the Equipment Holder Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Physical Port Specifications

A Physical Port specification defines a point of entry for communication. A physical port is where communication begins or ends on a physical device or unit of equipment. Unlike a physical connector, a physical port performs basic processing, such as reading transmission data. A physical port cannot exist on its own. It must be provided by either a physical device or an equipment.

You can configure a Physical Device specification or an Equipment specification to create physical port instances automatically when you create a physical device or equipment instance. See and "About Physical Device Specification Ports and Connectors" and "About Equipment Specification Ports, Connectors, and Equipment Holders" for more information.

You create Physical Port specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Physical Port Specification Editor" for reference information about the tabs you use to define a Physical Port specification.









Physical Port Specification Editor

Use the Physical Port Specification editor to model points of entry for communication.

When working with the Physical Port Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Physical Connector Specifications

You use Physical Connector specifications to model hardware used to physically link or connect hardware units for the transmission of signals or power. Unlike physical ports, physical connectors have no built-in intelligence—they simply conduct a signal.

You can configure a Physical Device specification or an Equipment specification to create physical connector instances automatically when you create a physical device or equipment instance. A physical connector cannot exist on its own. It must be provided by either a physical device or equipment. See "About Physical Device Specification Ports and Connectors"and "About Equipment Specification Ports, Connectors, and Equipment Holders"for more information.

You create Physical Connector specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Physical Connector Specification Editor" for reference information about the tabs you use to define a Physical Connector specification.









Physical Connector Specification Editor

Use the Physical Connector Specification editor to model hardware used to physically link or connect hardware units for the transmission of signals or power.

When working with the Physical Connector Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab















Working with Network, Pipe, Capacity, and Signal Structure Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Network specifications to describe a network as a whole. Capacity refers to the amount and type of resource that entities require or provide. You define the nature of the capacity, how it is measured, and how it is used. Signal structures support connectivity by defining the capacity and channel hierarchy of pipes. Pipes are the fundamental entities for modeling connectivity in UIM. You can use pipes to represent both physical connectivity and logical connectivity.

When working with Network, Pipe, Capacity, and Signal Structure specifications, see the following topics:

	
Working with Network Specifications


	
Working with Network Configuration Specifications


	
Working with Network Node Specifications


	
Working with Network Edge Specifications


	
Working with Capacity Types


	
Working with Capacity Provided Specifications


	
Working with Capacity Required Specifications


	
Working with Pipe Signal Termination Point Specifications


	
Working with Pipe Termination Point Specifications


	
Working with Pipe Specifications


	
Working with Pipe Configuration Specifications


	
Working with Connectivity Signal Termination Point Specifications


	
Working with Measurement Types


	
Working with Units of Measure












Working with Network Specifications

You use a Network specification to describe a network as a whole. There are many different types of networks that you can model with Network specifications:

	
ATM network


	
Ethernet VLAN


	
Frame Relay network




You can add characteristics to capture information that is specific to the type of network described by the specification.

In UIM, you create an instance of a network from a network specification, then you build a topological view of the network, its nodes, and its edges on the UIM Network Visualization tab. You build the network by adding nodes and edges and then associating resources to them.

You create Network specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Network Specification Editor" for reference information about the tabs you use to define a Network specification.









Network Specification Editor

Use the Network Specification editor to model Network specifications.

When working with the Network Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Network Specifications Editor Network Configurations Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Network Specifications Editor Network Configurations Tab

Use the Network Configurations tab to select, add, and remove a network configuration.


	Field	Use
	Network Configuration	Displays the name of the Network Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Network Configuration specification is built.
	Select	Click to select an existing Network Configuration.
	Open	Click to open the selected configuration in the Network Configuration Specification editor.
	Remove	Click to remove a Network Configuration.
	Add	Click to add a new Network Configuration. See "Adding Existing Configurations to a Network Specification" for more information.







Related Topics

Network Specification Editor

Working with Network Specifications












Working with Network Configuration Specifications

Network Configuration specifications capture the details about the resources used by the network. As these details can change frequently, Network Configurations provide a versioning capability that enables the management of changes to the facts about the network over time. As the facts about a network change over time, new versions of the Network Configuration can be created.

You can associate Custom Network Address, Custom Object, and Logical Device specifications to the Network Configuration specification.

When working with Network Configuration specifications, see the following topics:

	
Adding Existing Configurations to a Network Specification


	
Adding New Configurations to a Network Specification


	
Network Configuration Specification Editor












Adding Existing Configurations to a Network Specification

You can add existing network configurations to a Network specification. The network configuration and the Network specification do not have to be in the same project.

To add an existing network configuration to a Network specification:

	
Open a Network Specification entity in the Network Specification editor.

See "Creating New Specifications" for information about creating new Network specifications.


	
Click the Network Configurations tab.


	
Click Select.

The Add Entity dialog box appears.


	
Select the network configuration and click OK.

The Network Configuration specification is added to the Network specification's Network Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding New Configurations to a Network Specification

Adding Configuration Items

Network Configuration Specification Editor










Adding New Configurations to a Network Specification

You can add new network configurations to a Network specification. The network configuration and the Network specification do not have to be in the same project.

To add a new network configuration to a Network specification:

	
Open a Network Specification entity in the Network Specification editor.

See "Creating New Specifications" for information about creating new Network specifications.


	
Click the Network Configurations tab.


	
Click Add.

The Network Configuration Specification Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
In the Name field, enter a name for the new specification.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Oracle Communications Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

The Network Configuration specification is added to the Network specification's Network Configurations tab.


	
From the File menu, select Save.





Related Topics

Adding Existing Configurations to a Network Specification

Adding Configuration Items

Network Configuration Specification Editor










Network Configuration Specification Editor

Use the Network Configuration Specification editor to capture the details about the resources used by the network.

When working with the Network Configuration Specification editor, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Configuration Specification Editor Specification Options Subtab


	
Network Configuration Specification Editor Network Specs Tab












Network Configuration Specification Editor Network Specs Tab

Use the Network Specs tab to select, add, and remove the Network specifications that use the Network Configuration specifications. This tab identifies the Network specifications that use the selected Network Configuration specification. You must use this tab to relate a Network specification to its Network Configuration specification only when the Network specification and Network Configuration specification need to be in separate cartridges, and the Network specification can exist without the Network Configuration specification. If both the Network specification and Network Configuration specification are in the same cartridge, make the association on the Network specification.


	Field	Use
	Network Specification	Displays the name of the Network specification.
	Cartridge	Displays the name of the cartridge project into which the Network specification is built.
	Select	Click to select an existing Network specification.
	Open	Click to open the selected specification in the Network Specification editor.
	Remove	Click to remove a Network specification.
	Add	Click to add a new Network specification.







Related Topics

Adding Existing Configurations to a Network Specification

Adding New Configurations to a Network Specification

Network Configuration Specification Editor












Working with Network Node Specifications

You use Network Node specifications to define nodes for the various Network specifications in your inventory. When you add a network node to a network, you can associate a resource to a node. In UIM, nodes and the resources that they represent are modeled separately. This strategy gives you the flexibility required to keep your inventory up to date as equipment changes. A network can consist of nodes that represent a variety of different entities, or no entity at all.

You create Network Node specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

When working with Network Node specifications, see the following topics:

	
About Network Node Entity Type Limitations


	
Network Node Specification Editor












About Network Node Entity Type Limitations

You can limit the kinds of entities that a network node can represent. UIM uses the list of specifications with which a Network Node specification has relationships to restrict the entity types to which a node instance can be associated. If a relationship exists between a Network Node specification and a specification of any of the entity types a network node can represent, UIM allows the network node instance to be associated only with instances of the related specifications.

If a Network Node specification does not include any relationships to the entity types a network node can represent, then UIM allows node instances to be associated with any of the allowable entity types. See "Defining Specification Relationships" for more information about relationships.


Related Topics

Working with Network Node Specifications










Network Node Specification Editor

Use the Network Node Specification editor to define nodes for the various Network specifications in your inventory.

When working with the Network Node Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Network Edge Specifications

A Network Edge specification describes the behavior and attributes of the edges that connect nodes in a network. You create different Network Edge specifications for the different kinds of edges in your inventory.

You can associate a network edge to one or more pipes if the connectivity is known. You can leave the network edge unassociated if the connectivity is not known, or if the reachability is through a dynamic route in another network. A network edge can also be associated to one or more custom object instances that define a type of connectivity not available in the default model.

You create Network Edge specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

When working with Network Edge specifications, see the following topics:

	
About Network Edge Entity Type Limitations


	
Network Edge Specification Editor












About Network Edge Entity Type Limitations

By relating Pipe specifications and Custom Object specifications to a Network Edge specification, you can restrict the types of pipes and custom objects that can be represented by a Network Edge specification.

If no relationship exists between the Network Edge specification and pipe or custom object specification, then UIM does not limit the entity a network edge may represent to any specification.


Related Topics

Working with Network Edge Specifications










Network Edge Specification Editor

Use Network Edge Specification editor to describe the behavior and attributes of the edges that connect nodes in a network.

When working with the Network Edge Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Capacity Types

In UIM, you can define various types of capacity and how they are measured. You can also define how an entity provides or requires capacity in terms of its capacity type and the amount it provides. Capacity types define the kind of capacity that an entity provides or consumes. You associate a measurement type to a capacity type to specify how the capacity is measured. See "Working with Measurement Types" for more information.

When working with capacity types, see the following topics:

	
Creating Capacity Types


	
Configuring Capacity Types


	
Capacity Type Editor












Creating Capacity Types

You create capacity types to define the kind of capacity that an entity provides or consumes.

To create capacity types:

	
From the Studio menu, select New, then select Inventory, then select Resources, then select Capacity Type.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-right corner.


	
In the Project field, select the name of the project to which the new capacity type should be added.


	
In the Name field, enter a name for the capacity type.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the capacity type and displays the information in Capacity Type editor.





Related Topics

Capacity Type Editor

Configuring Capacity Types










Configuring Capacity Types

You associate a measurement type to a capacity type to specify how the capacity is measured.

To configure a capacity type:

	
Create a new capacity type or navigate to the editor of an existing one.

See "Creating Capacity Types" for more information.


	
In the Capacity Type editor Properties tab, enter a name for the capacity type in the Name field.


	
In the Measurement Type area, do one of the following:

	
Click Select to select an existing measurement type. The Measurement Type dialog box appears, listing all available measurement types.


	
Click the Measurement Type link to create and add a new measurement type. See "Creating Measurement Types" for information about creating a new measurement type.




The measurement type you select or create is displayed in the Measurement Type field.


	
In the Description field, enter a description of the capacity type.


	
From the File menu, select Save.





Related Topics

Capacity Type Editor










Capacity Type Editor

Use the Capacity Type editor to define the kind of capacity that an entity provides or consumes.


	Field	Use
	Name	Enter a name for the capacity type.
	Measurement Type	Displays the name of the measurement type. Click the link to create a new measurement type.
	Select	Click to select an existing measurement type.
	Clear	Click to remove the measurement type.
	Description	Enter a description for the capacity type.







Related Topics

Creating Capacity Types

Configuring Capacity Types











Working with Capacity Provided Specifications

Capacity Provided specifications define the maximum capacity an entity can provide to other entities that can consume the capacity, such as the maximum bandwidth capacity provided by a pipe. An entity can offer multiple types of capacity, so its specification can have relationships to multiple Capacity Provided specifications.

An entity specification can be related to only one Capacity Provided specification of a given capacity type, however. Capacity types are required to create Capacity Provided specifications. UIM supports defining capacity provided for pipes and signal termination points. See "Working with Capacity Types" for more information.

When working with Capacity Provided specifications, see the following topics:

	
Configuring Capacity Provided Specifications


	
Capacity Provided Specification Editor












Configuring Capacity Provided Specifications

You associate Capacity Provided specifications to specifications of entities that offer capacity through the capacity framework.

To configure a Capacity Provided specification:

	
Create a new Capacity Provided specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Capacity Provided editor, click the Properties tab.


	
In the Capacity Type field, do one of the following:

	
Click Capacity Type to create and add a new capacity type. See "Creating Capacity Types" for more information.


	
Click Select to select an existing capacity type. The Capacity Type dialog box appears, listing all available capacity types.


	
Click Clear to remove a previous selection.





	
In the Total Amount field, enter the amount of the capacity provided.


	
In the Unit of Measure field, do one of the following:

	
Click Unit of Measure to create and add a new unit of measure. See "Creating Units of Measure" for more information.


	
Click Select to select an existing unit of measure. The Unit of Measure dialog box appears, listing all available units of measure.


	
Click Clear to remove a previous selection.





	
In the Consumable Percentage field, enter the percentage of the total amount that can be consumed.


	
From the File menu, select Save.





Related Topics

Capacity Provided Specification Editor










Capacity Provided Specification Editor

Use the Capacity Provided Specification editor to define the capacity an entity offers in terms of a total amount and a consumable percentage.

When working with the Capacity Provided Specification editor, see the following topics:

	
Specification Editor Specification Properties Tab


	
Capacity Provided Specification Editor Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Media Tab












Capacity Provided Specification Editor Properties Tab

Use the Properties tab to create a new capacity type or select an existing one.


	Field	Use
	Capacity Type	Determines the type of capacity offered, defined by a capacity type.
Do one of the following:

	
Click Capacity Type to create a new capacity type.


	
Click Select to select from existing capacity types.


	
Click Clear to remove a previous selection.





	Clear	Click to remove a new capacity type.
	Total Amount	Enter the amount of the capacity type that an entity can provide.
	Unit of Measure	Select the units by which the total amount is measured, defined by a Unit of Measure specification.
Do one of the following:

	
Click the link to create a new unit of measure.


	
Click Select to select from existing units of measure.


	
Click Clear to remove a previous selection.





	Consumable Percentage	Select the percentage of the total amount that can be consumed. A consumable percentage over 100% indicates that the capacity can be oversubscribed.







Related Topics

Configuring Capacity Provided Specifications

Capacity Provided Specification Editor












Working with Capacity Required Specifications

Capacity Required specifications define the amount of capacity entities require when they consume a type of capacity.

An entity can require multiple types of capacity, so its specification can have relationships to multiple Capacity Required specifications. An entity specification can be related to only one Capacity Required specification of a given capacity type, however. Capacity types are required to create Capacity Required specifications. See "Working with Capacity Types" for more information.

When working with Capacity Required specifications, see the following topics:

	
Configuring Capacity Required Specifications


	
Capacity Required Specification Editor












Configuring Capacity Required Specifications

You associate Capacity Required specifications to specifications of entities that offer capacity through the capacity framework.

To configure a Capacity Required specification:

	
Create a new Capacity Required specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Capacity Required Specification editor, click the Properties tab.


	
In the Capacity Type field, do one of the following:

	
Click Capacity Type to create and add a new capacity type. See "Creating Capacity Types" for more information.


	
Click Select to select an existing capacity type. The Capacity Type dialog box appears, listing all available capacity types.


	
Click Clear to remove any previous selections.





	
In the Total Amount field, enter the total capacity provided.


	
In the Unit of Measure field, do one of the following:

	
Click Unit of Measure to create and add a new unit of measure. See "Creating Units of Measure" for more information.


	
Click Select to select an existing unit of measure. The Unit of Measure dialog box appears, listing all available units of measure.


	
Click Clear to remove a previous selection.





	
In the Consumable Percentage field, enter the percentage of the total amount that can be consumed.


	
From the File menu, select Save.





Related Topics

Capacity Required Specification Editor










Capacity Required Specification Editor

Use the Capacity Required Specification editor to define the capacity that an entity requires.

When working with the Capacity Required Specification editor, see the following topics:

	
Specification Editor Specification Properties Tab


	
Capacity Required Specification Editor Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab












Capacity Required Specification Editor Properties Tab

Use the Properties tab to create a new capacity type or select an existing one.


	Field	Use
	Capacity Type	Determines the type of capacity offered, defined by a capacity type.
Do one of the following:

	
Click Capacity Type to create a new capacity type.


	
Click Select to select from existing capacity types.


	
Click Clear to remove a previous selection.





	Required Amount	Enter the amount of the capacity type that an entity requires.
	Unit of Measure	Select the units by which the total amount is measured, defined by a Unit of Measure specification.
Do one of the following:

	
Click the link to create a new unit of measure.


	
Click Select to select from existing units of measure.


	
Click Clear to remove a previous selection.





	Quantity	Specify the quantity of the required amount. Typically, this value is set to 1. If the capacity required must be consumed as a set of units, such as channels provided by a facility pipe, set the Quantity to the number of units required. The capacity required of each unit is equal to the value set in the Required Amount field. The total amount of capacity required is equal to the value defined in the Required Amount field times the value defined in the Quantity field.







Related Topics

Configuring Capacity Required Specifications

Capacity Required Specification Editor












Working with Pipe Signal Termination Point Specifications

You use Pipe Signal Termination Point specifications to define signal structures. A signal structure defines a multiplexing hierarchy where data streams are separated into multiple lower data communication links. For example, a DS1 signal structure can define a 1.536 Mbps data stream as 24 DS0 signals, each supporting 64 Kbps. The signal structure defines the channel hierarchy for a pipe facility that supports time division multiplexing (TDM), such as a T1 or an E1 facility.

You create a hierarchy of Pipe Signal Termination Point specifications to define the signal structure. The highest-level Pipe Signal Termination Point specification in the hierarchy (the parent) represents a trail termination point (TTP). You associate this parent specification to a Capacity Provided specification to define the total bandwidth capacity provided by the signal structure.

The child Pipe Signal Termination Point specifications represent connection termination points (CTP). A signal structure can have multiple levels of child Pipe Signal Termination Point specifications, each representing a further breakdown of the data stream defined by the preceding specification in the hierarchy.

You associate the highest-level Pipe Signal Termination Point specification (the parent) of a signal structure to a Pipe specification to define the channel hierarchy and capacity provided by the pipe facility.

When working with Pipe Signal Termination Point specifications, see the following topics:

	
Configuring Child Signal Termination Points


	
Configuring Parent Signal Termination Points


	
Pipe Signal Termination Point Specification Editor












About Child Signal Termination Points

A child signal termination point represents a child signal level in a signal structure, such as the DS0 signals in a DS1 signal structure. Although you can create the specifications in any order, it is generally a good practice to begin with the child signal termination points and then move to the parent. Having the child termination points already created makes it easier to create the parent termination points. When you configure a child Pipe Signal Termination Point specification, you define the capacity unit amount, unit of measure, and number of child signals.

You can optionally define compatible signals. These are Pipe Signal Termination Point specifications that define capacity unit amounts that the signal can support even though they are not an exact match for the main capacity unit amount. For example, you can configure, a SONET STS1 51.840 Mbps channel to support a DS3 facility at a rate of 44.736 Mbps in addition to an STS transmission facility of exactly 51.840 Mbps.


Related Topics

Configuring Child Signal Termination Points

Pipe Signal Termination Point Specification Editor










Configuring Child Signal Termination Points

To configure a child Pipe Signal Termination Point specification:

	
Create a new Pipe Signal Termination Point specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Pipe Signal Termination Point Specification editor, click the Properties tab.


	
In the Capacity Unit Amount field, enter an amount for the capacity.

The value is relative to the selection in the Unit of Measure field. When you enter a value in the Capacity Unit Amount field, the Capacity Provided field is disabled. Capacity provided information is not required for child signal termination points.


	
In the Unit of Measure field, select a unit of measure relative to the Capacity Unit Amount field.

See "Creating Units of Measure" for information about creating a new Unit of Measure.


	
In the Number of Child Signals field, select the appropriate value.

For example, select 0 if this signal termination point will not have any child signal termination points. If the signal termination point will have children, this value will be greater than 0. For example, in a SONET or SDH signal structure, there can be more than two levels of signal termination points.


	
From the File menu, select Save.





Related Topics

Pipe Signal Termination Point Specification Editor

Configuring Parent Signal Termination Points










Configuring Parent Signal Termination Points

You define the total bandwidth for the signal structure by relating a Capacity Provided specification to the highest-level Pipe Signal Termination Point specification in the structure. A parent signal termination point represents the top level of a signal structure, such as the DS1 signal in DS1 signal structure. You define the signal hierarchy below the parent signal termination point by selecting a succession of child termination point specifications.

To configure a parent Pipe Signal Termination Point specification:

	
Create a new Pipe Signal Termination Point specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In Pipe Signal Termination Point Specification editor, click the Properties tab.


	
In the Capacity Provided field, do one of the following:

	
Click Capacity Provided to create and model a new specification. See "Creating New Specifications" for more information. When you have completed working on the new Capacity Provided specification, return to the editor of the original Pipe Signal Termination Point specification.


	
Click Select to select an existing Capacity Provided specification.


	
Click Clear to remove any previous selections.




The specification that you select or create is displayed in the Capacity Provided field, and the Capacity Unit Amount and Unit of Measure fields are disabled. This information is not required for parent signal termination points.


	
In the Number of Child Signals field, enter or select the appropriate number of signals.

For example, for a DS1 signal structure, enter 24.


	
Click the Signal Structure tab.


	
Right-click the icon in the tab and do one of the following:

	
Select Select Child Signal to select an existing Pipe Signal Termination Point specification.


	
Select Create New Child Signal to create a new Pipe Signal Termination Point specification.

See "Creating New Specifications" for information about creating a new Pipe Signal Termination Point specification. When you have completed working on the new specification, return to the editor of the original Pipe Signal Termination Point specification.




The specification that you select or create is displayed in the Signal Structure tab. The number of child signals is also displayed.


	
From the File menu, select Save.





Related Topics

Pipe Signal Termination Point Specification Editor

Configuring Child Signal Termination Points










Pipe Signal Termination Point Specification Editor

Use the Pipe Signal Termination Point Specification editor to define signal structures.

When working with the Pipe Signal Termination Point Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Pipe Signal Termination Point Specification Editor Signal Structure Tab


	
Pipe Signal Termination Point Specification Editor Properties Tab


	
Pipe Signal Termination Point Specification Editor Compatible Signals Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Pipe Signal Termination Point Specification Editor Signal Structure Tab

Use the Signal Structure tab to create a new Pipe Signal Termination Point specification or select an existing one.


	Field	Use
	Select Child Signal	Right-click the specification box and select this option to add an existing Pipe Signal Termination Point specification.
	Create New Child Signal	Right-click the specification box and select this option to create a new Pipe Signal Termination Point specification.







Related Topics

Configuring Child Signal Termination Points

Configuring Parent Signal Termination Points

Pipe Signal Termination Point Specification Editor










Pipe Signal Termination Point Specification Editor Properties Tab

Use the Properties tab to define the capacity unit amount, unit of measure, and number of child signals.


	Field	Use
	Capacity Provided	Displays the name of the selected Capacity Provided specification.
	New	Click to create a new Capacity Provided specification.
	Select	Click to select an existing Capacity Provided specification.
	Clear	Click to remove a Capacity Provided specification.
	Capacity Unit Amount	Enter a value relative to the selection in the Unit of Measure field. When you enter a value in the Capacity Unit Amount field, the Capacity Provided area is removed from the tab. Capacity provided information is not required for child signal termination points.
	Unit of Measure	Click New to create a new unit of measure or click Select to use an existing one.
	Number of Child Signals	Define this value as 0 if the signal termination point will not have any child signal termination points. Define this value as greater than 0 if the signal termination point will have children.







Related Topics

Configuring Child Signal Termination Points

Configuring Parent Signal Termination Points

Pipe Signal Termination Point Specification Editor










Pipe Signal Termination Point Specification Editor Compatible Signals Tab

You use the Compatible Signals tab to select Pipe Signal Termination Point specifications that include compatible capacity unit amounts. These are capacities that the signal can support even though they are not an exact match for the main capacity unit amount. For example, you can configure a SONET STS1 51.840 Mbps channel to support a DS3 facility at a rate of 44.736 Mbps in addition to an STS transmission facility of exactly 51.840 Mbps.


	Field	Use
	Supports Signals	Displays all supported Pipe Signal Termination Point specifications.
	Supported By Signals	Displays all Pipe Signal Termination Point specifications that are supported by the selected specification.
	Select	Click to select and add an existing Pipe Signal Termination Point specification.
	Open	Click to open the selected Signal Termination Point in the Pipe Signal Termination Point Specification editor.
	Remove	Click to remove the selected Pipe Signal Termination Point specification.
	Add	Click to create and add a new Pipe Signal Termination Point specification.
















Working with Pipe Termination Point Specifications

You can include Pipe Termination Point specifications in a Pipe specification. When you create a Pipe Termination Point specification, you can include characteristics for information you want to collect. Pipe Termination Point specifications enable you to include characteristics on the termination points of a pipe and to add behaviors through rule sets. A pipe termination point identifies where one end of a pipe terminates. If you use pipe termination points, each pipe must have two, one for each end.

Defining Pipe Termination Point specifications is necessary only to add characteristics to capture specific information about the termination point.

The application creates pipe termination points without a specification if there is no Pipe Termination Point specification associated to the Pipe specification. See "Adding Pipe Termination Point Specifications to a Pipe Specification" for more information.

You create Pipe Termination Point specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Pipe Termination Point Specification Editor" for reference information about the tabs you use to define a Pipe Termination Point specification.









Pipe Termination Point Specification Editor

Use the Pipe Termination Point Specification editor to identify where one end of a pipe terminates, to include characteristics on the termination points of a pipe, and to add behaviors through rule sets.

When working with the Pipe Termination Point Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Pipe Specifications

Pipes are a generalized representation of any kind of connectivity in the inventory. A pipe enables the transfer of information between two termination points. Both physical connectivity, such as cables, and logical connectivity, such as traffic flows, can be represented by pipes.

Pipes belong to the following categories:

	
Trails: Pipes that are enabled by some other connectivity, such as another trail or a connection.


	
Connections: Stand-alone, point-to-point pipes that can enable trails.




You use Pipe specifications to define both trails and connections. You use pipe termination points to define the end points of pipes. Pipe specifications can be used to model layered connectivity, such as a local loop that is enabled in the network by a series of interconnected cable pairs and cross-connects. Pipes can also be used to model hierarchical relationships of pipes. When you create a Pipe Termination Point specification, you can include characteristics for information you want to collect.

When working with Pipe specifications, see the following topics:

	
About Pipe Models


	
Configuring Pipe Specifications


	
Adding Pipe Termination Point Specifications to a Pipe Specification


	
Pipe Specification Editor












About Pipe Models

UIM supports three different pipe models. The models are defined by how a pipe provides other pipes and by the way the capacity is structured. Path analysis and other processes are designed to support these models.




	
Note:

Connectivity models other than those described in this section are not supported by path analysis.







When you define Pipe specifications, you should keep these models in mind. For example, if you are defining a specification for a TDM facility, you must consider that it has a signal structure but does not have any child pipes.

The following pipe models are supported in UIM:

	
Cable/Pair Model: A parent pipe represents a copper or fiber cable that provides child pipes to represent twisted pairs or fiber strands. The cable pipe is configured in the following way:

	
Minimum and maximum quantities for the child pipes are identical, so they are created automatically when the parent pipe is created in UIM.


	
No capacity is required or provided.


	
No signal structure is present.





	
Packet Facility Model: Supports Layer 2 links, such as ATM, Frame Relay and Ethernet. Facility pipes provide capacity in bulk to pipes that they enable. This capacity can be consumed completely by one pipe or in smaller quantities by multiple pipes. The facility pipe can enable any number of pipes if its maximum capacity and usage percentage are not exceeded.

Pipes based on the packet facility model are configured as follows:

	
No signal structure is defined.


	
The capacity required reflects the capacity that the pipe must be enabled by another pipe.


	
The capacity provided is the total capacity provided by the facility.


	
No child pipes are defined.





	
TDM Facility Model: Supports channelized technologies, such as TDM/PDH and SONET/SDH. Facility pipes provide channels that are used to enable service trails. A signal structure is associated to the facility pipe to define its capacity and channelization. The facility pipe is structured in the following way:

	
The capacity required is the capacity that is required when enabled by another pipe.


	
The pipe includes a signal structure that defines the pipe's capacity provided and how the signal is channelized. Channels are created either automatically or as needed in UIM depending on how the signal structure is organized.


	
No child pipes are defined.







See UIM Concepts for more information about pipes.


Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

Working with Pipe Specifications










Configuring Pipe Specifications

In UIM, you can describe where the pipe terminates in general terms (a network) or at a high level of specificity (on a particular subinterface). This section provides the procedure on how to configure a Pipe specification.

To configure a Pipe specification:

	
Create a new Pipe specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Pipe Specification editor, click the Capacities Required tab.


	
Do one of the following:

	
Click Select to select an existing Capacity Required specification. The Add Entities dialog box appears, listing all available Capacity Required specifications.


	
Click Add to create a new Capacity Required specification. See "Creating New Specifications" for more information.





	
(Optional) If this Pipe specification is associated with a signal structure, click the Signal Structure tab and do one of the following:

	
Click Select to select an existing Pipe Signal Termination Point specification. The Pipe Signal Termination Point Specification dialog box appears, listing all available Pipe Signal Termination Point specifications.


	
Click Signal Structure to create a new Signal Termination specification. See "Creating New Specifications" for information about creating a new Pipe Signal Termination Point specification. When you have completed working on the new specification, return to the editor of the original Pipe Signal Termination Point specification.




The specification that you selected or created is displayed in the Signal Structure tab. The number of child signals is also displayed.


	
(Optional) If the Specification is not associated with a signal structure, click the Capacity Provided tab and do one of the following:

	
Click Select to select an existing Capacity Provided specification. The Add Entities dialog box appears, listing all available Capacity Provided specifications.


	
Click Add to create a new Capacity Provided specification. See "Creating New Specifications" to create the specification. When you have completed working on the new specification, return to the editor of the original Pipe specification.




The specification you selected or created appears in the Capacities Provided tab.


	
From the File menu, select Save.





Related Topics

About Pipe Models

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

Working with Pipe Specifications










Adding Pipe Termination Point Specifications to a Pipe Specification

You can add a Pipe Termination Point specification to a Pipe specification. A Pipe Termination Point specification is required only to add characteristics. You add the Pipe Termination Point specification by including it on the Related Specifications tab of the Pipe specification editor. See "Working with Pipe Termination Point Specifications" and "Defining Specification Relationships" for more information.


Related Topics

About Pipe Models

Configuring Pipe Specifications

Pipe Specification Editor

Working with Pipe Specifications










Pipe Specification Editor

Use the Pipe Specification editor to define trails and connections, to model layered connectivity, and to model hierarchical relationships of pipes.

When working with the Pipe Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Pipe Specification Editor Pipe Configurations Tab


	
Pipe Specification Editor Capacity Provided Tab


	
Pipe Specification Editor Capacity Required Tab


	
Pipe Specification Editor Signal Structure Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab












Pipe Specification Editor Pipe Configurations Tab

Use the Pipe Configurations tab to select, add, and remove a pipe configuration.


	Field	Use
	Pipe Configuration	Displays the name of the Pipe Configuration specification.
	Cartridge	Displays the name of the cartridge project into which the Pipe Configuration specification is built.
	Select	Click to select an existing pipe configuration.
	Open	Click to open the selected configuration in the Pipe Configuration Specification editor.
	Remove	Click to remove a pipe configuration.
	Add	Click to add a new pipe configuration. See "Adding a Configuration to a Pipe Specification" for more information.







Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

About Pipe Models










Pipe Specification Editor Capacity Provided Tab

Use the Capacity Provided tab to create a new Capacity Provided specification or select an existing one.


	Field	Use
	Capacity Provided	Displays the selected Capacity Provided specification.
	Select	Click to select an existing Capacity Provided specification.
	Open	Click to open the selected specification in the Capacity Provided Specification editor.
	Remove	Click to remove a Capacity Provided specification.
	Add	Click to create a new Capacity Provided specification.







Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

About Pipe Models










Pipe Specification Editor Capacity Required Tab

Use the Capacity Required tab to create a new Capacity Required specification or select an existing one.


	Field	Use
	Capacity Required	Displays the selected Capacity Required specification.
	Select	Click to select an existing Capacity Required specification.
	Open	Click to open the selected specification in the Capacity Required Specification editor.
	Remove	Click to remove a Capacity Required specification.
	Add	Click to create a new Capacity Required specification.







Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

About Pipe Models










Pipe Specification Editor Signal Structure Tab

Use the Signal Structure tab to create a new Pipe Signal Termination Point specification or select an existing one.


	Field	Use
	Signal Structure	Displays the name of the selected Pipe Signal Termination Point specification. Click this link to create and associate a new Pipe Signal Termination Point specification.
	Select	Click to select an existing Pipe Signal Termination Point specification.
	Clear	Click to remove a previously selected Pipe Signal Termination Point specification.







Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor

About Pipe Models












Working with Pipe Configuration Specifications

A Pipe Configuration captures details about how a pipe is enabled and on what resources the pipe terminates.

When working with Pipe Configuration specifications, see the following topics:

	
About Pipe Configuration Specifications


	
Creating Pipe Configuration Specifications


	
Adding a Configuration to a Pipe Specification


	
Adding Configuration Items


	
Pipe Configuration Specification Editor












About Pipe Configuration Specifications

A pipe configuration can include one instance of each of the following four types of configuration items:

	
Termination (Originating): Defines the kinds of resources on which the pipe's originating termination point can terminate. Associating a specification option with the configuration item limits the resources from which the pipe can originate to instances of the selected specifications.


	
Termination (Terminating): Defines the kinds of resources on which the pipe's terminating termination point can terminate. Associating a specification option with the configuration item limits the resources on which the pipe can terminate to instances of the selected specifications.


	
Transport: Defines the kinds of pipes by which the pipe can be enabled. The pipe specifications that are selected as specification options for this item are used in Path Analysis to find the available pipe instances to enable the pipe in its end-to-end connectivity path.


	
Intermediate Node: Defines a resource, such as logical device, through which the pipe's connectivity must route. This is a child configuration item that can be created under the Transport item. A specification option associated with this item is used in Path Analysis to find an instance of the specified resource through which the pipes that enable the configured pipe must be routed.







	
Note:

Although Design Studio allows you to include more than one of each of these types of configuration items in a pipe configuration, doing so causes errors in UIM.
















Creating Pipe Configuration Specifications

You can create a Pipe Configuration specification independently or create a new Pipe Configuration specification in the processing of adding it to a Pipe specification.

To create a Pipe Configuration specification:

	
Do one of the following:

	
If you are creating the Pipe Configuration specification independently, select New from the Studio menu, then select Inventory, then select Resources, then select Pipe Configuration Specification.


	
If you are creating a Pipe Configuration specification while adding it to a Pipe specification, click Add in the Pipe Configurations tab of the Pipe Specification editor.





	
In the Project field, select the name of the project to which the new Pipe Configuration specification should be added.


	
In the Name field, enter a name for the new Pipe Configuration specification.

This is the name that appears in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.


	
In the Pipe Configuration Specification editor, click the Details tab.


	
(Optional) Right-click in the Details tab data tree area and from the Configuration Items menu select Add Termination (Originating), Add Termination (Terminating), or Add Transport to add configuration items.


	
If you added a Transport configuration item, right-click the Transport configuration item, and then from the Configuration Items menu select Add Intermediate Node.

For Transport configuration items, you must create an Intermediate Node child configuration item. Intermediate Node is the only required child configuration item.


	
(Optional) To limit the resources associated with configuration items to instances of particular specifications:

	
Select a configuration item.


	
In the Specification Options tab, add specifications for the valid resources.

See "Configuration Specification Editor Specification Options Subtab" for more information.





	
From the File menu, select Save.





Related Topics

Adding a Configuration to a Pipe Specification

Pipe Configuration Specification Editor










Adding a Configuration to a Pipe Specification

You can add an already existing pipe configuration or create one in the process of adding it. The pipe configuration and the Pipe specification do not have to be in the same project.

To add a pipe configuration to a Pipe specification:

	
Create a new Pipe specification or navigate to the editor of an existing one.

See "Creating New Specifications" for more information.


	
In the Pipe Specification editor, click the Pipe Configurations tab and do one of the following:

	
Click Select to add an existing configuration. The Add Entities dialog box appears, listing the available specifications.


	
Click Add to create and add a new configuration. See "Creating Configuration Specifications" to create the configuration. When you have completed working on the new configuration, return to the Pipe Specification editor.




The Pipe Configuration specification is added to the Pipe specification's Pipe Configurations tab.


	
From the File menu, select Save.





Related Topics

Creating Pipe Configuration Specifications

Pipe Configuration Specification Editor










Pipe Configuration Specification Editor

Use the Pipe Configuration Specification editor to capture details about how a pipe is enabled and on what resources the pipe terminates.

When working with the Pipe Configuration Specification editor, see the following topics:

	
Configuration Specification Editor Details Tab


	
Configuration Specification Editor Layouts Tab


	
Configuration Specification Editor Rules Tab


	
Pipe Configuration Specification Editor Pipe Specs Tab












Pipe Configuration Specification Editor Pipe Specs Tab

Use the Pipe Specs tab to select, add, and remove the Pipe specifications that use the Pipe Configuration specifications. This tab identifies the Pipe specifications that use the selected Pipe Configuration specification. You must use this tab to relate a Pipe specification to its Pipe Configuration specification only when the Pipe specification and Pipe Configuration specification need to be in separate cartridges, and the Pipe specification can exist without the Pipe Configuration specification. If both the Pipe specification and Pipe Configuration specification are in the same cartridge, make the association on the Pipe specification.


	Field	Use
	Pipe Specification	Displays the name of the Pipe specification.
	Cartridge	Displays the name of the cartridge project into which the Pipe specification is built.
	Select	Click to select an existing Pipe specification.
	Open	Click to open the selected specification in the Pipe Specification editor.
	Remove	Click to remove a Pipe specification.
	Add	Click to add a new Pipe specification.
















Working with Connectivity Signal Termination Point Specifications

Connectivity Signal Termination Point specifications define signals included the in ora_uim_basetechnologies cartridge. These signals include Synchronous Digital Hierarchy (SDH), Synchronous Optical Network (SONET), E-Carrier, T-Carrier, and J-Carrier technologies.

Connectivity Signal Termination Point specifications are related hierarchically to other Connectivity Signal Termination Point specifications (and Processing Signal specifications, for SONET and SDH) to define the multiplexing options for a channelized transmission facility. For more information about Connectivity Signal Termination Point specifications, see UIM Concepts and UIM Information Model Reference.

When working with Connectivity Signal Termination Point specifications, see the following topics:

	
Connectivity Signal Termination Point Specification Editor


	
Rate Code Editor


	
Technology Editor


	
Connectivity Function Editor


	
Processing Signal Specification Editor












Connectivity Signal Termination Point Specification Editor

Use the Connectivity Signal Termination Point Specification editor to review the connectivity signal structures that UIM uses to determine the multiplexing options for channelizing TDM Facility entities. These signal structures are read-only.

See UIM Concepts and UIM Information Model Reference for more information.


	Field	Use
	Display Name	Enter the name that appears in Design Studio editors and in UIM.
Design Studio supports multiple languages for this field. The field adjacent to Display Name displays your list of languages. You can define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the [default] option. See "Defining Language Preferences" for more information.


	Name	Displays the name of the connectivity signal specification.
	Termination Point Signal Type	Displays the type of the signal. Values are:
	
SYNCHRONOUS_TRANSPORT_MODULE (STM): Signal type used in the SDH technology.


	
CONTAINER: Signal type used in the SDH technology.


	
OPTICAL_CARRIER (OC): Signal type used in the SONET technology.


	
SYNCHRONOUS_TRANSPORT_SIGNAL (STS): A signal type used in the SONET technology.


	
SYNCHRONOUS_PAYLOAD_ENVELOPE (SPE): A signal type used in the SONET technology.


	
PDH_SIGNAL: Plesiochronous Digital Hierarchy (PDH) signal. Applicable to T-Carrier, E-Carrier, and J-Carrier signals.





	Transmission Signal Type	Displays the physical nature of the transmission signal, such as Optical or Electrical.
	Rate Code	Displays the rate code that identifies the technology and bit rate for the signal.
	Valid for Facility	Indicates whether the signal can be mapped to a TDM Facility through the associated rate code.














Rate Code Editor

You use the Rate Code editor to review information about the system-provided rate codes in Design Studio for Inventory. Rate codes are associated to Connectivity Signal Termination Point specifications and Processing Signal specifications to define the technology and transmission bit rate of the signals.

See UIM Concepts and UIM Information Model Reference for more information.


	Field	Use
	Name	Displays the rate code designation as an acronym or mnemonic, and which describes a technology-specific transmission rate for a signal, service, connectivity, transmission facility, or device interface. For example, a SONET technology STS-192 signal that operates at a transmission rate of 9,953.230 Mb/s can be referred to as STS192. A device interface that supports an STS-192 signal termination can be described as supporting the STS192 rate code.
	Description	Displays additional information about the rate code, when necessary.
	Nominal Bit Rate	Displays the transmission bit rate associated with the rate code.
	Unit of Measure	Displays the unit of measure of the nominal bit rate.
	Technology	Displays the technology that the rate code supports. A technology provides specific kinds of capabilities and is bound by specific types of standards, requirements, behaviors, information, and impact across the business and the use of the technology. Examples of communication technologies include:
	
SONET: Synchronous Optical Networking


	
SDH: Synchronous Digital Hierarchy


	
E-Carrier: European TDM Carrier


	
J-Carrier: Japanese TDM Carrier


	
T-Carrier: North American TDM Carrier












Related Topics

Device Interface Specification Editor Properties Tab










Technology Editor

Use the Technology editor to review the signal technologies that are applicable to connectivity and device.

See UIM Concepts and UIM Information Model Reference for more information.


	Field	Use
	Name	Displays the name of supported technology, which include:
	
SONET: Synchronous Optical Networking


	
SDH: Synchronous Digital Hierarchy


	
E-Carrier: European TDM Carrier


	
J-Carrier: Japanese TDM Carrier


	
T-Carrier: North American TDM Carrier





	Description	Describes the associated technology.
A technology provides specific kinds of capabilities and is bound by specific types of standards, requirements, behaviors, information, and impact across the business and the use of the technology.









Related Topics

About Rate Codes










Connectivity Function Editor

Use the Connectivity Function editor to review the connectivity functions associated with rate codes.

A connectivity function is a code that represents how a connectivity is used. For example, the T1 connectivity function description conveys specific information, that it is a T-Carrier transmission facility operating at a DS1 rate.

The rate codes delivered with Design Studio for Inventory have one associated connectivity function. You can extend Design Studio for Inventory to include additional connectivity functions. See UIM Developer's Guide for more information about extending the application.

See UIM Concepts and UIM Information Model Reference for more information.


	Field	Use
	Name	Displays the name of the connectivity function.
	Description	Describes the connectivity function.







Related Topics

About Rate Codes










Processing Signal Specification Editor

Use the Processing Signal Specification editor to review the processing signal specification information delivered with Design Studio for Inventory.

Processing signal specifications define processing signals in the signal structure for a SONET or SDH transmission facility (TDM facility). Processing signals multiplex to, align with, or map to other signals in a SONET or SDH signal structure, but they are not facility or channel signals, as they are not directly associated with a TDM facility or channel.

Processing signal specifications are provided in the ora_uim_basetechnologies cartridge. These specifications are associated with Connectivity Signal Termination Point specifications to form the connectivity signal architecture for the SONET and SDH technologies. For information about the signal specifications in the ora_uim_basetechnologies cartridge, including the specification relationships, see UIM Information Model Reference.


	Field	Use
	Name	Displays the name of the processing signal specification.
	Transmission Signal Type	Displays the physical nature of the transmission signal, such as Optical or Electrical.
	Processing Signal Type	Displays the name of the processing signal. Processing signal types for SDH are:
	
ADMINISTRATIVE_UNIT_GROUP (AUG): Groups a set of Administrative Unit (AU) signals.


	
ADMINISTRATIVE_UNIT (AU): A pointer with alignment to a Virtual Container (VC) signal.


	
TRIBUTARY_UNIT_GROUP (TUG): Groups a set of Tributary Unit (TU) signals in the STM-1 frame signal.


	
TRIBUTARY_UNIT (TU): A pointer with alignment to a Virtual Container (VC) signal in the STM-1 frame signal.


	
VIRTUAL_CONTAINER (VC): Adapts (maps to) a Container (C) signal.




Processing signal types for SONET are:

	
VIRTUAL_TRIBUTARY_GROUP (VTG): Groups a set of Virtual Tributary (VT) signals within the STS-1 frame signal.


	
VIRTUAL_TRIBUTARY (VT): A pointer with alignment to a Synchronous Payload Envelope (SPE) signal within the STS-1 frame signal.


	
SYNCHRONOUS_TRANSPORT_SIGNAL (STS): A pointer with alignment to a Synchronous Payload Envelope (SPE) signal.





	Rate Code	Displays the rate code that identifies the technology and bit rate for the processing signal.







Related Topics

About Rate Codes











Working with Measurement Types

A measurement type classifies related groups of units of measure. For example, a bit rate measurement type classifies units of measure such as bits per second (bps), kilobits per second (kbps), and so on. Other possible measurement types include weight and amperage. Measurement types and units of measure are required to create capacity types. See "Working with Capacity Types" for more information.

When working with measurement types, see the following topics:

	
Creating Measurement Types


	
Measurement Types Editor












Creating Measurement Types

You create measurement types to classify related groups of units of measure.

To create measurement types:

	
From the Studio menu, select New, then select Inventory, then select Resources, then select Measurement Type.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-right corner.


	
In the Project field, select the name of the project to which the new measurement type should be added.


	
In the Name field, enter a name for the measurement type.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the measurement type and displays its information in the Measurement Type editor.





Related Topics

Measurement Types Editor










Measurement Types Editor

Use the Measurement Types editor to model related groups of units of measure.


	Field	Use
	Name	Enter a name for the specification.
	Description	Enter a description for the specification. This field is optional.







Related Topics

Measurement Types Editor











Working with Units of Measure

Units of measure define the units used to measure a type of capacity in UIM. A unit of measure is a quantity or increment by which something is divided, counted, or described. For example, Kbps is a unit that measures a bit rate.

When working with units of measure, see the following topics:

	
Creating Units of Measure


	
Configuring Units of Measure


	
Unit of Measure Editor












Creating Units of Measure

You create units of measure to define the units used to measure capacity in UIM.

To create a unit of measure:

	
From the Studio menu, select New, then select Inventory, then select Resources, then select Unit of Measure.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-right corner.


	
In the Project field, select the name of the project to which the new unit of measure should be added.


	
In the Name field, enter a name for the unit of measure.

This is the name that will appear in UIM.


	
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the unit of measure and displays the information on the Properties tab.





Related Topics

Configuring Units of Measure

Unit of Measure Editor










Configuring Units of Measure

After you have created a unit of measure, you must configure its properties.

To configure unit of measure properties:

	
Create a new unit of measure or navigate to the editor of an existing one.

See "Creating Units of Measure" for more information.

The Unit of Measure editor appears, displaying the Properties tab.


	
In the Name field, enter a name that identifies the unit of measure.


	
In the Display Unit Value field, enter the value that you want to be displayed in UIM menus and lists.


	
In the Type of Measurement area, click Select and select a measurement type.

The Selection Dialog dialog box appears. See "Creating Measurement Types" to create a new measurement type.


	
Select a measurement type, then click OK.

The measurement type that you selected is displayed in the Type of Measurement field. Click the Type of Measurement link to open the measurement type in the Measurement Type editor.


	
In the Description field of the Conversion area, enter a description of the conversion required to convert this unit of measure to the base unit of measure.


	
In the Conversion Factor field, enter the multiple used to convert this unit of measure to the base unit of measure.


	
In the main Description field, enter a description of this unit of measure.


	
From the File menu, select Save.





Related Topics

Creating Units of Measure

Unit of Measure Editor










Unit of Measure Editor

Use the Unit of Measure editor to model the units used to measure capacity in UIM.


	Field	Use
	Name	Enter the name of the unit.
	Display Unit Value	Enter the text to be displayed in menus and lists for this unit of measure. This is usually a shortened version of the name.
	Type of Measurement	Specify the measurement type to which this unit of measure belongs. You specify this property by selecting or creating a measurement type.
	Conversion Description	Enter a description of the conversion required to convert this unit of measure to the base unit of measure.
	Conversion Factor	A multiplier used to convert a unit of measure to another unit of measure. For example, for a Mbps unit of measure, you could enter 1000000 as the conversion factor to bps.
Note: Use a conversion factor that converts to the same base unit of measure for all units of measure for any given measurement type.


	Description	Enter a description of this unit of measure.







Related Topics

Creating Units of Measure

Configuring Units of Measure












Working with Telephone Number, Custom Network Address, and Custom Object Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Telephone Number specifications to define the types of telephone numbers that your inventory includes and how they are managed in the business process, Custom Network Address specifications to define a network address that is not modeled by default in UIM, and Custom Object specifications to define entities that do not fit into one of the pre-defined categories in UIM.

When working with Telephone Number, Custom Network Address, and Custom Object specifications, see the following topics:

	
Working with Telephone Number Specifications


	
Working with Custom Network Address Specifications


	
Working with Custom Object Specifications












Working with Telephone Number Specifications

You use Telephone Number specifications to define the types of telephone numbers that your inventory includes and how they are managed in the business process. A Telephone Number specification is a blueprint for the various kinds of telephone numbers you might use. In addition to the standard aspects of a specification, you need to define how telephone numbers based on the specification are formatted for display and storage.

You create Telephone Number specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Telephone Number Specification Editor" for reference information about the tabs you use to define a Telephone Number specification.









Telephone Number Specification Editor

Use Telephone Number Specification editor to define the types of telephone numbers included in your inventory.

When working with the Telephone Number Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Custom Network Address Specifications

A network address is a name, label, or number identifying a location in storage or a device in a system or network. You use a Custom Network Address specifications to define a network address that is not modeled by default in UIM. The network addresses that are modeled by default in the UIM framework are telephone numbers and logical device accounts. See "Working with Telephone Number Specifications" and "Working with Logical Device Account Specifications" for more information.

You create Custom Network Address specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Custom Network Address Specification Editor" for reference information about the tabs you use to define a Custom Network Address specification.









Custom Network Address Specification Editor

Use the Custom Network Address Specification editor to define network addresses that are not modeled by default in UIM.

When working with the Custom Network Address Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Custom Object Specifications

You use Custom Object specifications to define entities that do not fit into one of the predefined categories in UIM. Custom Object specifications enable you extend the inventory model without having to create a custom schema or redeploy UIM.

All of the standard features of specifications, such as characteristics, relationships, and rules are available for custom objects. UIM manages the life cycle of custom objects the same way it manages other entities. Custom objects can also be included in involvement relationships. See "Working with Involvement Specifications" for more information.

You create Custom Object specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Custom Object Specification Editor" for reference information about the tabs you use to define a Custom Object specification.









Custom Object Specification Editor

Use Custom Object Specification editor to define entities that do not fit into one of the predefined categories in UIM.

When working with the Custom Object Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab















Working with Media Stream Specifications

You use Media Stream specifications to model content such as audio or video media delivered over cable, satellite, radio, or streaming IP. Media Stream specifications represent provisional or subscription video services such as tiered services and a la carte packages.

When you define Media Stream specifications, you can add characteristics to supplement the default data elements.

You create Media Stream specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

When working with Media Stream specifications, see "Media Stream Specification Editor" for reference information about the tabs you use to define a Media Stream specification.









Media Stream Specification Editor

You use the Media Stream Specification editor to model media streams. When working with the Media Stream Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Business Interaction, Inventory Group, and Involvement Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Business Interaction specifications to define arrangements (such as work orders or projects) that provide context to actions performed on entities in the inventory. You use Inventory Group specifications to organize and correlate entities in the inventory, and you use Involvement specifications to define associations between entities that are not related in the inventory model.

When working with Business Interaction, Inventory Group, and Involvement specifications, see the following topics:

	
Working with Business Interaction Specifications


	
Working with Inventory Group Specifications


	
Working with Involvement Specifications












Working with Business Interaction Specifications

You use Business Interaction specifications to define arrangements or transactions that provide context to actions performed on entities in the inventory. You can define specifications for business interactions such as service orders, projects, work orders, tasks, and plans.

A business interaction in UIM provides a context for tracking the transactions that are performed against the inventory. Any additions, changes, or deletions to items in the inventory made under the context of a business interaction are included in its transactions. The transactions associated with a business interaction become effective when the business interaction is completed, and they are canceled when the business interaction is canceled. Business interactions provide traceability and auditability. They also enable transaction cancellations and changes. Business interactions can include child business interactions.

You create Business Interaction specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Business Interaction Specification Editor" for reference information about the tabs you use to define a Business Interaction specification.









About Engineering Work Orders

In Design Studio, Engineering Work Order is a unique instance of a Business Interaction specification. The Engineering Work Order Business Interaction specification is included in the ora_uim_workorder cartridge project.

In UIM, an engineering work order enables you to schedule resource infrastructure changes to occur simultaneously. Engineering work orders can be included in Web services, such as the Service Fulfillment Web service. Use the characteristics on an engineering work order to manage and organize the activities associated with the engineering work order. See Unified Inventory Management Concepts for more information.

You can extend the Engineering Work Order Business Interaction specification by adding characteristics to it. You must unseal the ora_uim_workorder cartridge project before you can extend the Engineering Work Order Business Interaction specification. See the discussion about upgrading and extending cartridges and technology packs in Unified Inventory Management Cartridge and Technology Pack Guide for more information about extending cartridges and technology packs.

Engineering Work Order uses the Business Interaction Specification editor.


Related Topics

Adding Existing Characteristics to Specifications

Business Interaction Specification Editor










Business Interaction Specification Editor

Use the Business Interaction Specification editor to define arrangements or transactions that affect entities in the inventory.

When working with the Business Interaction Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Inventory Group Specifications

You use Inventory Group specifications to organize and correlate entities in the inventory. You can define inventory groups to organize entities based on criteria such as geographic area, serving area, billing area, IP address pool, and so forth.

For example, an inventory group containing locations and telephone numbers enables you to specify the telephone numbers that can be selected from a specific serving area.

You create Inventory Group specifications in the same manner as you create other types of specifications. See "Creating New Specifications" for more information.

See "Inventory Group Specification Editor" for reference information about the tabs you use to define an Inventory Group specification.









Inventory Group Specification Editor

Use the Inventory Group Specifications editor to organize and correlate entities in the inventory.

When working with the Inventory Group Specifications editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Configuration Spec Usage Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab














Working with Involvement Specifications

Involvement specifications enable you to define associations between entities for relationships that are not currently supported in UIM. The Involvement specifications that you create enable you to capture characteristics on the relationship and to specify the roles played by the entities participating in the involvement. In order to give the relationship behaviors, you must use rulesets and extension points.

For example, you can use involvements to establish associations involving custom objects. See "Working with Custom Object Specifications" for information about custom objects. By definition, custom objects have no implicit relationships with other entities, so you can use involvements to associate them to other entities.

Two resources can be preconfigured using the PreconfigureSpec Involvement specification (provided by Oracle). Preconfigured resources share the same life cycle in that when one of the resources is reserved or assigned to a service or resource, the other is automatically reserved or assigned with it. This behavior applies only to involvements created using the PreconfigureSpec specification. This specification does not appear in Oracle Communications Design Studio; rather, it is installed in UIM as base data.

You create and configure an Involvement specification in the same way that you do most other types of specifications. See "Working with Specifications" for more information.

When working with Involvement specifications, see "Involvement Specification Editor" for more information.









Involvement Specification Editor

Use the Involvement Specification editor to define associations between entities that are not related in the inventory model.

When working with the Involvement Specification editor, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Specification Properties Tab


	
Specification Editor Related Specifications Tab


	
Specification Editor Rules Tab


	
Specification Editor Layouts Tab


	
Specification Editor Media Tab


	
Specification Editor Extends Tab















Working with Sequence and Entity Identification Specifications

In Oracle Communications Design Studio, you can customize business entity identification generation using Entity Identification specifications. You can use Sequence specifications to customize the sequence of an ID for an entity, by defining the maximum, minimum and increment values for the sequence.

Additionally, you can define and use Sequence specifications independent of Entity Identification specifications. You can create sequence specifications to define sequences used in custom logic (in rulesets and extension points) that you write to generate numeric identifiers.

When working with Entity Identification and Sequence specifications, see the following topics:

	
Working with Entity Identification Specifications


	
Working with Sequence Specifications












Working with Entity Identification Specifications

Using Design Studio, you can configure business entities so that when instances are created in Oracle Communications Unified Inventory Management (UIM), the entity IDs are generated automatically. By default, the ID is a numeric sequence number. You can also customize the ID generation by defining an Entity Identification specification and associating it to an entity specification.

Entity Identification specifications enable you to define alphanumeric prefixes and suffixes, which are added to numeric sequence values to form ID values for entities.

An Entity Identification specification must be associated to a Sequence specification. The Sequence specification defines the minimum, maximum, and increment values that UIM uses to generate the numeric sequence value segment of the entity ID. See "Working with Sequence Specifications" for more information.

You can associate an Entity Identification specification to one or multiple entity specifications to define how UIM creates entity IDs when you create an entity using those specifications.

When working with Entity Identification specifications, see the following topics:

	
Configuring an Entity Identification Specification


	
Entity Identification Specification Editor












Configuring an Entity Identification Specification

After you create an Entity Identification specification, you must configure it.

To configure an entity identification specification:

	
Open an existing Entity Identification or create a new Entity Identification specification.

See "Creating New Specifications" for more information.


	
In the Entity Identification Specification editor, click the Specification Properties tab.


	
Enter the start date, end date, and description.


	
Click the Properties tab.


	
(Optional) In the Prefix field, enter an alphanumeric sequence of characters to append to the beginning of the numeric sequence of the ID value.


	
(Optional) In the Suffix field, enter an alphanumeric sequence of characters to append to the end of the numeric sequence of the ID value.


	
Do one any of the following:

	
Click Sequence Specification to create a new Sequence specification.


	
Click Select to select an existing Sequence specification.


	
Click Clear to remove a previously associated Sequence specification.





	
From the File menu, select Save.





Related Topics

Entity Identification Specification Editor










Entity Identification Specification Editor

Use the Entity Identification Specification editor to define how ID values are created for an entity when the ID is generated automatically.

When working with the Entity Identification Specification editor, see the following topics:

	
Specification Editor Specification Properties Tab


	
Entity Identification Specification Editor Properties Tab












Entity Identification Specification Editor Properties Tab

Use the Properties tab to create, select, and remove a Sequence specification. This tab also enables you to specify a prefix or a suffix for an entity specification.


	Field	Use
	Prefix	Specify an alphanumeric sequence of characters to append to the beginning of the numeric sequence of the ID value.
	Suffix	Specify an alphanumeric sequence of characters to append to the end of the numeric sequence of the ID value.
	Sequence specification	Displays the name of the Sequence specification. Click to create a new Sequence specification.
	Select	Click to select an existing Sequence specification.
	Clear	Click to remove the association of Sequence specification.







Related Topics

Configuring an Entity Identification Specification

Entity Identification Specification Editor












Working with Sequence Specifications

You use Sequence specifications with Entity Identification specifications to customize the sequence of an ID for an entity, by defining the maximum, minimum and increment values for the sequence.

Additionally, you can define and use Sequence specifications independent of Entity Identification specifications. You can create sequence specifications to define sequences used in custom logic (in rulesets and extension points) that you write to generate numeric identifiers. For example, you can create sequence specifications for serial numbers or connection IDs. See UIM Developer's Guide for more information.

When working with Sequence specifications, see the following topics:

	
Configuring a Sequence Specification


	
Sequence Specification Editor












Configuring a Sequence Specification

After you create a sequence specification, you must configure it.

To configure a sequence specification:

	
Open an existing Sequence specification or create a new Sequence specification.

See "Creating New Specifications" for more information.


	
In the Sequence Specification editor, click the Specification Properties tab.


	
Enter the start date, end date, and description.


	
Click the Properties tab.


	
Enter the minimum value, maximum value, and increment value.


	
From the File menu, select Save.





Related Topics

Sequence Specification Editor










Sequence Specification Editor

Use the Sequence Specification editor to customize the sequence of an ID for an entity.

When working with the Sequence Specification editor, see the following topics:

	
Specification Editor Specification Properties Tab


	
Sequence Specification Editor Properties Tab


	
Specification Editor Media Tab












Sequence Specification Editor Properties Tab

Use the Properties tab to set a minimum, maximum, and an increment value for a sequence.


	Field	Use
	Minimum Value	Enter a minimum value for the sequence.
	Maximum Value	Enter a maximum value for the sequence.
Retain the default value 0 to define the sequence value as unbounded.


	Increment Value	Enter an increment value for the sequence.







Related Topics

Configuring a Sequence Specification

Sequence Specification Editor













Working with Rulesets and Extension Points

In Oracle Communications Unified Inventory Management (UIM), rulesets and extension points are used to extend or customize UIM behavior at run time. Rulesets contain application business logic, and extension points define where in the application (which methods on classes) rulesets can be executed.

For example, if you are working with related specifications, you can add rulesets that automatically create entity instances from a child specification when an instance of the entity is created from a parent specification.

You can create combinations of rulesets and extension points and apply the combinations to UIM specifications so a ruleset executes at the associated extension point if it is acting on an entity created from one of the specifications. See "Associating Specification-Based Extension Points to Rulesets" for more information.

You can also create combinations of rulesets and extension points that apply globally. In this scenario, the ruleset always executes at the associated extension point (for all specifications). See "Associating Global Extension Points with Rulesets" for more information.

When working with rulesets and extension points, see the following topics:

	
Working with Rulesets


	
Working with Extension Points


	
Working with Ruleset Extension Points












Working with Rulesets

You use rulesets to control actions on certain entities at certain times and when conditions are met. You code business logic in a ruleset and you can execute a ruleset at multiple extension points. For example, you might define a ruleset to make a telephone number field's edit mask to be ### - ### - #### at creation time for all telephone numbers based on the North American Telephone Number specification.

You use rulesets to extend and customize UIM by associating an extension point to a ruleset. Rulesets provide a capability to modify the business logic at run time.

When working with rulesets, see the following topics:

	
Creating Rulesets


	
Configuring Rulesets


	
Ruleset Editor












Creating Rulesets

You create rulesets to control actions on entities at specific times and under specific conditions.

To create a ruleset:

	
From the Studio menu, select New, then select Inventory, then select Administration, and then select Ruleset.

The Ruleset Wizard dialog box appears.


	
From the Project drop-down list, select the project where the entity is to reside.


	
In the Name field, enter the name of the ruleset.




	
Note:

For a ruleset entity, the text editor forces you to enter all capitals. Use underscores for readability, such as MY_RULE_SET.








	
(Optional) Select a location for the new ruleset.

By default, Oracle Communications Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.





Related Topics

Configuring Rulesets

Ruleset Editor










Configuring Rulesets

After you create a ruleset, you must configure it.

To configure a ruleset:

	
Open an existing ruleset or create a new one.

See "Creating Rulesets" for more information.


	
Click Edit Code.

An empty DRL file opens.




	
Note:

Oracle recommends that you download the JBoss text editor and configure Design Studio to use the editor of the DRL file. The JBoss text editor can catch syntax errors that can be corrected as you write the ruleset, rather than waiting to catch the errors at compilation.








	
Write the ruleset.

See UIM Developer's Guide for detailed information about writing a ruleset.


	
From the File menu select Save, then close the DRL file.


	
From the File select Save again to save the ruleset.













Ruleset Editor

Use the Ruleset editor to create and configure rulesets.

When using the Ruleset editor to create or configure a ruleset, see the following topics:

	
Ruleset Editor Code Tab


	
Ruleset Editor Realization Tab












Ruleset Editor Code Tab

Use the Ruleset editor Code tab to create rulesets in a DRL file.


	Field	Use
	Edit Code	Click to write a ruleset in a DRL file.







Related Topics

Working with Rulesets

Creating Rulesets

Configuring Rulesets

Ruleset Editor










Ruleset Editor Realization Tab

Use the Ruleset editor Realization tab to associate rulesets with a conceptual model service action.


	Field	Use
	Realizes	Click to open the selected service action in the Action editor.
	Select	Associates the ruleset with a conceptual model service action. To select from the available conceptual model service actions, there must be a dependency defined between your Inventory cartridge project and the Model project in which your conceptual model is saved. See "Managing Cartridge Dependencies" for more information.







Related Topics

Working with Conceptual Models

Working with Rulesets

Creating Rulesets

Configuring Rulesets

Ruleset Editor












Working with Extension Points

An extension point represents a method on a Java class where a ruleset can be executed. These methods can be extended by associating an executable ruleset to the extension point.

When working with extension points, see the following topics:

	
About Extension Points


	
Creating Extension Points


	
Configuring Extension Points


	
Associating Specification-Based Extension Points to Rulesets


	
Associating Global Extension Points with Rulesets


	
Extension Point Editor












About Extension Points

An extension point represents a method on a Java class where a ruleset can be executed. These methods can be extended by associating an executable ruleset to the extension point. UIM provides several extension points, and a way for you to create new extension points.

There are two types of extension points that you can create in Design Studio:

	
Specification-based extension points define methods where an associated ruleset can be executed, but only when working with entities created from specific specifications.


	
Global extension points define methods where an associated ruleset can be executed, and which do not pertain to any particular specification. Rulesets associated with global extension points are triggered by all specifications.





Related Topics

Creating Extension Points

Configuring Extension Points

Associating Specification-Based Extension Points to Rulesets

Associating Global Extension Points with Rulesets










Creating Extension Points

An extension point represents a method on a Java class where a ruleset can be executed. These methods can be extended by associating an executable ruleset to the extension point.

To create an extension point:

	
From the Studio menu, select New, then select Inventory, then select Administration, and then select Extension Point.

The Extension Point Wizard dialog box appears.


	
From the Project drop-down list, select the project where the entity is to reside.


	
In the Name field, enter the name of the extension point.


	
(Optional) Select a location for the new extension point.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.





Related Topics

About Extension Points

Configuring Extension Points

Extension Point Editor










Configuring Extension Points

After you create an extension point, you must configure it. When you configure an extension point in Design Studio, the data you enter is saved to the cartridge.

To configure an extension point:

	
Open an existing Extension Point entity or create a new one.

See "Creating Extension Points" for more information.


	
In the Point Name field, enter the name of the extension point.

Oracle recommends the point name be represented as ClassName_methodName. Eclipse does not allow a period in a text field, so the standard notation of ClassName.methodName cannot be entered.


	
In the Description field, enter a brief description of the extension point.

The description describes the method defined by the point name.


	
(Optional) Select Global if the extension point will not be associated with a specific specification type (or with a specific set of specifications).


	
In the Signature field, enter the signature of the method defined by the point name.

	
The signature includes the return value, method name, and all parameters.


	
The signature requires that all objects be fully qualified.


	
The signature must be an abstract interface.


	
Signatures that define arrays must use the notation of ”[]” to represent the array of objects. The notation of ”...” to represent an array of objects is not recognized by the AspectJ framework.


	
Signatures that define an array of objects as a parameter must contain the keyword transient. The AspectJ framework requires this keyword to retrieve the extension point.





	
From the File menu, select Save.


	
Create an aop.xml file and define the extension point within the file.

See UIM Developer's Guide for more information on creating the aop.xml file.





Related Topics

About Extension Points

Associating Specification-Based Extension Points to Rulesets

Associating Global Extension Points with Rulesets

Extension Point Editor










Associating Specification-Based Extension Points to Rulesets

You can create combinations of rulesets and extension points and associate the combinations to UIM specifications so that a ruleset executes at the associated extension point only if it is acting on an entity created from one of the associated specifications.

To associate specification-based extension points to rulesets:

	
Create and configure a ruleset.

See "Working with Rulesets" for more information.


	
Create an extension point.

See "Creating Extension Points" for more information.


	
Create and configure enabled extension points for one or multiple specification classes.

See "Working with Enabled Extension Points" for more information.


	
Create and configure a ruleset extension point.

See "Working with Ruleset Extension Points" for more information.




After you associate a specification-based extension point to a ruleset, you associate the ruleset extension point to a specific instance of a specification in Design Studio. See "Associating Specification-Based Ruleset Extension Points to Specifications" for more information.









Working with Enabled Extension Points

An enabled extension point identifies the specification entity class on which a specification-based extension point can be used. You must create an enabled extension point for each type of entity specification for which you use the extension point. For example, if you plan to use an extension point on equipment specifications and logical device specifications, you must create two enabled extension points for the extension point; one that identifies the EquipmentSpecification class, and one that identifies the LogicalDeviceSpecification class.

When working with enabled extension points, see the following topics:

	
Creating Enabled Extension Points


	
Configuring Enabled Extension Points


	
Mapping Inventory Entities to Entity Specification Java Classes


	
Enabled Extension Point Editor












Creating Enabled Extension Points

An enabled extension point associates a Java class entity specification to an extension point. You can create an enabled extension point in Oracle Communications Design Studio.

To create an enabled extension point:

	
From the Studio menu, select New, then select Inventory, then select Administration, and then select Enabled Extension Point.

The Enabled Extension Point Wizard dialog box appears.


	
From the Project drop-down list, select the project where the entity is to reside.


	
In the Name field, enter the name of the enabled extension point.


	
(Optional) Select a location for the new enabled extension point.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.





Related Topics

Configuring Enabled Extension Points

Enabled Extension Point Editor










Configuring Enabled Extension Points

After you create an enabled extension point, you must configure it.

To configure an enabled extension point:

	
In the Solution view, double-click any enabled extension point.

The Enabled Extension Point editor.


	
In the Specification Class Name field, select the Java class for the specification.

When adding an enabled extension point for a configuration specification (configurable entities include the Logical Device, Network, Pipe, Place, and Service entities), you must select the class name InventoryConfigurationSpec. You use the Configuration Version Instance Type field to identify the configurable entity.

See "Mapping Inventory Entities to Entity Specification Java Classes" for more information.


	
(Optional) If you selected InventoryConfigurationSpec in the Specification Class Name field, select the configuration version DAO class for the configurable entity in the Configuration Version Instance Type field.

If you selected InventoryConfigurationSpec in the Specification Class Name field and you leave the Configuration Version Instance Type field blank, the enabled extension point applies to all of the configurable entities (Logical Device, Network, Pipe, Place, and Service).

See "Mapping Inventory Entities to Entity Specification Java Classes" for more information.


	
In the Point field, select an existing extension point or create a new one.

See "Creating Enabled Extension Points" for more information.





Related Topics

Enabled Extension Point Editor










Mapping Inventory Entities to Entity Specification Java Classes

The following table displays a complete listing of mappings of Studio Inventory entities to entity specification Java class.

The Studio Inventory entities that map to the InventoryConfigurationSpec class display the qualified class in bold, and include the corresponding configuration version instance type class that identifies the configurable entity.


	Studio Inventory Entity	Entity Specification Java Class
	Business Interaction Specification	oracle.communications.inventory.api.entity.BusinessInteractionSpec
	Capacity Provided Specification	oracle.communications.inventory.api.entity.CapacityProvidedSpecification
	Capacity Required Specification	oracle.communications.inventory.api.entity.CapacityRequiredSpecification
	Custom Network Address Specification	oracle.communications.inventory.api.entity.CustNetAddrSpecification
	Custom Object Specification	oracle.communications.inventory.api.entity.CustomObjectSpecification
	Device Interface Specification	oracle.communications.inventory.api.entity.DeviceInterfaceSpecification
	Entity Identifier Specification	oracle.communications.inventory.api.entity.EntityIdentificationSpecification
	Equipment Holder Specification	oracle.communications.inventory.api.entity.EquipmentHolderSpecification
	Equipment Specification	oracle.communications.inventory.api.entity.EquipmentSpecification
	Inventory Group Specification	oracle.communications.inventory.api.entity.InventoryGroupSpecification
	Involvement Specification	oracle.communications.inventory.api.entity.CustomInvolvementSpecification
	Logical Device Account Specification	oracle.communications.inventory.api.entity.LogicalDeviceAccountSpecification
	Logical Device Configuration Specification	oracle.communications.inventory.api.entity.InventoryConfigurationSpec com.metasolv.impl.entity.LogicalDeviceConfigurationVersionDAO
	Logical Device Specification	oracle.communications.inventory.api.entity.LogicalDeviceSpecification
	Media Stream Specification	oracle.communications.inventory.api.entity.MediaStreamSpecification
	Network Configuration Specification	oracle.communications.inventory.api.entity.InventoryConfigurationSpec
com.metasolv.impl.entity.NetworkConfigurationVersionDAO


	Network Edge Specification	oracle.communications.inventory.api.entity.NetworkEdgeSpecification
	Network Node Specification	oracle.communications.inventory.api.entity.NetworkNodeSpecification
	Network Specification	oracle.communications.inventory.api.entity.NetworkSpecification
	Party Specification	oracle.communications.inventory.api.entity.PartySpecification
	Physical Connector Specification	oracle.communications.inventory.api.entity.PhysicalConnectorSpecification
	Physical Device Specification	oracle.communications.inventory.api.entity.PhysicalDeviceSpecification
	Physical Port Specification	oracle.communications.inventory.api.entity.PhysicalPortSpecification
	Pipe Configuration Specification	oracle.communications.inventory.api.entity.InventoryConfigurationSpec com.metasolv.impl.entity.PipeConfigurationVersionDAO
	Pipe Specification	oracle.communications.inventory.api.entity.PipeSpecification
	Pipe Termination Point Specification	oracle.communications.inventory.api.entity.PipeTerminationPointSpecification
	Place Configuration Specification	oracle.communications.inventory.api.entity.InventoryConfigurationSpec com.metasolv.impl.entity.PlaceConfigurationVersionDAO
	Place Specification	oracle.communications.inventory.api.entity.PlaceSpecification
	Product Specification	oracle.communications.inventory.api.entity.ProductSpecification
Note: Product specifications are included in Design Studio for Inventory for backward compatibility with customized solutions that require mapping services to corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a conceptual model.


	Role Specification	oracle.communications.inventory.api.entity.InvRoleSpecification
	Sequence Specification	oracle.communications.inventory.api.entity.SequenceSpecification
	Service Configuration Specification	oracle.communications.inventory.api.entity.InventoryConfigurationSpec com.metasolv.impl.entity.ServiceConfigurationVersionDAO
	Service Specification	oracle.communications.inventory.api.entity.ServiceSpecification
	Signal Termination Point Specification	oracle.communications.inventory.api.entity.SignalTerminationPointSpecification
	Telephone Number Specification	oracle.communications.inventory.api.entity.TelephoneNumberSpecification







Related Topics

Creating Enabled Extension Points

Configuring Enabled Extension Points

Enabled Extension Point Editor










Enabled Extension Point Editor

Use to define the specification entity class on which a specification-based extension point can be used.


	Field	Use
	Specification Class Name	Select the fully qualified entity specification Java class.
	Configuration Version Instance Type	If you selected InventoryConfigurationSpec in the Specification Class Name field, select the configuration version DAO class for the configurable entity.
If you selected InventoryConfigurationSpec in the Specification Class Name field and you leave the Configuration Version Instance Type field blank, the enabled extension point applies to all of the configurable entities (Logical Device, Network, Pipe, Place, and Service).


	Point	Displays the name of the selected extension point. Click Point to create a new extension point.
	Select	Click to select an existing extension point.
	Clear	Click to remove a previously selected extension point.







Related Topics

Configuring Enabled Extension Points

Mapping Inventory Entities to Entity Specification Java Classes

Associating Specification-Based Extension Points to Rulesets












Associating Global Extension Points with Rulesets

You can create combinations of global extension points and ruleset associations if you want rulesets to execute at the associated extension point for all specifications.

To associate global extension points to rulesets:

	
Create and configure a ruleset.

See "Working with Rulesets" for more information.


	
Create an extension point.

See "Creating Extension Points" for more information.


	
Create and configure a ruleset extension point.

See "Working with Ruleset Extension Points" for more information.













Extension Point Editor

Use the Extension Point editor to define point names, descriptions, and method signatures for extension points.


	Field	Use
	Point Name	Enter a name for the extension point.
	Description	Enter a description for the extension point.
	Global	Select if the extension point will not be associated with a specific specification type (or with a specific set of specifications).
	Signature	Define a method signature for an extension point.







Related Topics

Configuring Extension Points

Associating Specification-Based Extension Points to Rulesets

Associating Global Extension Points with Rulesets











Working with Ruleset Extension Points

A ruleset extension point associates a ruleset with an extension point and defines whether the ruleset executes before, after, or instead of the method defined by the extension point.

To define an ruleset extension point, see the following:

	
About Ruleset Extension Points


	
Creating Ruleset Extension Points


	
Configuring Ruleset Extension Points


	
Associating Specification-Based Ruleset Extension Points to Specifications


	
Ruleset Extension Point Editor


	
Ruleset Extension Point-Global Editor












About Ruleset Extension Points

A ruleset extension point associates a ruleset with an extension point and defines whether the ruleset executes before, after, or instead of the method defined by the extension point.

There are two types of ruleset extension points, and the type determines which of the two Ruleset Extension Point editors you use.

	
Specification-based ruleset extension points associate a ruleset with a specification-based extension point. You use the "Ruleset Extension Point Editor" when configuring these types of ruleset extension points.


	
Global ruleset extension points associate a ruleset with a global extension point. You use the "Ruleset Extension Point-Global Editor" when configuring these types of ruleset extension points.





Related Topics

Creating Ruleset Extension Points

Configuring Ruleset Extension Points

Working with Extension Points










Creating Ruleset Extension Points

The ruleset extension point associates an extension point to a ruleset, and defines the placement of the ruleset.

To create a ruleset extension point:

	
From the Studio menu, select New, then select Inventory, then select Administration, and then do one of the following:

	
Select Ruleset Extension Point to associate a ruleset with a specification-based extension point.


	
Select Ruleset Extension Point-Global to associate a ruleset with a global extension point.




Depending on your selection, the Ruleset Extension Point Wizard or Ruleset Extension Point-Global Wizard appears.


	
From the Project drop-down list, select the project where the entity is to reside.


	
In the Name field, enter the name of the ruleset extension point.


	
(Optional) Select a location for the new ruleset extension point.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.





Related Topics

Configuring Ruleset Extension Points

Ruleset Extension Point Editor

Ruleset Extension Point-Global Editor










Configuring Ruleset Extension Points

After you create a ruleset extension point, you must configure it.

To configure a ruleset extension point

	
Open an existing ruleset extension point or create a new one.

See "Creating Ruleset Extension Points" for more information.


	
In the Ruleset field, do one of the following:

	
Click Ruleset to create a new ruleset. See "Creating Rulesets" for more information.


	
Click Select to select an existing ruleset. The Ruleset dialog box appears, displaying all available rulesets.





	
In the Point field, do one of the following:

	
Click Point to create a new extension point. See "Creating Extension Points" for more information.


	
Click Select to select an existing extension point. The Extension Point dialog box appears, displaying all available extension points. The list displays only those extension points that are applicable to the type of ruleset extension point. For example, if you are configuring the ruleset in the Ruleset Extension Point-Global editor, only those extension points defined as global appear in the list. See "Working with Extension Points" for more information.





	
In the Placement field, define whether the ruleset executes before, after, or instead of the method defined by the extension point.

See "Ruleset Extension Point Editor"or "Ruleset Extension Point-Global Editor" for more information about this field.


	
From the File menu, select Save.













Associating Specification-Based Ruleset Extension Points to Specifications

Ruleset extension points must be associated with an instance of a specification in order to execute. This is not applicable to global ruleset extension points (rulesets at a global extension point can execute without being associated to a specification).

To associate specification-based ruleset extension points to specifications:

	
Navigate to the editor of an existing specification to which you want to associate a ruleset extension point.


	
Click the Rules tab.


	
Do one of the following:

	
Click Select to select an existing ruleset extension point.


	
Click Add to create and select a new ruleset extension point. See "Creating Ruleset Extension Points" for more information. When you have completed working on the new ruleset extension point, return to the editor of the specification to which you want to associate this ruleset.


	
Select a ruleset extension point in the table and click Open to view the ruleset extension point in the Ruleset Extension Point editor.


	
Select a ruleset extension point in the table and click Remove to delete the association.





	
From the File menu, select Save.




See UIM Developer's Guide for more information.










Ruleset Extension Point Editor

Use to associate a ruleset with a specification-based extension point, and to define the custom code placement.


	Field	Use
	Ruleset	Do one of the following:
	
Click Ruleset to create a new ruleset.


	
Click Select to select an existing ruleset.


	
Click Clear to remove a previously selected ruleset.





	Point	Do one of the following:
	
Click Point to create a new specification-based extension point.


	
Click Select to select an existing specification-based extension point.


	
Click Clear to remove a previously selected specification-based extension point.




See "Working with Extension Points" for more information.


	Placement	Define whether the ruleset executes before, after, or instead of the method defined by the extension point.
	
Select Before to run the ruleset before the method specified by the signature. For an extension point of type call, the custom code is weaved before the call to the method. For an extension point of type execution, the custom code is weaved within the method before the first line of executable code.


	
Select After to run the ruleset after the method specified by the signature. For an extension point of type call, the custom code is weaved after the call to the method. For an extension point of type execution, the custom code is weaved within the method after the last line of executable code.


	
Select Instead to run the ruleset instead of the method specified by the signature. For an extension point of type call, the custom code is weaved in place of the call to the method. For an extension point of type execution, the custom code is weaved within the method in place of the executable code.












Related Topics

Configuring Ruleset Extension Points

Associating Specification-Based Extension Points to Rulesets










Ruleset Extension Point-Global Editor

Use to associate a ruleset with a global extension point, and to define the custom code placement.


	Field	Use
	Ruleset	Do one of the following:
	
Click Ruleset to create a new ruleset. See "Creating Ruleset Extension Points" for more information.


	
Click Select to select an existing ruleset. The Ruleset dialog box appears, displaying all available rulesets.


	
Click Clear to remove a previously selected ruleset.





	Point	Do one of the following:
	
Click Point to create a new global extension point. See "Creating Extension Points" for more information.


	
Click Select to select an existing global extension point. The Extension Point dialog box appears, displaying all available global extension points.


	
Click Clear to remove a previously selected extension points.




See "Working with Extension Points" for more information.


	Placement	Define whether the ruleset executes before, after, or instead of the method defined by the global extension point.
	
Select Before to run the ruleset before the method specified by the signature. For an extension point of type call, the custom code is weaved before the call to the method. For an extension point of type execution, the custom code is weaved within the method before the first line of executable code.


	
Select After to run the ruleset after the method specified by the signature. For an extension point of type call, the custom code is weaved after the call to the method. For an extension point of type execution, the custom code is weaved within the method after the last line of executable code.


	
Select Instead to run the ruleset instead of the method specified by the signature. For an extension point of type call, the custom code is weaved in place of the call to the method. For an extension point of type execution, the custom code is weaved within the method in place of the executable code.












Related Topics

Associating Global Extension Points with Rulesets

Configuring Ruleset Extension Points












Managing and Extending Technology Packs and Cartridges

Oracle Communications Design Studio packages project information into cartridges that can be deployed into Oracle Communications Unified Inventory Management (UIM). Cartridges can contain small amounts of data, such as one specification, or can be large collections of many specifications.

Cartridges can be developed by customers, systems integrators, Professional Services staff, and third-party vendors. In addition, Oracle provides technology packs, which are packages of one or more cartridges that model inventory for a particular technology.

When managing and extending technology packs and cartridge projects, see the following topics:

	
About Technology Packs and Cartridges


	
Extending Technology Packs and Cartridges


	
Extending Technology Packs and Cartridges by Renaming


	
Working with UIM Cartridge Projects












About Technology Packs and Cartridges

A cartridge is an application component delivered with product, technology pack, or solution. Cartridges are typically packaged in a JAR format. Technology packs are packages of one or more cartridges developed by Oracle.


	Base cartridges	Provide basic content required by many other cartridges and technology packs. Delivered in the core UIM package and installed at the following location:
UIM_Home/cartridges/base folder

See UIM Cartridge and Technology Pack Guide for more information.


	Sample cartridges	Include sample specifications, extensions, rule sets, and code. You can use them as a reference or as a starting point for your own development. Installed at the following location:
UIM_Home/cartridges/sample folder


	Product technology packs	Separately licensed products developed and supported by Oracle Communications to model inventory for specific technology domains, such as Consumer VoIP or MPLS L3 VPNs. Available on the Oracle software delivery Web site.






You can install technology packs without modification into UIM. This is usually the case for base cartridges. If a technology pack has more than one cartridge, these cartridges may have dependencies on each other. In this case, they must be installed in a particular order. See UIM Installation Guide, the UIM online Help, and the guides for individual product technology packs for more information about installation.

You can also extend technology packs and cartridges. See "Extending Technology Packs and Cartridges" for more information.










Extending Technology Packs and Cartridges

You can extend technology packs and cartridges to include new specifications, characteristics, and rule sets. You can also introduce new behaviors into the model provided by a technology pack by taking advantage of stub rule sets.




	
Important:

To ensure that extensions are upgradeable and supportable, follow the guidelines and policies described in UIM Developer's Guide. In most cases, you extend technology packs by adding content in supplemental cartridges that you create.







When extending technology packs, see the following topics:

	
Extending Technology Packs and Cartridges by Adding Content


	
Extending Technology Packs and Cartridges by Replacing Stub Rule Sets


	
Extending Technology Packs and Cartridges by Renaming












Extending Technology Packs and Cartridges by Adding Content

You can extend technology packs and cartridges by creating new, related content in a separate project. When you install the technology pack or cartridge into UIM and then install your supplemental cartridge, the additional content becomes available.

There are several ways to add content:

	
By creating new specifications to represent additional resources in the model. For example, if the technology pack or cartridge does not include specifications for all of the specific types of equipment and physical devices you use, you can create specifications for them. If the new specifications are similar to specifications in the technology pack or cartridge, you can copy the existing specifications into your project and make any necessary modifications. Design Studio forces you to rename the copies. See "Copying Specifications" for more information.


	
By creating new specifications that are upwardly related to specifications in the technology pack or cartridge. Three types of upward relationships are possible:

	
From an entity specification to another entity specification in a technology pack or cartridge. For example, you can create an upward relationship from a Device Interface specification you create to a Logical Device specification in a technology pack or cartridge.


	
From an entity specification to a configuration item in the technology pack or cartridge. For example, you can create an upward relationship from a Telephone Number specification you create to a configuration item in a configuration specification that is part of a technology pack or cartridge. See "Defining Configuration Specification Usage" for more information.


	
From an configuration specification to a parent entity specification in a technology pack cartridge. For example, you can create an ADSL2Plus Service Configuration specification and relate it to a DSL Service specification in a technology pack.




See "Defining Specification Relationships" for more information about relating specifications.


	
By creating new entity-level characteristics for a Managed Project Extension, Channelized Connectivity Extension, or a Property Location Extension entity. When you define entity-level characteristics for these extension entities, those characteristics apply to all instances of the entity in the run-time environment. See "Extending Design Studio for Inventory Entities" for more information.




When you create a dependency between a specification in your own cartridge and a specification in a technology pack or cartridge, both cartridges must exist in the same workspace. Additionally, you must import into the workspace all cartridges on which the technology pack or cartridge depends.









Extending Design Studio for Inventory Entities

You can define entity-level characteristics for Managed Project Extension, Channelized Connectivity Extension, or Property Location Extension entities. The characteristics you define extend a single Managed Project Extension, Channelized Connectivity Extension, or Property Location Extension specification. When you define characteristics for these entities and deploy the cartridge to the UIM run-time environment, those characteristics apply to all instances of the entity.




	
Note:

You must import the ora_uim_basespecifications cartridge (which includes the specifications for the extension entities) before you define characteristics for the extension entities. See UIM Cartridge and Technology Pack Guide for information about the ora_uim_basespecifications cartridge.







To extend Design Studio for Inventory entities:

	
From the Studio menu, select New, then select Inventory, then select Extend Entity, and then select the type of entity to extend.

You can extend Managed Project Extension, Channelized Connectivity Extension, or Property Location Extension entities. After you make a selection, the Entity Extension Wizard appears.


	
In the Project field, select the name of the project to which the new specification should be added.


	
(Optional) Select a location for the new specification.

By default, Design Studio saves the entity to your default workspace location. You can enter a folder name in the Folder field or select a location different from the system-provided default. To select a different location:

	
Click the Folder field Browse button.


	
Navigate to the directory in which to save the entity.


	
Click OK.





	
Click Finish.

Design Studio creates the new entity and displays its information in an Entity Extension editor.


	
In the Entity Extension editor Characteristics tab, right-click and select Add Characteristic or Select Characteristic.

See "Creating Characteristics from the Specification Editor" for information about creating new characteristics, and see "Adding Existing Characteristics to Specifications" for information about selecting existing characteristics.


	
(Optional) Define the layout for the entity extension.

See "Specification Editor Layouts Tab" for more information.


	
(Optional) Define user interface hints for the entity-level characteristics for the entity extension.

See "Specification Editor Layouts Tab" for more information.


	
(Optional) If a characteristic is defined with enumerations, define a set of data values for the entity-level characteristic.

You can exclude enumerations defined at the schema level or add additional enumerations. See "Characteristics Tab Data Values Subtab" for more information.


	
Click Save.













Entity Extension Editor

You use the Entity Extension editor to create new entity-level characteristics for a Managed Project Extension, Channelized Connectivity Extension, or a Property Location Extension entity.

When extending these entities, see the following topics:

	
Specification Editor Characteristics Tab


	
Specification Editor Layouts Tab














Extending Technology Packs and Cartridges by Replacing Stub Rule Sets

You can extend a technology pack or cartridge by replacing stub rule sets with rule sets you create. Stub rule sets have no default logic associated with them. When you replace a stub, your logic executes at the extension point associated with the rule set. Stub rule sets typically provide opportunities to extended validation and auto-allocation.

You give your rule set the same name as the original in the technology pack. When you install your cartridge into UIM, your version of the stub rule set overwrites the stub rule set installed with the technology pack. Because Design Studio requires unique names within a workspace, you must create your rule set in a workspace that does not include the technology pack project with the stub.

Alternatively, instead of having a separate workspace, you can just close the other project that includes the entity with the same name.

See "Working with Rulesets" for more information about working with rule sets.










Extending Technology Packs and Cartridges by Renaming

You can extend technology packs and cartridges by renaming the original technology pack or cartridge and refactoring all existing objects. Oracle recommends that you use this method only when you are not able to extend the technology pack or cartridge by adding new content to your own project.




	
Important:

When you intend to rename a technology pack or cartridge, do not deploy the original technology pack or cartridge into UIM.







To extend technology packs and cartridges by renaming:

	
Create a backup of the technology pack or cartridge.


	
Import all dependent projects into the workspace, then import the technology pack or cartridge.

See "Importing Projects" for more information.


	
Build the technology pack or cartridge and all dependent projects and resolve all problem markers.

See "Building and Packaging Projects" for more information.


	
From the Studio menu, select Show Design Perspective.


	
From the Studio Projects view, double-click the Project entity for the technology pack or cartridge.

The entity opens in the Project editor.


	
On the Properties tab, click Unseal.

The Unseal Project confirmation dialog box appears.


	
Click OK.


	
Build the unsealed technology pack or cartridge project.


	
From the Studio Projects view, right-click the technology pack or cartridge and select Rename.

The Refactoring dialog box appears.




	
Important:

Always rename technology packs or cartridges from the Studio Projects view.








	
In the Name field, enter a new name for the technology pack or cartridge then click Next.

Design Studio lists all of the changes to be performed. Ensure that all of the instances are selected.


	
Click Finish and when prompted click OK.

Design Studio closes and restarts.


	
After Design Studio reopens, build all sample and dependent cartridges and fix all problem markers.


	
Change the package reference to remove "Oracle" from the class packaging.

Removing this reference ensures that there are no collisions at run time.

	
From the Window menu, select Open Perspective and then select Java.

The Java perspective appears.


	
In the Package Explorer view, navigate to and open the cartridge src folder.


	
Remove the Oracle reference from the class packaging.





	
(Optional) If projects in the workspace have dependencies on the original cartridge, import the original cartridge back into the workspace.














Working with UIM Cartridge Projects

In Design Studio, a cartridge is a collection of components that you deploy into a run-time environment to support your business processes. You create Cartridge projects to contain the specifications and code that you develop. Each Cartridge project is mapped to directories in the file system and is a collection of files and folders.

You can import existing cartridge projects into your workspace (for example, you can import Cartridge projects from a technology pack) or you can create new Cartridge projects in Design Studio.

When working with Inventory Cartridge projects, see the following topics:

	
About Imported Inventory Cartridge Projects


	
About New UIM Cartridge Projects


	
About Inventory Cartridge Project Dependencies


	
Deploying Inventory Cartridge Projects


	
Configuring the UIM Project Library List












About Imported Inventory Cartridge Projects

You can import existing Cartridge projects into Design Studio. Cartridges that include customizable Java source code are packaged in a ZIP file. You can import the ZIP file or extract the ZIP file to a folder and import the Cartridge project from the folder. When you import a cartridge, it becomes a Cartridge project in the current workspace. See "Importing Projects" for more information about importing Inventory Cartridge projects.

If you import a cartridge from a technology pack or a cartridge that has been protected by its creator, it will be sealed. Sealed cartridges cannot be modified without first being unsealed. See "Sealing Projects" and "Unsealing Projects" for more information.

Cartridges with dependencies will display errors when you import them without the required cartridges already being present in the workspace. For example, if you import a cartridge that requires one of the base cartridges, you will see errors. After all the cartridges have been imported, you can clean all the projects to remove the errors. See "Reviewing the Error Log", "Problems View", and "Running Clean Builds" for more information. See "Importing Projects into Design Studio using Root Directories" for more information about importing existing projects into a workspace.










About New UIM Cartridge Projects

You can create new Cartridge projects in Design Studio. For example, you may create a Cartridge project that contains all characteristics, another that contains all specifications, and so forth. Everything you create in Design Studio (characteristics, specifications, and rule sets, for example) resides in a project. The name you choose for a Cartridge project becomes the name of a JAR file, and everything you create within that project is automatically placed in the JAR file.

See "Creating New Cartridge Projects" for more information about creating cartridge projects in Design Studio.

See "Project Editor" for information about the tabs you use to define an Inventory cartridge project. See "Reviewing the Error Log" and "Problems View" for more information about resolving project errors and warnings.










About Inventory Cartridge Project Dependencies

Inventory projects have dependencies on other projects when entities in one project reference entities in a different project. For example, an Inventory project might reference data elements defined in a common model project.

If you configure a project to reference content in other projects without declaring project dependencies, Design Studio creates an error or a warning, depending on how you configured the diagnostic level (see "Project Editor Dependency Tab" for more information about configuring the diagnostic level). Design Studio filters data that appears in dialog boxes and views based on project dependencies.

All Inventory cartridge projects have a dependency on the ora_uim_model project. You must import and open the ora_uim_model and ora_uim_mds projects in your workspace before modeling UIM entities in Design Studio.

The ora_uim_model project is a read-only project that represents the UIM model. It supports the ability to define specifications and characteristics and is also used to validate which entity types can be assigned or referenced by configuration items.

When you create a new Inventory cartridge project, Design Studio adds the ora_uim_model project to the dependency list on the Inventory Project editor Dependency tab. Do not remove this dependency.


Related Topics

Managing Project Dependencies










Deploying Inventory Cartridge Projects

You deploy Design Studio Inventory cartridge projects from the Environment perspective. The method that you use to deploy cartridge projects is the same for all Design Studio features. See "Deploying Cartridge Projects" for more information.

If you are deploying into a UIM environment that is a clustered server or where UIM is running on a managed server that is separate from the administration server, you must define the wladmin.host.name and wladmin.host.port cartridge management variables. See "Design Studio for Inventory Cartridge Management Variables Tab" for more information.









Design Studio for Inventory Cartridge Management Variables Tab

Use the Project editor Cartridge Management Variables tab to define the Oracle WebLogic Server Admin Server IP address and port values. Before you deploy Design Studio for Inventory Cartridge projects, you must define the default cartridge management variables wladmin.host.name and wladmin.host.port.

This topic describes the cartridge management variables that are specific to Design Studio for Inventory. For general information about how to use the tab to add variables, see "Project Editor Cartridge Management Variables Tab".


	Field	Use
	wladmin.host.name	Enter the hostname of the server where the WebLogic Server resides. Contact your UIM System Administrator to obtain this information.
If you are deploying to an environment where there is only one server (for example, the application is deployed to the Admin Server, define this value with the same value that you defined for IP address of the UIM server in the Studio Environment editor Connection Information tab Address field.


	wladmin.host.port	Enter the WebLogic Server port number. Contact your UIM System Administrator to obtain this information.
If you are deploying to an environment where there is only one server (for example, the application is deployed to the Admin Server, define this value with the same value that you defined for port number of the UIM server in the Studio Environment editor Connection Information tab Address field.









Related Topics

Studio Environment editor Connection Information Tab











Configuring the UIM Project Library List

Depending on the imported project, you may need to configure the project library list. If the imported project includes a library list of the files needed to compile the project, the project library list must be configured to point to a location to pick up the cited files.

To configure the project library list within Design Studio:

	
Select the cartridge in the Studio Projects view.


	
From the Project menu, select Properties.


	
Select Java Build Path.


	
Click the Libraries tab.

The project library list contains all the files needed to compile the project.

The library path for each file starts with UIM_LIB. Therefore, you must:

	
Create a working directory. For example, UIM_LIB.


	
Copy the files from your UIM installation to the working directory you just created.


	
Add a new variable named UIM_LIB that points to this working directory. (The following steps show how to add the new variable.)





	
Click Add Variable.

The New Variable Classpath Entry dialog box appears.


	
Click Configure Variables.

The Preferences dialog box appears.


	
Click New.

The New Variable Entry dialog box appears.


	
In the Name field, enter UIM_LIB.


	
Click Folder and browse to the directory you created in a previous step.

For example, the UIM_LIB directory.


	
Click OK.

The Preferences dialog box appears.


	
Click OK.

The Classpath Variables Changed dialog box appears, suggesting that you do a full build now.


	
Click No.

The New Variable Classpath Entry dialog box appears.




	
Note:

The OK button is not available, and an error displays stating ”Variable points to...”. Click Cancel, and the new variable is added successfully.








	
Click Cancel.

The Properties dialog box appears.


	
Click OK.


	
Open the Properties dialog box again to refresh the library list and ensure that the variable was added successfully.

You should now see the complete path in the build path.
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